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1. Legal Notice

This manual is protected under MandrakeSoft intellectual property rights. Permission is granted to copy,
distribute and/or modify this document under the terms of the GNU Free Documentation License, Version
1.1 or any later version published by the Free Software Foundation; with the invariant sections being About
Mandrake Linux, page i, with the front-cover texts being listed below, and with no Back-Cover Texts. A copy of
the license is included in the section GNU Free Documentation License, page 223.

Front-cover texts:

MandrakeSoft March 2002

http://www.mandrakesoft.com/

Copyright ľ 1999,2000,2001,2002 by MandrakeSoft S.A. and MandrakeSoft Inc.

“Mandrake”, “Mandrake Linux” and “MandrakeSoft” are registered trademarks of MandrakeSoft S.A.; Li-
nux is a registered trademark of Linus Torvalds; UNIX is a registered trademark of The Open Group in the
United States and other countries. All other trademarks and copyrights are the property of their respective
owners.

2. About Mandrake Linux

Mandrake Linux is a GNU/Linux distribution supported by MandrakeSoft S.A. MandrakeSoft was born in
the Internet in 1998 with the main goal to provide an easy-to-use and friendly GNU/Linux system. The two
pillars of MandrakeSoft are open-source and collaborative work.

2.1. Contact Mandrake Community

Following are various Internet links pointing you to various Mandrake Linux related sources. If you wish
to know more about the MandrakeSoft company, connect to its web site (http://www.mandrakesoft.com/).
There is also the Mandrake Linux distribution (http://www.mandrakelinux.com/) web site and all its deri-
vatives.

First of all, MandrakeSoft is proud to present its new open help platform. MandrakeExpert (http://www.
mandrakeexpert.com/) isn’t just another web site where people help others with their computer problems in
exchange for up-front fees, payable regardless of the quality of the service received. It offers a new experience
based on trust and the pleasure of rewarding others for their contributions.

In addition, MandrakeCampus (http://mandrakecampus.com/) provides the GNU/Linux community with
open education and training courses on all open-software-related technologies and issues. It also gives
teachers, tutors and learners a place where they can share knowledge.

There is a site for the “mandrakeholic” called Mandrake Forum (http://www.mandrakeforum.com/): a pri-
mary site for Mandrake Linux related tips, tricks, rumors, pre-announcements, semi-official news, and more.
This is also the only interactive web site hosted by MandrakeSoft, so if you have something to tell us, or
something you want to share with other users, search no longer: this is a place to do it!

In the philosophy of open source, MandrakeSoft is offering many means of support (http://www.
mandrakelinux.com/en/ffreesup.php3) for the Mandrake Linux distributions. You are invited in particu-
lar to participate in the various Mailing lists (http://www.mandrakelinux.com/en/flists.php3), where the
Mandrake Linux community demonstrates its vivacity and keenness.

Finally, do not forget to connect to MandrakeSecure (http://www.mandrakesecure.net/). This site gathers all
security related material about Mandrake Linux distributions. You’ll notably find there security and bug advi-
sories, as well as security and privacy-related articles. A must for any server administrator or user concerned
about security.

i
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2.2. Support Mandrake

By popular request, MandrakeSoft proposes that its happy customers make a donation (http://www.
mandrakelinux.com/donations/) to support the forth-coming developments of the Mandrake Linux system.
Your contribution will help MandrakeSoft provide its users with an ever better distribution, ever safer, easier,
up-to-date, and with more supported languages.

For the many talented, your skills will be very useful for one of the many tasks required in the making of a
Mandrake Linux system:

• Packaging: a GNU/Linux system is mainly made of programs picked up on the Internet. These programs
have to be packaged so that they will hopefully work together.

• Programming: there are many many projects directly supported by MandrakeSoft: find the one that most
appeals to you, and offer your help to the main developer.

• Internationalization: translation of the web pages, programs and their respective documentation.

• Documentation: last but not least, the book you are currently reading requires a lot of effort to stay up-to-
date with the rapid evolution of the system.

Consult the contributors page (http://www.mandrakesoft.com/labs/) to learn more about the way you can
contribute to the evolution of Mandrake Linux.

On August 3rd 2001, after having established itself as one of the world leaders in Open Source and GNU/Linux

software, MandrakeSoft became the first Linux company listed on a European stock market. Whether you’re
already a MandrakeSoft shareholder or wish to become one, our Investor pages (http://www.mandrakesoft.
com/company/investors) provide the best financial information related to the company.

2.3. Purchasing Mandrake Products

For Mandrake Linux fans wishing to benefit from the ease of on-line purchasing, MandrakeSoft now sells its
products worldwide from its MandrakeStore (http://www.mandrakestore.com/) e-commerce web site. You
will find not only Mandrake Linux software — operating systems and network tools (Single Network Fire-
wall), but also special subscription offers, support, third party software and licenses, training documentation,
GNU/Linux related books, as well as other goodies related to MandrakeSoft.

3. About This Installation And User Guide

This book is divided into four parts. The first part, the Installation Guide, will help you install and configure
your Mandrake Linux distribution by describing the preparation, installation and post-installation procedu-
res. The second part, entitled Discover, is an introduction to Linux basics. In this section we also discuss the
two most popular graphical environments, KDE and GNOME .

The third part is called Use, and discusses everyday applications such as office software (word processors,
spreadsheets and the like), file managers and graphics software. We also discuss devices such as printers and
scanners as well as multimedia applications for sound and video. We wrap up this section by describing Inter-
net usage using a variety of tools, where you will learn about mail readers, web browsers, instant messaging
and Internet Relay Chat, or “IRC”.

In the last part, Personalize, we go deeper into the Mandrake Linux architecture. You will discover Mandrake-
specific tools such as Bastille , which allows you to better secure your machine, the Mandrake Control Cen-

ter where you can fine-tune your configuration and RpmDrake , a package management tool.

Thank you for choosing Mandrake Linux and have fun!

4. Authors And Translators

The following people contributed to the making of the Mandrake Linux manuals:

• Yves Bailly

• Camille Bégnis

• Marco De Vitis
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• Francis Galiègue

• Hinrich Göhlmann

• Carsten Heiming

• Fabian Mandelbaum

• Joël Pomerleau

• Peter Rait

• Roberto Rosselli Del Turco

• Christian Roy

• Stefan Siegel

These people also participated at various degrees: Philippe Ambon, Jay Beale, Hoyt Duff, Joël Flores-Carpio,
Giuseppe Ghibò, Till Kampetter, Alexander Sasha Kirillov, Damien Dams Krotkine, Robert Kulagowski, Kevin
Lecouvey, François Pons, Guillaume Poulin, Pascal Pixel Rigaux, John Rye and Laurence Tricon.

5. Note From The Editor

As you may notice while you go from one chapter to another, this book is a composite document from various
authors. Even though much care has been taken in insuring the technical and vocabulary consistency, the style
of each author is obviously preserved.

Some of the authors write in English even though it is not their native language. Therefore, you may notice
strange sentence constructions; do not hesitate to let us know if something is not clear to you.

In the open-source philosophy, contributors are always welcomed! You may provide help to this documenta-
tion project by many different means. If you have a lot of time, you can write a whole chapter. If you speak a
foreign language, you can help with the internationalization of this book. If you have ideas on how to improve
the content, let us know - even advice on typos is welcomed!

For any information about the Mandrake Linux documentation project, please contact the documentation
administrator (mailto:documentation@mandrakesoft.com).

6. Tools Used in The Making of This Manual

This manual was written in DocBook . perl and GNU make were used to manage the sets of files involved.
The XML source files were processed by openjade and jadetex using custom Norman Walsh’s stylesheets.
Screen-shots were taken using xwd or GIMP and converted with convert (from the ImageMagick package). All
this software is available on your Mandrake Linux distribution, and all parts of it are free software.

7. Conventions Used in This Book

7.1. Typing Conventions

In order to clearly differentiate special words from the text flow, the documentation team uses different rende-
rings. The following table shows an example of each special word or group of words with its actual rendering
and what this means.

Formatted Example Meaning

inode This formatting is used to stress a technical term, explained in the Glossary.

ls -lta Indicates commands or arguments to a command. This formatting is applied to
commands, options and file names. Also see the section about “ Commands Synopsis,
page iv ”.

ls(1) Reference to a man page. To get the page in a shell (or command line), simply type
man 1 ls.

$ ls *.pid

imwheel.pid

The documentation team uses this formatting for text snapshots of what you may see
on your screen. It includes computer interactions, program listings, etc.

iii
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Formatted Example Meaning

localhost This is literal data that does not generally fit in with any of the previously defined
categories. For example, a key word taken from a configuration file.

Apache This is used for application names. The example used is not a command name but, in
particular contexts, the application and command name may be the same but
formatted in different ways.

Files This is used for menu entries or graphical interface labels in general. The underlined
letter indicates the keyboard shortcut, if applicable.

SCSI-Bus It denotes a computer part or a computer itself.

Le petit chaperon
rouge

This formatting identifies foreign language words.

Warning! Of course, this is reserved for special warnings in order to stress the importance of
words; read out loud :-)

This icon highlights a note. Generally, it is a remark in the current
context, giving additional information.

This icon represents a tip. It can be a general advice on how to
perform a specific action, or a nice feature that can make your life
easier.

Be very careful when you see this icon. It always means that very
important information about a specific subject will be dealt with.

7.2. General Conventions

7.2.1. Commands Synopsis

The example below shows you the symbols you will find when the writer describes the arguments of a com-
mand:

command <non literal argument>

[--option={arg1,arg2,arg3}] [optional arg. ...]

These conventions are standard and you may find them at other places such as the man pages.

The “<” (lesser than) and “>” (greater than) symbols denote a mandatory argument not to be copied verbatim,
but to be replaced according to your needs. For example, <filename> refers to the actual name of a file. If this
name is foo.txt, you should type foo.txt, and not <foo.txt> or <filename>.

The square brackets “[ ]” denote optional arguments, which you may or may not include in the command.

The ellipsis “...” mean an arbitrary number of items can be included.

The curly brackets “{ }” contain the arguments authorized at this specific place. One of them is to be placed
here.

7.2.2. Special Notations

From time to time, you will be directed to press, for example, the keys Ctrl+R, which means you need to press
and hold the Ctrl and tap the R key as well. The same applies for the Alt and Shift keys.

Also about menus, going to menu item File→Reload user config (Ctrl+R) means: click on the File text displayed
on the menu (generally horizontal on the top of the window). Then in the pull-down menu, click on the Reload
user config item. Additionally, you are informed that you can use the key combination Ctrl+R, as described
above, to achieve the same result.

iv
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7.2.3. System Generic Users

Whenever possible, we used two generic users in our examples:

Queen Pingusa This user is created at installation
time.

Peter Pingus This user is created afterwards by
the system administrator.

v
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I. Installation Guide





Introduction to The Installation Guide

In this chapter, we will help you install Mandrake Linux on your computer. The default setup program, DrakX ,
uses a graphical interface to guide you through the process. If you cannot or prefer not to use DrakX , a text-
mode install program is also available. If you want to use the text-mode install, please see section “Installation
With DrakX”, page 11 for complete instructions.

“Before Setup”, page 3: Before getting started with the installation you’ll be asked to find out some informa-
tion to help streamline the process. A few of the things that are covered are configuring your BIOS , finding
information about your hardware, and, if needed, creating a bootdisk.

“Disks And Partitions”, page 7: Although DrakX is designed to handle partitioning the hard drive automatically,
a whole section will be devoted to the concepts behind configuring your hard drive. You’ll learn all about the
details of how to partition your disk for special uses. This way, you’ll have have the background necessary to
successfully partition your hard drive if you want to override DrakX and setup your partitions manually.

“Installation With DrakX”, page 11: Then comes the long-awaited chapter about the installation itself.

“Using Mandrake Linux For The First Time”, page 33: Finally, we will be introducing some post-installation
procedures useful for full system configuration.
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Chapter 1. WARNING – README

This manual covers the installation in both Recommended and Expert modes. If you wish to use Windows , please
note that it’s easier to install it before GNU/Linux . If you already have Windows installed on your system,
and have never installed GNU/Linux before, DrakX will have to resize your Windows partition (if any). This
operation can be harmful to your data, therefore you must perform the following steps before proceeding:

• you must run scandisk on your Windows partition; the resizing program can detect some obvious errors,
but scandisk is better suited for this task;

• for maximum data security, you should also run defrag on your partition. This further reduces the risk of
data loss; this is not mandatory, but is highly recommended and doing so will make resizing much faster
and easier;

• the ultimate insurance against problems is to always back up your data!

If neither scandisk nor defrag are installed within Windows , please refer to the Windows documentation for
instructions on installing them.

NTFS partitions. Windows 2000 , NT or XP users should be very
careful not to resize NTFS partitions with GNU/Linux . This will
damage your data. In this case, use an appropriate disk-resizing
application such as Partition Magic.

1
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Chapter 2. Before Setup

2.1. Configuring Your BIOS

The BIOS (Basic Input/Output System) is used to boot up a computer. Specifically, it is used to find the device
on which the operating system is located and start it up. It is also used for the initial hardware configuration.

The appearance of plug’n’play and its widespread use means that all modern BIOS can initialize these de-
vices, but you still have to ask it to do so. If your Windows 9x OS is initializing these devices instead of the
BIOS , this will need to be changed for use under GNU/Linux .

Changing your BIOS settings is usually performed by holding down the DEL key just after the computer is
switched on. Unfortunately, there are many types of BIOS ’, therefore you will have to look for the appropriate
option for yourself. The option to look for is often called PNP OS installed (or Plug’n’Play OS installed). Set this
option to No and the BIOS will then initialize any plug’n’play devices. That can help GNU/Linux recognize
some devices in your machine, which it would not be able to initialize otherwise.

If your BIOS can boot from the CD-ROM and you want to perform a standard installation of Mandrake Linux,
you can also set your BIOS to boot from the CD-ROM before searching the hard disk. Look for Boot sequence
in the BIOS features setup.

If you want to use a printer locally connected to your machine, make
sure that the parallel port mode is set to ECP+EPP (or at least
one of them) and not to SPP. If it’s not set this way, you will still
be able to print, but your printer will not be auto-detected so you
will have to configure it by hand. Also make sure that the printer is
powered on and properly connected to your machine beforehand.

2.2. Creating a Boot Disk

If you cannot boot from the CD-ROM, and if Windows is not installed on your computer, you will need to
create a boot disk.

The CD-ROM contains all of the image files and utility programs needed. You will also need to create a boot
disk if you wish to use a bootloader other than LILO or grub . If Windows is installed on your computer, you
will not need a boot disk, so you may skip this step and go on to “Installation With DrakX”, page 11.

The boot images are in the images directory on the CD-ROM. For this method of installation, the significant
file is named cdrom.img.

We use the image cdrom.img when you install the distribution from a CD-ROM. However, many other images
are available to perform installs:

• cdrom.img: to install from a local IDE or SCSI CD-ROM drive. This has to be used in cases where you cannot
boot your computer directly from the CD-ROM, by changing BIOS settings.

• network.img: to install from a NFS, FTP, HTTP repository, your local LAN or via a PPPoE (DSL lines)
network connection. The network configuration of the machine to be installed may be manual or automatic.

• pcmcia.img: if the installation media is reached through a PCMCIA card (network, CD-ROM, etc.).

Some PCMCIA devices now use common network drivers. In case
the PCMCIA device doesn’t work, try the network.img.

• hd.img: use this image in the case where you were not able to perform the install from a CD-ROM. You just
need to copy the content of the CD onto the hard drive (either on a FAT ext2fs or reiserfs partition), and boot
with the floppy containing that image.

• usb.img: this image allows you to perform an installation through a USB device, such as an external CD-
ROM, etc.

• other.img: this installation image provides less common drivers such as NET and SCSI drivers. Try this
image if the others failed.
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• /images/alternatives/*: this directory provides more or less the same boot images, but with a different
(older) kernel. Actually, it provides a 2.2 kernel (Mandrake Linux 8.2 uses kernel 2.4), which might help
you to get started on older systems.

2.2.1. Creating a Boot Disk With Windows

You need to use the program called rawwrite. This can be found in the CD-ROM’s dosutils directory.

You may have noticed that there is a DOS version, rawrite, of the same program. It is, in fact, the original
version of the program: rawwrite is a graphical front-end to it.

Start the program, as shown in figure 2-1.

Figure 2-1. The Rawrite Program

Select the boot image to copy and the target device. In almost all cases, the target device is the A: drive (that
is, the first floppy disk drive).

Then, if you haven’t already done so, insert an empty disk into your chosen floppy drive and click on Write.
When completed, click on E xit, you have a boot disk to install your Mandrake Linux distribution.

2.2.2. Creating a Boot Disk With GNU/Linux

If you already have GNU/Linux installed (another version, or on another machine, a friend’s computer who
lent you his Mandrake Linux CD), then carry out the following steps:

1. mount the CD-ROM. Let us suppose that the mount point is /mnt/cdrom;

2. log in as root;

3. insert an empty disk into the drive and type:

$ dd if=/mnt/cdrom/images/cdrom.img of=/dev/fd0
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Replace /dev/fd0 by /dev/fd1 if you are using the second floppy
drive and, of course, the name of the image with the one you want.
When completed, your boot disk will be ready.

2.3. Supported Hardware

Mandrake Linux can handle a large number of hardware devices, and the list is far too long to be quoted in
its entirety here. Nevertheless, some of the steps described in this chapter will help you to find out if your
hardware is compatible and configure some of the problematic devices.

You may consult an up-to-date list of supported hardware on our web site (http://www.mandrakelinux.com/
en/hardware.php3).

USB devices: support for USB is now extensive. Most peripherals are fully supported. You can get the list of
supported hardware on the Linux-USB Device (http://www.qbik.ch/usb/devices/) site.

Legal disclaimer: the Mandrake Linux Supported Hardware List
contains information about hardware devices that have been tested
and/or have been reported to function properly with Mandrake
Linux. Due to the wide variety of system configurations, Mandra-
keSoft cannot guarantee that a specific device will work properly
on your system.

2.3.1. What’s Not Supported

Some types of hardware cannot presently be handled by GNU/Linux , either because the support is still in an
experimental stage, because nobody has written a driver for the devices in question, or because it has been
decided for valid reasons that they cannot be supported. For example:

• winmodems , also called controller-less modems or software modems. Support for these peripherals is cur-
rently very sparse. Drivers do exist, but are binary only and for a limited range of kernel versions. The
difference between a “hardware” modem and a winmodem is that the latter cannot function without a spe-
cial driver which emulates a large number of a hardware modem’s functions. You can communicate with
a hardware modem by sending to it a series of commands: this cannot be done with a winmodem without
special drivers (this also explains why GNU/Linux does not need drivers for external modems: it only gives
access to the serial port, with an external program sending the commands).

If you have a PCI modem, as the root user, look at the output of cat /proc/pci. This will tell you the I/O
port and the IRQ of the device. Then, use the setserial command (for our example, the I/O address is
0xb400 and the IRQ is 10) as follows:
setserial /dev/ttyS3 port 0xb400 irq 10 UART 16550A

Then see if you can query your modem using minicom or kppp . If it doesn’t work, you may have a soft-
ware modem. If it does work, create the file /etc/rc.d/rc.setserial and place the appropriate setserial
command line in it.

A recent project is trying to make software modems work under GNU/Linux . If you happen to have this type
of hardware in your machine, you may have a look at linmodems (http://linmodems.org/) and modems
and winmodems (http://www.idir.net/~gromitkc/winmodem.html).

2.3.2. Collecting Information About Your Hardware

GNU/Linux ’ hardware resources are now very well supported and, apart from the devices mentioned in the
previous section, you can expect the rest of your hardware to work correctly.

Some types of devices are still problematic with GNU/Linux , especially ISA plug’n’play devices: but you can
use Windows to discover their working configuration. If you intend to install Mandrake Linux while leaving
a version of Windows on your machine, you can ignore this section at first, and then come back here if you
experience problems under GNU/Linux .
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For this, boot under Windows and access your control panel.

If you have ISA devices, you can view them when you bring up the directory structure.

You will be able to find the ISA devices in this part of the directory structure. If you only see one entry for the
data port, ignore it. If there are devices present, and if there is no conflict, you can then select them and view
their Properties.

You will have to write down the base address(es) (Input/output range) used, together with the IRQ(s). Also write
down the DMA channel(s) used for the sound card.

If your ISA card is plug’n’play , you will have to configure your BIOS properly, as instructed in the preceding
section. But even if you do so, GNU/Linux may not find it. However, you can disable plug’n’play for the par-
ticular device. If the manufacturer has provided one, you should have a disk containing a program enabling
you to reset the card to non-plug’n’play . The manufacturer provides a setup program which does this. If
you have this sort of program (or can get it from the manufacturer’s web site), start it up, set the device’s
configuration with the parameters used by Windows and disable the plug’n’play . After that, GNU/Linux can
then see it during the installation process.

Don’t worry too much about sound cards, though. They are in most cases automatically configured, and you
can re-configure them after installation and not during installation. See chapter Configuring Your Hardware,
page 178 for more information.
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If you are reading this chapter, it means that you have decided on an expert installation of Mandrake Linux,
which will require you to understand partitioning. Or you are simply curious and that’s OK too :-)

This section provides a complete description of the PC partitioning scheme. It is only useful to you if you
intend to manually set the partitions of your hard drive. If you do not understand what we are talking about,
you may safely ignore this section; the installer can do everything automagically for you.

3.1. Structure of a hard disk

Basically, a disk is physically divided into little sectors. A sequence of sectors can form a partition. Roughly
speaking, you can create as many partitions as you wish; each of them is regarded as a single hard drive.

3.1.1. Sectors

To simplify, a hard disk is merely a sequence of sectors . A sector is the smallest data unit on a hard disk, and
its size is typically 512 bytes. The sectors on a hard disk of ( n ) sectors are numbered from ( 0 ) to ( n-1 ).

3.1.2. Partitions

The use of multiple partitions enables you to create many virtual hard drives inside your real physical drive.
This has many advantages:

• Different operating systems use different disk structures (called file systems); this is the case for Windows and
GNU/Linux . Having multiple partitions on a hard drives allows you to install various operating systems on
the same physical drive.

• For performance reasons, a single operating system may prefer different drives with different file-systems
on them because they are used for completely different things. It is the case for GNU/Linux which requires a
second partition called “swap” and used for virtual memory.

• Finally, it may prove very useful to separate the different parts of your OS into different partitions, even if
they use the same file-system. In the most simple configuration, you can split your files into two partitions,
one for your personal data, and another for programs. This allows you to update your OS, completely
erasing the programs partition while keeping the data partition safe.

• Physical errors on a hard disk are generally located at adjacent sectors and not scattered among the disk.
Distributing your files into different partitions will limit data loss in case of hard disk physical damages.

Normally the partition type specifies the file-system which the partition is supposed to contain. Each operating
system recognizes some of the types, but not others. See the chapter about GNU/Linux file-systems in the
Reference Manual for more information.

3.1.3. Define the structure of your disk

3.1.3.1. The Simplest Way

Having only two partitions: one for the swap space, the other for the files1.

The rule of thumb for the swap partition size is to choose double
of the size of your RAM memory. However for large memory con-
figurations (>512 MB), this rule is not valid, and smaller sizes are
preferred.

1. the file system used currently for GNU/Linux files is called ext2
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3.1.3.2. Another Common Scheme

Choose to separate data from programs. To be even more efficient, one usually defines a third partition called
the “root” and labelled as /. It will handle the programs necessary to startup your system and the basic
maintenance programs.

So we could define four partitions:

Swap

A partition of type swap, which is roughly equivalent to twice the memory size.

Root: /

It is the most important partition. It not only contains the most important data and programs for the
system, but will also act as a mount point for other partitions.

The needs of the root partition in terms of size are very limited, 300MB is generally enough. However,
if you plan to install commercial applications, that usually reside in /opt, you will need to increase that
size. Another option is to create a separate partition for /opt.

Static data: /usr

Most packages install most of their executables and data files under /usr. The advantage of having it on
a separate partition is that you can share it easily with other machines over a network.

The size depends on the packages you wish to install. It varies from 100MB for a lightweight installation
to several GB for a full install. A compromise of one or two GB (depending on your disk size) generally
suffices.

Home directories: /home

Here are kept the personal directories for all the users hosted on the machine. It also generally hosts the
directories served by HTTP or FTP (respectively for web browsing and file transfers).

Here the partition size depends on the number of users (or services) hosted and their needs.

A variant to that solution is to not use a separate partition for the /usr files: /usr will simply be a directory
inside the root / partition.

3.1.3.3. Exotic Configurations

When setting up your machine for specific uses such as a web server or a firewall, the needs are radically
different than for a standard desktop machine. For example, a FTP server will probably need a big separate
partition for /var/ftp, while the /usr will be relatively small. For such situations, you are encouraged to
carefully think about your needs before even beginning the install.

If after a period of time using your system, you notice that you
should have chosen different sizes and partitions, it is possible to
resize most partitions without the need to reinstall your system, it is
even generally data-safe. See Managing Your Partitions, page 190.

With a little bit of practice, you will even be able to move a
crowded partition to another brand new hard drive. But that’s
another story...
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3.2. Conventions For Naming Disks and Partitions

GNU/Linux uses a logical method for naming partitions. First, when numbering the partitions, it ignores the
file-system type of each partition that you may have. Second, it names the partitions according to the disk on
which they are located. This is how the disks are named:

• the primary master and primary slave IDE devices (whether they be hard disks, CD-ROM drives or anything
else) are called /dev/hda and /dev/hdb respectively;

• on the secondary interface, they are called /dev/hdc and /dev/hdd for the master and slave respectively;

• if your computer contains other IDE interfaces (for example, the IDE interface present in some Soundblaster
cards), the disks will then be called /dev/hde, /dev/hdf, etc.

• SCSI disks are called /dev/sda, /dev/sdb, etc., in the order of their appearance on the SCSI chain (depending
on the increasing ID s). The SCSI CD-ROM drives are called /dev/scd0, /dev/scd1, always in the order of
their appearance on the SCSI chain.

The partitions are named after the disk on which they are found, in the following way (in the example, we
have used the case of partitions on a primary master IDE disk):

• the primary (or extended) partitions are named /dev/hda1 through /dev/hda4 when present;

• logical partitions, if any, are named /dev/hda5, /dev/hda6, etc. in their order of appearance in the table of
logical partitions.

So GNU/Linux will name the partitions as follows:

Primary master IDE hard drive (/dev/hda)

Primary slave IDE hard drive (/dev/hdb)

/dev/hda1

First primary partition

First primary partition Second primary partition

/dev/hdb2/dev/hdb1

Figure 3-1. First Example of Partition Naming Under GNU/Linux

Primary Partition

/dev/hda1

Primary slave IDE hard disk (/dev/hdb)

First primary partition Second primary partition

/dev/hdb2

Primary master IDE hard disk (/dev/hda)

1st logical partition

/dev/hda5 /dev/hda6

/dev/hdb1

Extended Partition (/dev/hda2)

2nd logical partition

Figure 3-2. Second Example of Partition Naming Under GNU/Linux

So now you can cite the name the various partitions and hard disks when you need to manipulate them. You
will also see that GNU/Linux names the partitions even if it does not know how to manage them initially (it
ignores the fact that they are not native GNU/Linux partitions).
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For current 2.4 kernels, Mandrake Linux uses the Linux Devfs (De-
vice File System) (http://www.atnf.csiro.au/~rgooch/linux/
docs/devfs.html). This system ensures full compatibility with the
scheme described above, but this compatibility may disappear in the
future. Actually, each device is dynamically added to the system as
soon as it becomes available or needed.

For example, the first IDE hard drive now becomes:

[root@localhost root]# ll /dev/hda

lr-xr-xr-x 1 root root 32 Sep 2 17:14 /dev/hda

-> ide/host0/bus0/target0/lun0/disc
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4.1. Introduction to The Mandrake Linux Installer

DrakX is Mandrake Linux’s installation program. It possesses a graphical user interface and is very easy to
use. It allows you to go back at any time to previous configuration steps, even choosing the type of installation
that you want (depending on your skill level).

In order to ensure the installation occurs in the best possible condi-
tions, make sure to plug in and power on all the devices which will
be used on your computer: printer, modem, scanner, etc. Hence,
DrakX will automatically detect and configure them.

Figure 4-1. Very First Installation Welcome Screen

When you begin the installation – either from a CD-ROM or a floppy disk, you will first get a screen which
offers help (figure 4-1). Doing nothing will simply begin the installation in normal mode. Pressing F1 will open
a help screen (figure 4-2). Here are some useful options to choose from:

Figure 4-2. Available Installation Options

11



Chapter 4. Installation With DrakX

• vgalo: if you tried a normal installation and could not get the normal graphical screens as shown below,
you may try the installation in low resolution, simply by issuing vgalo at the prompt presented here.

• text: if your video card is really old, and graphical installation does not work at all, you can always choose
the text mode installation.

• expert mode: in some rare cases, hardware detection may freeze your computer. Should that happen, use
this mode to prevent it from happening. However, you will need to provide hardware parameters by hand.
expert is an option to the previous modes (or linux, the common mode).

• kernel options: you can pass on these command-line parameters to the installation kernel. It is particularly
useful for machines on which the installation program cannot determine the amount of memory installed.
Then, you just need to specify it manually here as an option to the installation modes with mem=xxxM. For
example, to start the installation in normal mode with a computer having 256 MB of memory, issue at the
command line:
boot: linux mem=256M

On the left, you can see the various installation steps. Depending on the installation’s progress level, some
stages may or may not be available. If they are available, they will be highlighted when you move the mouse
cursor over them.

The buttons representing the various stages can also be of different colors:

• red: this installation phase has not yet been carried out;

• orange: the installation stage which is currently being processed;

• green: this installation stage has already been configured. However, nothing stops you from going back to
it if you need or want to.

The bottom frame holds the help for the current step. You can
access it at any moment by pressing the F1 key.

This guide assumes that you are performing a standard, step-by-step installation, as shown in the following
screenshots.

4.2. Choosing Your Language

The first step is to choose your preferred language.

Please choose your preferred language for installation and system usage.
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Clicking on the Advanced button will allow you to select other languages to be installed on your workstation.
Selecting other languages will install the language-specific files for system documentation and applications.
For example, if you will host users from Spain on your machine, select English as the main language in the
tree view and in the Advanced section click on the box corresponding to Spanish|Spain.

Note that multiple languages may be installed. Once you have selected any additional locales, click the OK
button to continue.

4.3. License Terms of The Distribution

Before continuing, you should read carefully the terms of the license. It covers the whole Mandrake Linux
distribution, and if you do not agree with all the terms in it, click on the Refuse button which will immediately
terminate the installation. To continue with the installation, click on the Accept button.

4.4. Installation Class

DrakX now needs to know if you want to perform a default (Recommended) installation or if you want to have
greater control (Expert). You can also choose to do a new install or an upgrade of an existing Mandrake Linux
system:
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• Install: completely wipes out the old system. In fact, depending on what currently holds your machine, you
will be able to keep some old (Linux or other) partitions unchanged;

• Upgrade: this installation class allows to simply update the packages currently installed on your Mandrake
Linux system. It keeps the current partitions of your hard drives as well as user configurations. All other
configuration steps remain available with respect to plain installation;

• Upgrade Packages Only: this brand new class allows to upgrade an existing Mandrake Linux system while
keeping all system configurations unchanged. Adding new packages to the current installation is also pos-
sible.

Upgrades should work fine for Mandrake Linux systems starting
from 8.1 release.

Depending on your knowledge of GNU/Linux , select one of the following choices:

• Recommended: choose this if you have never installed a GNU/Linux operating system. The installation will
be very easy and you will only be asked a few questions;

• Expert: if you have a good knowledge of GNU/Linux , you can choose this installation class. The expert
installation will allow you to perform a highly-customized installation. Answering some of the questions
can be difficult if you do not have a good knowledge of GNU/Linux , so do not choose this unless you know
what you are doing.

This manual will document the full Expert installation class. If you choose the Recommended class, simply
ignore the steps presented here which only apply to the Expert installation class.

4.5. Disk Detection And Configuration

This step is generally ignored for Recommended mode.

DrakX now detects any IDE device present in your computer. It will also scan for one or more PCI SCSI card(s)
on your system. If a SCSI card is found, DrakX will automatically install the appropriate driver.

Because hardware detection does not always detect a piece of hardware, DrakX will ask you to confirm if a
PCI SCSI card is present. Click Yes if you know that there is a SCSI card installed in your machine. You will
be presented a list of SCSI cards to choose from. Click No if you have no SCSI hardware. If you are unsure,
you can check the list of hardware detected in your machine by selecting See hardware info and clicking OK.
Examine the list of hardware and then click on the OK button to return to the SCSI interface question.
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If you have to manually specify your adapter, DrakX will ask if you want to specify options for it. You should
allow DrakX to probe the hardware for the card-specific options which the hardware needs to initialize. This
usually works well.

If DrakX is not able to probe for the options which need to be passed, you will need to provide options to the
driver manually. Please review the User Guide (chapter 3, in the “Collecting Information on Your Hardware”
section) for hints on retrieving the parameters required from hardware documentation, from the manufactu-
rer’s web site (if you have Internet access) or from Microsoft Windows (if you used this hardware with Windows

on your system).

4.6. Configuring Your Mouse

This step is generally ignored for Recommended mode.

DrakX generally detects the number of buttons your mouse has. If not, it assumes you have a two-button
mouse and will set it up for third-button emulation. DrakX will automatically know whether it is a PS/2,
serial or USB mouse.

If you wish to specify a different type of mouse select the appropriate type from the provided list.

If you choose a mouse other than the default, a test screen will be displayed. Use the buttons and wheel to
verify that the settings are correct. If the mouse is not working well, press the space bar or Return to Cancel
and choose again.

4.7. Configuring The Keyboard

This step is generally ignored for Recommended mode.
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Normally, DrakX selects the right keyboard for you (depending on the language you have chosen) and you
won’t even see this step. However, you might not have a keyboard that corresponds exactly to your language:
for example, if you are an English speaking Swiss person, you may still want your keyboard to be a Swiss
keyboard. Or if you speak English but are located in Québec, you may find yourself in the same situation. In
both cases, you will have to go back to this installation step and select an appropriate keyboard from the list.

Click on the More button to be presented with the complete list of supported keyboards.

4.8. Security Level

This step is generally ignored for Recommended mode.

At this point, it is time to choose the security level desired for the machine. As a rule of thumb, the more
exposed the machine is, and the more the data stored in it is crucial, the higher the security level should be.
However, a higher security level is generally obtained at the expense of easiness of use. Refer to the msec
chapter of the Reference Manual to get more information about the meaning of these levels.

If you do not know what to choose, keep the default option.
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4.9. Selecting The Mount Points

At this point, you need to choose where you want to install the Mandrake Linux operating system on your
hard drive. If your hard drive is empty or if an existing operating system is using all the available space, you
will need to partition it. Basically, partitioning a hard drive consists of logically dividing it to create space to
install your new Mandrake Linux system.

Because the partitioning process’ effects are usually irreversible, partitioning can be intimidating and stressful
if you are an inexperienced user. Fortunately, there is a wizard which simplifies this process. Before beginning,
please consult the manual and take your time.

If you are running the installation in Expert mode, you will enter DiskDrake , the Mandrake Linux partitioning
tool, which allows you to fine-tune your partitions. See the DiskDrake section in the User Guide. From the
installation interface, you can use the wizards as described here by clicking the dialog’s Wizard button.

If partitions have already been defined, either from a previous installation or from another partitioning tool,
simply select those to install your Linux system.

If partitions are not defined, you will need to create them using the wizard. Depending on your hard drive
configuration, several options are available:

• Use free space: this option will simply lead to an automatic partitioning of your blank drive(s). You will not
be prompted further;

• Use existing partition: the wizard has detected one or more existing Linux partitions on your hard drive. If
you want to use them, choose this option;

• Use the free space on the Windows; partition: if Microsoft Windows is installed on your hard drive and takes all
the space available on it, you have to create free space for Linux data. To do so, you can delete your Microsoft
Windows partition and data (see “Erase entire disk” or “Expert mode” solutions) or resize your Microsoft
Windows partition. Resizing can be performed without the loss of any data, provided you previously de-
fragment the Windows partition. Backing up your data won’t hurt either.. This solution is recommended if
you want to use both Mandrake Linux and Microsoft Windows on the same computer.

Before choosing this option, please understand that after this procedure, the size of your Microsoft Windows
partition will be smaller than at the present time. You will have less free space under Microsoft Windows to
store your data or to install new software;

• Erase entire disk: if you want to delete all data and all partitions present on your hard drive and replace them
with your new Mandrake Linux system, choose this option. Be careful with this solution because you will
not be able to revert your choice after you confirm;

If you choose this option, all data on your disk will be lost.
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• Remove Windows: this will simply erase everything on the drive and begin fresh, partitioning everything from
scratch. All data on your disk will be lost;

If you choose this option, all data on your disk will be lost.

• Expert mode: choose this option if you want to manually partition your hard drive. Be careful – it is a powerful
but dangerous choice. You can very easily lose all your data. Hence, do not choose this unless you know
what you are doing.

4.10. Choose Partitions to Be Formatted

This step is generally ignored for Recommended mode.

Any partitions that have been newly defined must be formatted for use (formatting means creating a filesys-
tem).

At this time, you may wish to reformat some already existing partitions to erase any data they contain. If you
wish to do that, please select those partitions as well.

Please note that it is not necessary to reformat all pre-existing partitions. You must reformat the partitions
containing the operating system (such as /, /usr or /var) but you do not have to reformat partitions containing
data that you wish to keep (typically /home).

Please be careful when selecting partitions. After formatting, all data on the selected partitions will be deleted
and you will not be able to recover any of it.

Click on OK when you are ready to format partitions.

Click on Cancel if you want to choose another partition for your new Mandrake Linux operating system
installation.

Click on Advanced if you wish to select partitions that will be checked for bad blocks on the disk.
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4.11. Choose Packages to Install

It is now time to specify which programs you wish to install on your system. There are thousands of packages
available for Mandrake Linux, and you are not supposed to know them all by heart.

If you are performing a standard installation from a CD-ROM, you will first be asked to specify the CDs you
currently have (in Expert mode only). Check the CD labels and highlight the boxes corresponding to the CDs
you have available for installation. Click OK when you are ready to continue.

Packages are sorted in groups corresponding to a particular use of your machine. The groups themselves are
sorted into four sections:

1. Workstation: if you plan to use your machine as a workstation, select one or more of the corresponding
groups;

2. Development: if your machine is to be used for programming, choose the desired group(s);

3. Server: if your machine is intended to be a server, you will be able to select which of the most common
services you wish to install on your machine;

4. Graphical Environment: finally, this is where you will choose your preferred graphical environment. At least
one must be selected if you want to have a graphical workstation!

Moving the mouse cursor over a group name will display a short
explanatory text about that group. If you deselect all groups when
performing a regular installation (by opposition to an upgrade), a
dialog will pop up proposing different options for a minimal insta-
llation:

Ĺ With X: install the fewer packages possible to have a work-
ing graphical desktop;

Ĺ With basic documentation: installs the base system plus ba-
sic utilities and their documentation. This installation is
suitable for setting up a server;

Ĺ Truly minimal install: will install the strict minimum neces-
sary to get a working Linux system, in command line only.
This installation is about 65Mb large.

You can check the Individual package selection box, which is useful if you are familiar with the packages being
offered or if you want to have total control over what will be installed.

If you started the installation in Upgrade mode, you can unselect all groups to avoid installing any new package.
This is useful for repairing or updating an existing system.
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Finally, depending on whether or not you selected individual packages, you will be presented a tree contai-
ning all packages classified by groups and subgroups. While browsing the tree, you can select entire groups,
subgroups, or individual packages.

Whenever you select a package on the tree, a description appears on the right. When your selection is finished,
click the Install button which will then launch the installation process. Depending on the speed of your hard-
ware and the number of packages that need to be installed, it may take a while to complete the process. An
estimate of the time it will take to install everything is displayed on the screen, to help you gauge if there is
sufficient time to enjoy a cup of coffee.

If a server package has been selected, either intentionally or because
it was part of a whole group, you will be asked to confirm that you
really want those servers to be installed. Under Mandrake Linux,
any installed servers are started by default at boot time. Even if they
are safe and have no known issues at the time the distribution was
shipped, it may happen that security holes are discovered after this
version of Mandrake Linux was finalized. If you do not know what
a particular service is supposed to do or why it is being installed,
then click No. Clicking Yes will install the listed services and they
will be started automatically by default.

The Automatic dependencies option simply disables the warning dia-
log which appears whenever the installer automatically selects a
package. This occurs because it has determined that it needs to
satisfy a dependency with another package in order to successfully
complete the installation.

The tiny floppy disk icon at the bottom of the list allows to load
the package list chosen during a previous installation. Clicking on
this icon will ask you to insert a floppy disk previously created at
the end of another installation. See the second tip of last step on
how to create such a floppy.
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4.12. Multiple CD-ROM Installation

The Mandrake Linux installation is spread out over several CD-ROMs. DrakX knows if a selected package is
located on another CD-ROM and will eject the current CD and ask you to insert a different one as required.

4.13. Root Password

This is the most crucial decision point for the security of your GNU/Linux system: you have to enter the root
password. root is the system administrator and is the only one authorized to make updates, add users, change
the overall system configuration, and so on. In short, root can do everything! That is why you must choose
a password that is difficult to guess – DrakX will tell you if it is too easy. As you can see, you can choose not
to enter a password, but we strongly advise you against this if only for one reason: do not think that because
you booted GNU/Linux that your other operating systems are safe from mistakes. Since root can overcome all
limitations and unintentionally erase all data on partitions by carelessly accessing the partitions themselves, it
is important for it to be difficult to become root.

The password should be a mixture of alphanumeric characters and at least 8 characters long. Never write
down the root password – it makes it too easy to compromise a system.

However, please do not make the password too long or complicated because you must be able to remember it
without too much effort.
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The password will not be displayed on screen as you type it in. Hence, you will have to type the password
twice to reduce the chance of a typing error. If you do happen to make the same typing error twice, this
“incorrect” password will have to be used the first time you connect.

In Expert mode, you will be asked if you will be connecting to an authentication server, like NIS or LDAP.

If your network uses the LDAP (or NIS) protocol for authentication, select LDAP (or NIS) as authentication. If
you do not know, ask your network administrator.

If your computer is not connected to any administrated network, you will want to choose Local files for authen-
tication.

4.14. Adding a User

GNU/Linux is a multiuser system, and this means that each user can have his own preferences, his own files
and so on. You can read the User Guide to learn more. But unlike root, which is the administrator, the users you
will add here will not be entitled to change anything except their own files and their own configuration. You
will have to create at least one regular user for yourself. That account is where you should log in for routine
use. Although it is very practical to log in as root everyday, it may also be very dangerous! The slightest
mistake could mean that your system would not work any more. If you make a serious mistake as a regular
user, you may only lose some information, but not the entire system.

First, you have to enter your real name. This is not mandatory, of course – as you can actually enter whatever
you want. DrakX will then take the first word you have entered in the box and will bring it over to the User
name. This is the name this particular user will use to log onto the system. You can change it. You then have
to enter a password here. A non-privileged (regular) user’s password is not as crucial as root’ one from a
security point of view, but that is no reason to neglect it: after all, your files are at risk.

If you click on Accept user, you can then add as many as you want. Add a user for each one of your friends:
your father or your sister, for example. When you finish adding all the users you want, select Done.

Clicking the Advanced button allows you to change the default
shell for that user (bash by default).

4.15. Configure your Network

This step is generally ignored for Recommended mode.
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You are now proposed to set up your Internet/network connection. If you wish to connect your computer to
the Internet or to a local network, click OK. The autodetection of network devices and modem will be launched.
If this detection fails, uncheck the Use auto detection box next time. You may also choose not to configure the
network, or do it later; in that case, simply click the Cancel button.

Available connections are: traditional modem, ISDN modem, ADSL connection, cable modem, and finally a
simple LAN connection (Ethernet).

Here, we will not detail each configuration. Simply make sure that you have all the parameters from your
Internet Service Provider or system administrator.

You can consult the User Guide chapter about Internet connections for details about the configuration, or
simply wait until your system is installed and use the program described there to configure your connection.

If you wish to configure the network later after installation, or if you are finished configuring your network
connection, click Cancel.

4.16. Check Miscellaneous Parameters

Here are presented various parameters concerning your machine. Depending on your installed hardware, you
may – or not, see the following entries:

• Mouse: check the current mouse configuration and click on the button to change it if necessary;
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• Keyboard: check the current keyboard map configuration and click on the button to change that if necessary;

• Timezone: DrakX , by default, guesses your time zone from the language you have chosen. But here again,
as for the choice of a keyboard, you may not be in the country for which the chosen language should
correspond. Hence, you may need to click on the Timezone button in order to configure the clock according
to the time zone you are in;

• Printer: clicking on the No Printer button will open the printer configuration wizard;

• Sound card: if a sound card is detected on your system, it is displayed here. No modification possible at
installation time;

• TV card: if a TV card is detected on your system, it is displayed here. No modification possible at installation
time;

• ISDN card: if an ISDN card is detected on your system, it is displayed here. You can click on the button to
change the parameters associated with it.

GNU/Linux manages time in GMT (Greenwich Mean Time) and translates it in local time according to the time
zone you selected. It is however possible to deactivate this by deselecting Hardware clock set to GMT so that the
hardware clock is the same as the system clock. This is useful when the machine is hosting another operating
system like Windows .

The Automatic time synchronization option will automatically regulate the clock by connecting to a remote time
server on the Internet. In the list that is presented, choose a server located near you. Of course you must have
a working Internet connection for this feature to work. It will actually install on your machine a time server
which can be optionally used by other machines on your local network.

4.17. Selecting Available Services at Boot Time

This step is generally ignored for Recommended mode.
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You may now choose which services you wish to start at boot time.

Here are presented all the services available with the current installation. Review them carefully and uncheck
those which are not always needed at boot time.

You can get a short explanatory text about a service by selecting
a specific service. However, if you are not sure whether a service is
useful or not, it is safer to leave the default behavior.

At this stage, be very careful if you intend to use your machine as a
server: you will probably not want to start any services which you do
not need. Please remember that several services can be dangerous
if they are enabled on a server. In general, select only the services
you really need.

4.18. Installing a Bootloader

This step is generally ignored for Recommended mode.
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LILO and grub are GNU/Linux bootloaders. This stage, normally, is totally automated. In fact, DrakX analyzes
the disk boot sector and acts accordingly, depending on what it finds here:

• if a Windows boot sector is found, it will replace it with a grub/LILO boot sector. Hence, you will be able to
load either GNU/Linux or another OS;

• if a grub or LILO boot sector is found, it will replace it with a new one.

If in doubt, DrakX will display a dialog with various options.

• Bootloader to use: you have three choices:

1. GRUB: if you prefer grub (text menu).

2. LILO with graphical menu: if you prefer LILO with its graphical interface.

3. LILO with text menu: if you prefer LILO with its text menu interface.

• Boot device: in most cases, you will not change the default (/dev/hda), but if you prefer, the bootloader can
be installed on the second hard drive (/dev/hdb), or even on a floppy disk (/dev/fd0);

• Delay before booting the default image: when rebooting the computer, this is the delay granted to the user to
choose – in the bootloader menu, another boot entry than the default one.

Beware that if you choose not to install a bootloader (by selecting
Cancel here), you must ensure that you have a way to boot your
Mandrake Linux system! Also, be sure you know what you do
before changing any of the options.

Clicking the Advanced button in this dialog will offer many advanced
options, which are reserved to the expert user.

After you have configured the general bootloader parameters, the list of boot options which will be available
at boot time will be displayed.

If there is another operating system installed on your machine, it will automatically be added to the boot
menu. Here, you can choose to fine-tune the existing options. Select an entry and click Modify to modify or
remove it; Add creates a new entry; and Done goes on to the next installation step.
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4.19. Boot Disk

This step is generally ignored for Recommended mode.

The Mandrake Linux CD-ROM has a built-in rescue mode. You can access it by booting from the CD-ROM,
press the F1 key at boot and type rescue at the prompt. But in case your computer cannot boot from the
CD-ROM, you should come back to this step for help in at least two situations:

• when installing the bootloader, DrakX will rewrite the boot sector (MBR) of your main disk (unless you are
using another boot manager), to allow you to start up with either Windows or GNU/Linux (assuming you
have Windows in your system). If you need to reinstall Windows , the Microsoft install process will rewrite
the boot sector, and then you will not be able to start GNU/Linux !

• if a problem arises and you cannot start up GNU/Linux from the hard disk, this floppy disk will be the only
means of starting up GNU/Linux . It contains a fair number of system tools for restoring a system, which has
crashed due to a power failure, an unfortunate typing error, a typo in a password, or any other reason.

When you click on this step, you will be asked to enter a disk inside the drive. The floppy disk you will insert
must be empty or contain data which you do not need. You will not have to format it since DrakX will rewrite
the whole disk.

4.20. Configuring X, The Graphical Server

This step is generally ignored for Recommended mode.
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X (for X Window System) is the heart of the GNU/Linux graphical interface on which all the graphical environ-
ments (KDE , GNOME , AfterStep , WindowMaker , etc.) bundled with Mandrake Linux rely. In this section, DrakX
will try to configure X automatically.

It is extremely rare for it to fail, unless the hardware is very old (or very new). If it succeeds, it will start X
automatically with the best resolution possible, depending on the size of the monitor. A window will then
appear and ask you if you can see it.

If you are doing an Expert installation, you will enter the X configuration wizard. See the corresponding section
of the manual for more information about this wizard.

If you can see the message during the test, and answer Yes, then DrakX will proceed to the next step. If you
cannot see the message, it simply means that the configuration was wrong and the test will automatically end
after 10 seconds, restoring the screen.

The first time you try the X configuration, you may not be very satisfied with its display (screen is too small,
shifted left or right...). Hence, even if X starts up correctly, DrakX then asks you if the configuration suits you.
It will also propose to change it by displaying a list of valid modes it could find, asking you to select one.

As a last resort, if you still cannot get X to work, choose Change graphics card, select Unlisted card, and when
prompted on which server, choose FBDev. This is a failsafe option which works with any modern graphics
card. Then choose Test again to be sure.
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Finally, you will be asked whether you want to see the graphical interface at boot. Note this question will be
asked even if you chose not to test the configuration. Obviously, you want to answer No if your machine is to
act as a server, or if you were not successful in getting the display configured.

4.21. Installation Updates From The Internet

At the time you are installing Mandrake Linux, it is likely that some packages have been updated since
the initial release. Some bugs may have been fixed, and security issues solved. To allow you to benefit from
these updates, you are now proposed to download them from the Internet. Choose Yes if you have a working
Internet connection, or No if you prefer to install updated packages later.

Choosing Yes displays a list of places from which updates can be retrieved. Choose the one nearest you. Then
a package-selection tree appears: review the selection, and press Install to retrieve and install the selected
package(s), or Cancel to abort.
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4.22. It’s Finished!

There you are. Installation is now complete and your GNU/Linux system is ready to use. Just click OK to reboot
the system. You can start GNU/Linux or Windows , whichever you prefer (if you are dual-booting), as soon as
the computer has booted up again.

The Advanced button (in Expert mode only) shows two more but-
tons to:

1. generate auto-install floppy: to create an installation floppy
disk which will automatically perform a whole installation
without the help of an operator, similar to the installation
you just configured.

Note that two different options are available after clicking
the button:

Ĺ Replay. This is a partially automated installation as the
partitioning step (and only this one) remains interac-
tive;

Ĺ Automated. Fully automated installation: the hard disk
is completely rewritten, all data is lost.

This feature is very handy when installing a great number
of similar machines. See the Auto install (http://www.
mandrakelinux.com/drakx/auto_inst.html) section
on our web site;

2. Save packages selection1: saves the package selection as
done previously. Then, when doing another installation,
insert the floppy inside the drive and run the installation
going to the help screen by pressing on the F1 key, and
by issuing linux defcfg="floppy".

4.23. How to Uninstall Linux

Well, that is not recommended, as you may regret it soon, but, that’s your right :-)

The process consists of two simple steps:

1. delete all partitions on your hard drive and replace them by a single FAT partition through Managing Your
Partitions, page 190;
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2. uninstall the bootloader (generally grub ) from the Master Boot Record (MBR). To do so, boot under DOS
and run the fdisk /mbr command.

If you have another OS, consult its documentation to know how to do same thing efficiently.

Goodbye, and thank you for using Mandrake Linux :-)
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Chapter 5. Using Mandrake Linux For The First Time

This chapter discusses the tasks you should perform just after a system is installed. In fact, those tasks should
be regarded as part of the installation process.

We assume that you are already logged in the system, either because you chose auto-login during the installa-
tion (Adding a User, page 22), or you manually logged in. If you do not know how to log in, please read first
Beginning And Ending Your Session, page 39.

5.1. Mandrake First Time Wizard

When a user logs into a newly installed Mandrake Linux system for the first time, a one-time configuration
wizard automatically shows up. This wizard will help you to configure three things:

1. Desktop Theme. This step enables you to customize the look-and-feel of your systems and choose the
behavior of your graphical environment (by choosing a window manager).

2. Internet Configuration. If you did not do it during the installation, the same wizard (“Configuring Internet
Connections”, page 211) will be launched to help you configure your Internet connection and define your
e-mail account settings.

3. Mandrake Registration. This wizard guides you in the Mandrake Linux user registration process. This
step requires you to provide personal information; please read carefully the Mandrake Privacy Policy
preceding the data.

After you completed this step, you will receive a confirmation e-mail.

5.2. Mandrake Online Services

The MandrakeOnline subscription offer is a new service brought to you by MandrakeSoft. It gives you extra
services which render your Mandrake Linux system even easier to work with and more secure.

This offer consists of four main features:

1. E-mail Alerts. According to the packages and their version installed on your machine, you will receive
e-mail alerts about potential security threats and security updates. This solution, sent directly in your
mailbox in minimum time, ensures maximum security for your system.

2. Automated Security Updates. With the rapid growth of the Internet, security has become a major concern
for normal users and a serious threat to corporations. In this new version of MandrakeOnline , you can
now rest assured that your systems will always be up-to-date for security problems. Since we know what
is installed on your system, a nightly process updates all your packages automatically. Obviously, your
Internet connection must be up and running.

3. Rebates on Mandrake Expert (http://www.mandrakeexpert.com/) . Subscribing to MandrakeOnline au-
tomatically entitles you to rebates on the purchase of support incidents.

4. E-mail Alias. Finally, you are given a cool e-mail alias taking the <YourName@mandrakeonline.net> form,
pointing to the e-mail address you provided at subscription time.

Launch the MandrakeOnline wizard from the icon on the desktop to discover this service for a free trial period.

This wizard first asks you if you already registered your account during the Mandrake First Time Wizard, pa-
ge 33. If not, check the box and follow the subscription process. You will then be asked to log in, using the
information provided by the confirmation e-mail mentioned above. When this is done, your machine’s confi-
guration information is sent to our servers, after you agree, of course.
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5.3. Other Optional Configurations

If your machine is meant to always be connected to the Internet or even quite often, you should really consider
installing a firewall on it. Consult the chapter “Securing Your Machine”, page 165 for an easy and efficient
firewall setup.

In case you wish to use this brand new Mandrake Linux system as a LAN (Local Area Network) server, you
can launch the server wizards detailed in the Reference Manual. They will guide you through the configuration
of many useful services for your LAN hosts.
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Discover a New Universe

Now that your installation is complete, let us introduce you to the Mandrake Linux operating system. This
user guide will cover many subjects, ranging from very basic Linux information to Mandrake-specific tools.
Here is a summary of each chapter.

The first chapter, “Linux For Beginners”, page 39, is aimed at those of you who have no or very little knowledge
about GNU/Linux . It contains very basic information. If you have previously used a GNU/Linux system with a
graphical interface, just ignore this chapter.

The next one is dedicated to KDE , Mandrake Linux’s default graphical environment. It is a powerful wor-
king environment, very intuitive, user-friendly and fully configurable. One of its strong points is its superior
graphical design. It comprises a large number of stable applications. Hence, KDE is a very mature desktop
project under Linux .

You will then encounter a chapter about GNOME , another favorite graphical interface. Easy to use and graphi-
cally appealing, GNOME is fully personalizable and stable. GNOME comes with a wide array of applications for
all sorts of tasks such as Gnumeric (spreadsheet), The GIMP (raster graphics) and Galeon (web browser).
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6.1. Introduction

This chapter was written for inexperienced users. If you know how to create an icon on the desktop, skip
ahead to the next chapter. If not, read on!

If we took for granted that all users know how to operate Windows , it would have been easier to write this
chapter. Instead, we decided to write everything from scratch. Hence, any user, experienced or not (who barely
knows how to move the mouse pointer across a screen), can launch programs, properly close them and shut
down the computer. After reading this chapter, all subsequent ones will make much more sense to you.

We assume that you are sitting in front of a running Mandrake Linux computer which, when turned on,
automatically displays the graphical login screen. The latter shows a little box in the middle of your screen
and holds two fields tagged as login and password. This is what you should see if you previously followed the
Installation Guide procedure.

Given the large number of graphical interfaces available under GNU/Linux , it is impossible to document them
all. We will discuss two of the most popular ones: KDE and GNOME .

6.2. Beginning And Ending Your Session

It is important to understand the terms “to log in” and “to log out” since it is unlikely you will find these
terms in a typical dictionary, although you might find them in a cyber dictionary. To log in means: to identify
yourself to the computer. Think of it as a security officer validating who you are before letting you in. After
logging in, the system takes a number of actions in order to give you access to the system’s resources. By
logging in, you start a so-called “session”.

To log out means you are telling the system you no longer need to use it. It closes your personal session and,
the resources (CPU, bandwidth, etc.) you were using are made available for someone else.

Although these definitions are valid within the scope of this chapter,
they are oversimplified. As you read the following chapters, you will
better understand these concepts, their advantages and options.

6.2.1. Identifying Yourself

At this point, you need to fully comprehend both login and password notions. The former identifies you (it
is generally your name or nickname) while the latter is your secret so no one accesses your computer and
grossly fools your “hacking companion”. If you carefully conducted your installation, you already have your
login and password. If not, you must ask the people whom installed your computer to help you out urgently!

You are currently in front of the following display (figure 6-1). Of course, it appears slightly different as the
user names displayed under the penguin icons are probably different.

Figure 6-1. The Login Window
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The login procedure takes place in four simple steps:

1. Place the mouse pointer on the icon corresponding to your login name and press the left button of your
mouse. 1.

2. Verify that your login name correctly appears in the login field just below and now type your secret
password.

You will notice that the letters do not appear while you type them
in the password field. They are replaced by little stars (*), in order
to avoid anyone from seeing your secret password. This is a com-
mon computer behavior whenever you enter a password. Because
of this, make sure you type the correct keys since you can not check
them visually. Remember: passwords under Linux are case sensitive,
which means that if your password is Very_Secret and you type
Very_secret, access will be denied!

3. This step is optional and allows you to choose a specific graphical environment. Basically, the latter
defines the appearance of your screen and the way you interact with the system. We encourage you to try
various graphical environments so you can choose the one you prefer.

As you can see in the Session Type field, the default environment is KDE . You can change it by simply
choosing another one from the pull-down menu. However, we strongly suggest you start with either KDE
or GNOME .

Figure 6-2. The Pull-Down Session Type List

4. Finally, simply click on the Go! button to begin your session. Be patient! It may take a few seconds before
your desktop is ready to be used.

If it is the first time you log onto a freshly installed machine, you will
see the Mandrake First Time wizard. Please refer to the Mandra-
ke First Time Wizard , page 33 for more information.

6.2.2. Closing Your Session

If all went well, you are now in front of your real working environment. In this section, we will not describe
the various components any further since this will be done later in the following chapters. Depending on the
environment you previously chose, you will see of one of the following screens:

1. This action will be abbreviated as “click” from now on. If you need to click on the mouse’s right button, we will refer
to a “right-click” and so on.
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Figure 6-3. First Time KDE

Figure 6-4. First Time GNOME

You may now explore your brand new toy: enjoy!

When you are finally done, do not forget to tell the system you are leaving, that is to log out.

Logging out can be carried out in many ways in both KDE and GNOME . You can use the K menu, log-out icons,
and right-clicking pop-up menus (only in KDE ). Let’s see the different procedures:

Under KDE

• Using The K Menu

Click on the K menu and select the Logout item. A window like the one shown below will appear, asking
you for confirmation.
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Figure 6-5. KDE Logout Confirmation

If you want the applications you were using to open automatically
the next time you log in, just check the Restore session when logging
in next time box. Please note that not all applications support this
feature.

• Right-Clicking on The Desktop

You can right-click on the desktop in an “empty” place and a pop-up menu, like the one shown below,
will be displayed.

Figure 6-6. Logging Out Using The Pop-Up Menu Under KDE

Just click Logout and the confirmation window will appear.

• Using The Log-out Icon

Simply click on the icon shown below to log out as well. As always, the confirmation window will
appear.

Figure 6-7. KDE’s Log-out Icon
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Under GNOME

• Using GNOME’s Main Menu

Click on the GNOME foot menu and select Log out. A window will pop up asking you for confirmation
before logging out.

Figure 6-8. GNOME’s Log-Out Menu

• Using The Log-Out Icon

Click on the log-out icon shown in figure 6-9. As usual, a window will pop up asking you to confirm.

Figure 6-9. GNOME’s Log-Out Icon

After clicking on the icon, the screen will shade and a little box will pop up with options. Simply ignore
the messages and options for now and click the Yes button.

6.2.3. Some Notes About Security

It is important to assimilate a few security notions in regards with your Mandrake Linux box. Some of them
might seem a little bit obvious to some people. Anyhow, here they are:

• do not write down your password on any piece of paper (a post-it for example) that can be seen by anyone;

• always make sure your password is complex enough to keep people from guessing it, but simple enough
for you to remember it! Try to use a mix of numbers and letters with mixed case for your passwords;

It is a good idea to think of a sentence you can remember easily.
Then, take the first letters and/or numbers of every word in the
sentence to form a password. For example, the sentence: “I was
born on September 10th 1973” would make up the password: Iw-
boS101973, which is easy to remember (hey, it is your birth date
after all...) and fairly hard to guess.

• if you have a permanent connection the Internet, when you do not want to use your computer anymore,
it is better to close it completely, as crackers could be able to use your machine. That is, do not just log out
of it, but shut it down (power off). This can be done using the Shutdown button in the login window. In a
Terminal , “su” to root and then type shutdown now -h or halt.

The list above is not extensive at all. There are many things you can think of in order to make your system
more secure. A more detailed analysis of security under Mandrake Linux is done in the Reference Manual’s
msec – Mandrake Security Tools chapter.
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6.3. Using Your Graphical Environment

This section will introduce a few basic concepts and skills about using your computer. You may choose to use
KDE or GNOME during the login process explained above.

6.3.1. Elements Displayed

On your screen are displayed many elements we will now describe.

Figure 6-10. The KDE Desktop

Figure 6-11. The GNOME Desktop

1. On the left of the screen are “icons”, that is little drawings usually enhanced with a short text beneath it
representing the icon’s title or name. Each icon allows you to open a window, within which a program will
run, for instance, a game or a window displaying personal data. In our example, the icon shown above
gives you access to a configuration tool created by MandrakeSoft.

Figure 6-12. Accessing The Mandrake Control Center
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2. In the lower part of the screen is the “panel”. It provides a quick access to useful tools such as a terminal ,
a file manager, etc. Each icon symbolizes an application (or program). Just move your mouse cursor on
one of them and leave it there for a few seconds. A yellow help balloon will appear. It describes the icon’s
function. The panel is retractable; click on the arrow target...

Figure 6-13. KDE And GNOME Retractable Panel

... and the panel will automagically shrink. This makes you gain desktop space. Click again for it to reap-
pear.

3. The icons and the panel are not floating on the screen: they are “stuck” on something called the “ desktop
”, also called “background”. In a sense, the desktop is where everything you see or use lives. Bring your
mouse cursor on the desktop (i.e. on “nothing”) and click on either one of your mouse buttons: a list of
items, called a pull-down menu, appears and gives you access to several functions.

Now we can start playing with all this.

6.3.2. Managing Windows And Desktops

Click on the icon on the desktop (usually, at the left side of the screen). You will hear your hard drive
work a bit. Then, either one of those windows will appear:

Figure 6-14. KDE And GNOME File Managers

You just launched a program (here, a file manager) which runs inside a window.

The window is composed of several parts. On the top is the “title bar”. It shows the name or title of the
program you launched and possibly, the document you are working on.

It can be in two different states:

active, which means you are currently using it, while inactive signifies the program is still running, but you
are not currently interacting with it. Usually, the active title bar is full-colored, whereas the inactive one is
shaded or grey.
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Just under the title bar is the “menu bar”. In our example, it says (from left to right) File, Edit, and so on. Click
on File. A list of items appears in a pull-down menu, each item giving you access to one of the program’s
functions.

Under the menu bar is the “icons bar”, also called the “application’s tool bar”. It is simply one or more rows
of icons, each one equivalent to an item in a pull-down menu: you can see them as a short-hand access to
program features, which you can find somewhere in the menu bar.

The “status bar” usually sits at the bottom of the window. There, you will find information about what the
program is doing. Not all programs offer this feature, but if the one you are using does, remember to check it
if you are lost...

We introduced the word desktop. Now, look at the panel on the bottom of the screen. You can see a group of
four “buttons”:

Figure 6-15. Buttons For Virtual Desktops

These buttons give you access to “ virtual desktops ”, which allow you to open several windows and to
organize them as you wish. More on virtual desktop handling and usage in “The Desktop According to KDE”,
page 55 and “Using GNOME”, page 67.

Sometimes, you may find the window you opened is not where you want on your screen. You may want to
move it to see another window, or simply for convenience.

You can do this very simply with your mouse. Bring the mouse cursor to the window’s title bar, then press and
hold the left button. Just move the mouse (while still pressing the button). The window will simply follow the
movement of your mouse. This is called “dragging” the window. When you reach a position which pleases
you, just release the mouse button: you just fixed the window to a new position.

You can also change the virtual desktop the window is in. This may be handy to logically organize your work
by desktop.

You will need to use your mouse again. With KDE , right-click on the window’s title bar and a pull-down menu
will appear holding an item named Move to. Just point to this item and a list of your virtual desktops will
appear. Simply choose the virtual desktop towards which you want to move it.

With GNOME , right-clicking on the window’s title bar gives you a pull-down menu in which is included the
Send window to item. Then, you can select to move or copy it to another desktop (previous or next).

Figure 6-16. Moving a Window to Another Desktop

You will often find your window is in the right place but it is too small or too big.
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Click on this button in the title bar.

Figure 6-17. Maximizing Windows For KDE And GNOME

Now your window fits your screen! This operation is called “maximizing” a window. Click again on the same
button to bring the window back to its original size.

On the contrary, if you want to hide your window but keep the program running, click on this button.

Figure 6-18. Minimizing Windows For KDE And GNOME

The window seems to disappear. In fact, you resized it to its minimal possible size: an icon. This is called
“minimizing” a window. You cleared the screen space it was using but the program is still running. You can
still see it there on the “task bar” for KDE , “tasklist” for GNOME :

Figure 6-19. The Task Bar Under KDE And Tasklist Under GNOME

To view the window on your desktop once more, just click on the icon associated with it.

In most cases, you do not want to maximize nor minimize the window. You just want some sort of a middle
range where you can adjust the window’s size according to your needs.

You can achieve this with your mouse and the boundary borders of the window.

Bring the mouse cursor to the right edge between the desktop and the running program. Your cursor
will change to a double-arrow. Now act like you did when you moved the window, pressing the left
button and keeping it pressed while moving. The window resizes and its contents rearranges. When
the new size satisfies you, just release the mouse button.

We did this using the right-hand border of the window. You can do the same thing with the bottom, top or
left-hand borders. You can even do it with the window’s corners, in which case you can resize the window in
two directions simultaneously.

Not all windows can resize this way and usually, minimum and maximum (although rare) sizes are defined.

As a final note about the buttons in the window’s title bar, consider this:

Figure 6-20. Closing a Window For KDE And GNOME

If you click on this button, you simply stop the running program: you terminate it, you quit it. This button is
called the “close button”.
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6.3.3. Personalizing Your Desktop

A lot of things can be changed under both KDE and GNOME to suit your personal taste, like the background, the
windows and background colors, the “themes”, the way windows and icons behave, etc.

If you are under KDE , please refer to Desktop Personalization, page 61. If you are under GNOME please refer to
figure 9-3 for more information about how to customize your desktop.

6.3.4. Accessing Programs

You may be wondering how to access all the software you installed during the installation process. This is
rather easy. On the left of the panel, you can see a big icon like this:

Figure 6-21. Application Menu For KDE And GNOME

Just click on this icon (slightly different whether you work with KDE or GNOME ) and you will see a pull-up
menu listing the programs you can run. They are organized by categories, so finding the program you are
looking for is easy.

Please refer to “The Desktop According to KDE”, page 55 and “Using GNOME”, page 67 chapters as we further
our exploration of the desktop.
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Apart from the manuals included with Mandrake Linux, documentation is available from many sources. The
next few pages will offer you some suggestions which you might find useful.

7.1. The Documentation Included With Mandrake Linux

7.1.1. The Man Pages

This is a primary source of information on a day-to-day basis. Each command corresponds to a manual page,
or almost. Also, certain configuration files, library functions for programmers and others, also possess their
own man pages.

Their contents are arranged in different sections. References to these sections are made in the following man-
ner: for example, open(2), fstab(5) will respectively refer to the open page in section 2 and the fstab page in
section 5.

To display a manual page, type man. Its syntax will be as follows:

man [options] [section] <manual page>

Even for man itself, a command is available: man man. Manual pages are formatted, then displayed using the
less pager by default.

The names of the manual pages and their relevant sections appear at the top of each page. At the bottom are
given references to other pages with related subjects (in general in the SEE ALSO section).

You can start by consulting the pages related to the different commands covered in this manual: ls(1), ch-
mod(1), etc.

If you cannot find the right manual page – for example, you want to use the mknod function in one of your
programs but you end up on the mknod command page –, make sure you spell out the section explicitly. In our
example: mknod(2). If you forgot the exact section, man -a mknod will read through all the sections looking
for pages named mknod.

7.1.2. Info Pages

info pages complete the documentation included in the manual pages. The command for accessing info
pages is info.

The info pages have a tree structure, the top of which is called dir. From there, you can access all of its info
pages.

info may be called up in two ways: either by omitting any argument, which will place you at the very top of
the tree structure, or by adding a command or a package name, which will open the relevant page, if it exists.
For example:

info emacs

In the info pages:

* Buffers::

will indicate a link. Moving the cursor to this link (using the arrow keys) and pressing Enter will take you to
the corresponding info page.

You may use the following keyboard shortcuts:

• u: for Up, takes you up one level;

• n: for Next, brings you to the next info page on the same tree-structure level;

• p: for Prev, takes you back to the previous info page.

A great number of commands may be listed by typing “?”.
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7.1.3. HOWTOs

HOWTOs , published by the LDP (Linux Documentation Project), and available in many languages, will help you
configure many aspects of your system. As long as the proper packages are installed (the howto-html-en pac-
kage for the English edition), HOWTOs will provide you with an answer to a specific question or a solution to a
problem on your hard disk. The documentation is located in the /usr/share/doc/HOWTO/HTML/en/ directory.
These are text files in their primary form, although they are also readable in HTML with a web browser, and
printable with PostScript .

The list is quite exhaustive. Get an idea of its length by consulting the index from the main menu:
Documentation→HOWTOs English. When met with a complex problem, start by reading the corresponding HOW-

TO (if it exists of course!). Not only will you be given a solution to your problem but you will also learn a great
deal at the same time. Among others, examples of what is covered range from networking (NET-3-HOWTO),
sound card configuration (Sound-HOWTO), the writing of media CD (CD-Writing-HOWTO) as well as NIS and
NFS configuration.

An important step is to check the modification dates of the HOWTO documents – i.e. the publication date located
at the beginning of the document – to make sure they are up-to-date. Otherwise, their contents may be invalid.
Watch out for old HOWTOs relating to hardware configuration especially, as Linux evolves very fast in that
specific area. Remember also that, in the free software world, the term “old” carries even more weight than in
IT in general: free software may be considered old after being around for fifteen days!

HOWTOs are available online on the LDP (http://linuxdoc.
org/) web site and likely to be slightly more up-to-date the-
re. Have a look at the following as well: HOWTOs classi-
fied by categories (http://linuxdoc.org/HOWTO/HOWTO-INDEX/
categories.html); and FAQs (http://linuxdoc.org/docs.
html##faq).

7.1.4. The /usr/share/doc Directory

Some packages include their own documentation in one of /usr/share/doc’s subdirectories and named after
the specific package.

7.2. Internet

Internet information sources are widespread and web sites devoted to GNU/Linux and its use or configuration
are abundant. However, there are other places than web sites.

Your preferred source of information should be the Mandrake Linux (http://mandrakelinux.com/) official
web site. In particular, check out the support (http://mandrakelinux.com/en/ffreesup.php3) section.

7.2.1. Web Sites Devoted to GNU/Linux

7.2.1.1. MUO

MandrakeUser (http://mandrakeuser.org/) (MUO) is the Mandrake Linux user’s database. It is probably
the largest collection of Mandrake Linux-related documentation on the web. Apart from the online version of
our present wonderful handbook, that is... :-)

MUO collects submissions by Mandrake Linux users. It also features a discussion forum and a community
newsletter. The articles are targeted towards beginners and semi-advanced users. They do not simply repeat
what may be read somewhere else. Their aim is to be practical.

Topics range from administrative issues, like the handling of the shell , to the tweaking of X ’s performances,
GNU/Linux ’s graphical subsystem.
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If you are familiar with Mandrake Linux’s web sites, you probably
know Mandrake Forum (http://mandrakeforum.com/). For those
who are unaware of that site, it acts as a forum for Mandrake
Linux users. There, you will find suggestions, questions as well as
news related to Mandrake Linux and GNU/Linux .

7.2.1.2. Demos and Tutorials

A specific section of the Mandrake Linux web site is devoted to numerous demos and tutorials (http://www.
mandrakelinux.com/en/demos/). They discuss, among other topics, installation and graphical environments;
many aspects of the configuration of your system such as network, package maintenance, server configuration,
etc. Some of the tutorials are also accessible from the installation CD in the tutorial directory.

7.2.1.3. Security-Related Web Sites

Security Focus (http://www.securityfocus.com/)

A very well organized site which reviews current attacks, gives out vulnerability advisories for a remark-
ably great number of products, including Mandrake Linux’s.

Linux Security (http://www.linuxsecurity.com/)

This one is entirely devoted to Linux and includes news, advisories, newsletters, and many resources
such as documentation, forums, tools, etc.

Linux dot com (http://linux.com/enhance/)

An excellent site regularly fed with articles on present security issues. This section of the Linux.com
(http://www.linux.com/) also features articles about desktop issues, sound, etc.

7.2.1.4. Other Linux Web Sites

Out of the multiple existing web sites, here are some of the most exhaustive:

http://www.linux.org/ (http://www.linux.org/)

One of the very first sites devoted to Linux which contains a whole slew of links to other useful sites.

Freshmeat (http://freshmeat.net/)

This is the place to visit to get the latest applications available in the Linux world.

Linux Weekly News (http://www.lwn.net/)

This is one of the most exhaustive Linux publications available. It covers everything from latest security
alerts to new distributions, info about the current and past kernels, books, and a weekly newsletter.

And, of course, remember about your favorite search engines. Generally speaking, it is the most practical
information seeking tool. A few carefully chosen keywords in a search engine will often produce the needed
answers to your specific problem. In Google, you can even make a GNU/Linux -oriented search by typing
Google dot com slash linux (http://www.google.com/linux/).

7.2.2. Mailing Lists

Mailing lists still remain very popular in spite of the multiplication of other means of communication. Almost
every piece of GNU/Linux software has its own mailing list geared towards users, developers, announcers, etc.

The Mandrake Linux project has its own support lists (http://www.mandrakelinux.com/en/flists.php3).

Here, we can not give out a list of addresses but bear in mind that it very often is the best mean to get in touch
with the best experts on a particular subject. Some piece of advice, however:
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• do not post questions which are off-topic. Carefully read the guidelines generally posted when you first
subscribed or where you found the address of the list. We also recommend that you read this version of
the E-mail Etiquette (http://www.iwillfollow.com/email.htm), also known as Netiquette, where some
precious hints are given. If you have spare time, you may also consider reading the corresponding RFCs
(http://www.rfc-editor.org/).

IMPORTANT: remember to always keep the first e-mail you recei-
ve from a mailing list since it normally tells you how to unsubscribe,
if you wish to do so;

• respect the general rules applicable to e-mails: in particular, do not send HTML messages: text only;

• mailing lists usually have archives: check them out! Your question may have been debated just before you
subscribed to the list;

• God helps those who help themselves.

7.2.3. Newsgroups

Before asking for help on newsgroups, it is advisable to find out if your problem has already been cove-
red (or solved) on Dejanews (http://groups.google.com/googlegroups/deja_announcement.html), which
has been acquired by Google. If nothing is relevant to your question, access this newsgroup entirely devo-
ted to Mandrake Linux (news:alt.os.linux.mandrake). Or you may also join many other groups in the
comp.os.linux.* “hierarchy”:

• comp.os.linux.setup (news:comp.os.linux.setup): questions about Linux configuration (devices, configu-
ration of applications) and resolution of miscellaneous problems.

• comp.os.linux.misc (news:comp.os.linux.misc): whatever does not fit in any other group.

• and others...

Before posting to one of these groups, make sure you did your homework and read the available documenta-
tion on your specific issue. If you have not, you will most likely get the following answer: RTFM. And nothing
more!

7.3. General Guidelines For Solving a Problem Under Mandrake Linux

Here are the different means available in your problem-solving quest. Try the first option and only then, if that
did not work, try the second, and so on.

7.3.1. RTFM

“The manual” means that very manual and all the manuals and literature available on that subject. Our pre-
vious sections offer you good starting points. Only when all these resources have been exhausted, you may
start thinking you have indeed stumbled over a real problem.

7.3.2. Search The Internet

The various Internet sites previously mentioned are other excellent starting points. They deal with general and
very specific aspects of your potential problems. Finally, try a general search engine such as Google (http://
www.google.com) or, as mentioned above, the Linux-specific (http://www.google.com/linux/) Google search
engine. And do not hesitate to use the Advanced search (http://www.google.com/advanced_search) option
with very detailed questions, such as the error message you are receiving.
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7.3.3. Mailing Lists And Newsgroups Archives

The previous searches may lead you to general answers which hide the results of your specific inquiry among
many others. To refine your search, this is what you should do.

First, try to find a list which seems specifically linked to your problem, then perform a search in its archive
pages.

Example

You noticed a strange behavior while trying to use grub with a minix partition.

A search using “grub mailing list” keywords in Google gives as a fourth result the link to an archive’s message
of the GRUB mailing-list July 1999 (http://mail.gnu.org/pipermail/bug-grub/1999-July/003129.html). Once
there, you get the URL for the archive’s root: GRUB mailing list archive (http://www.mail-archive.com/bug-grub%
40gnu.org/). It even suggests a search engine. Thus, searching for “Minix” will lead you directly to a patch.

Note that all archives do not propose an embedded search engine. However, in Google for example, you can easily
use the advance field domain to limit your search to the specific site hosting the archive. This strategy may also be
used to exclude sites which keep returning garbage.

For a newsgroups search, Dejanews (http://groups.google.com/googlegroups/deja_announcement.html)
holds the archives for an amazing number of newsgroup channels.

7.3.4. Questions to Mailing Lists And Newsgroups

See the related section above: Mailing Lists, page 51 and Newsgroups, page 52. Reading How To Ask Questions
The Smart Way (http://www.tuxedo.org/~esr/faqs/smart-questions.html) may be of great help.

7.3.5. Directly Contacting The Person in Charge

Use this option as a very last resort and in really extreme situations – unless you want to offer your collabora-
tion! Software developers generally receive mountains of e-mails. Therefore, your anguished question on the
use of the cd command will most likely... be ignored!

The addresses will be found either on the home page of a project’s site or in the software documentation.

A last word however: do not underestimate your neighbors’ skills or those of your local LUG (Linux Users
Group). And, please, do not throw your computer through the window as of yet. If your problem is not fixed
today, it will be tomorrow...

7.3.6. Mandrake Business Services

Finally, facing a really challenging situation, especially corporate users, might consider hiring one of Mandra-
keSoft’s consultants to address their specific needs.

This is truly one of the most amazing feature of open-source products: we have the source, we have the power!
Therefore, almost any problem, no matter how complex, specific or high level, may be solved, right in the heart
of the software.

You might also want to customize your Linux environment to meet very precise goals. For example, you could
use Mandrake Linux as a custom routing application on special devices. Know that MandrakeSoft consulting
services (http://www.mandrakesoft.com/products/business) can help you.
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7.3.7. Training

7.3.7.1. MandrakeSoft Linux-Campus

The Linux-Campus catalog is distributed through a network of partners: Linux-Campus Certified Centers,
and responds to the needs of beginners (users) and experts (administrators).

Complimentary to the technical Linux certification program offered by the Linux Professional Institute (LPI),
the Linux-Campus catalog is the ideal choice when wishing to further your knowledge of Linux and truly
harness the power of open-source software.

Training (http://www.mandrakesoft.com/training/)

7.3.7.2. E-Learning – MandrakeCampus

MandrakeSoft offers a series of on-line training courses available directly from our web site. Although the
curriculum is not as extensive as the Linux-Campus offer, this is a very good place to start exploring Mandrake
Linux.

MandrakeCampus/ (http://www.mandrakecampus.com/)
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Along with GNOME , KDE is one of the two most sophisticated graphical environments. We will now discover
KDE ’s possibilities for every-day work.

8.1. First Steps

8.1.1. Discovering KDE

Figure 8-1. The KDE Desktop

Here is the whole KDE desktop . The panel will be evoked later on. Different icons are directly available on the
desktop:

Access to the Mandrake Control Center , described in the “Mandrake Control Center”,
page 173 chapter.

Configuring or monitoring your network access (please refer to “Configuring Internet
Connections”, page 211).

Mandrake News.

Mandrake Expert.
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Mandrake online services (Mandrake Online).

Mandrake Store, the online MandrakeSoft shop.

Access to printing interface tool.

Launches the file manager from your home directory (please refer to the Konqueror:
KDE’s File Manager, page 91 chapter).

Launches the file manager in order to browse the CD-ROM’s contents.

Launches the file manager in order to browse the floppy disk’s contents.

Tool used to rapidly close (“kill”) an application which is not working correctly.

Table 8-1. KDE’s Desktop Icons

8.1.2. The Panel

K menu used to access the software installed on your machine.

Show Desktop: minimizes all your windows. Click again to maximize them.

Launches the konsole program to use the command line (please refer to the Reference
Manual for extensive information on its use).

Launches the KDE Control Center used to configure your environment. Please refer
to the Changing Styles, page 63 section.
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Direct access to KDE’s Internal Help, page 57.

Also launches the file manager from your home directory.

Launches the Konqueror web browser.

Starts KDE ’s mail client.

Opens up Kwrite , a powerful text editor.

These buttons allow to switch from one “virtual desktop” to another. Please refer to
the Manipulating Virtual Desktops, page 59 section.

The taskbar, which holds a button for every launched application.

Allows to lock your screen.

Allows to log out of KDE .

The clipboard and its parameters.

The clock, which can also display the date (right-click on it and choose Preferences→
Digital Clock. Then, select Show date). Click on it to get a complete calendar.

Click on this button to minimize the toolbar on the right of the screen.

Table 8-2. The KDE Panel
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8.2. KDE’s Internal Help

Figure 8-2. KDE’s Internal Help Window

Click on the life buoy to get KDE ’s internal, on-disk help. You can also launch it by accessing the K
menu, then Documentation→Help.

The left side of the window holds the different available topics. In the example mentioned above, we clicked
successively on Application menu, then Office, and lastly Presentations→KPresenter. The contents are shown in the
right part of the window. In the text, the words in blue are hyperlinks. Simply click on one of them to move
to another part of the document. Since it is easy to get lost using this process, use this arrow which allows to
go back one or many steps:
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8.2.1. Unix Info And Manual Pages

Figure 8-3. Accessing Unix Manual Pages Through The HelpCenter

These two categories are not KDE -specific. They exist on practically every UNIX -type systems. The manual
pages (commonly referred to as man pages) are the historical and internal help pages under UNIX , and are
provided with those systems almost since they were conceived. They are an inexhaustible source of informa-
tion about system commands, its internal functions, configuration file formats... Click on this subject to browse
the covered topics.

The info pages (right below in the Unix manual pages entry in the KDE HelpCenter ) hold almost the same
thing, but their presentation is different. They were developed within the GNU project’s framework in order
to compensate for some of the man pages’ weaknesses.

8.3. Manipulating Virtual Desktops

8.3.1. A Little Bit of Practice

Normally, the internal help window is displayed by default in the first virtual desktop.

Now click on the second virtual desktop’s button, then on the text editor icon (see The Panel, page 56) to launch
it. Reduce the window a bit (let’s say to a quarter of the screen), and place it in the lower right corner.

When this is done, go to the third virtual desktop by clicking on button number 3. Then, launch the Konqueror
file manager by clicking on the appropriate icon (see The Panel, page 56). Notice that the screen seems to empty
itself when you switch virtual desktop.

Each button of the virtual desktop’s button bar is a tiny representation of each desktop’s
contents. Click on the second desktop: you will find the text editor in its corner. Press on
Ctrl+F1: you will go back to the first desktop, where the internal help window is waiting
for you.

8.3.2. Sticking or Transferring Windows

Choose any topic in the KDE HelpCenter . Then, click on the stick-off thumbnail (as shown
in the table below) located on the left side of the title bar:
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The stick-off thumbnail.

The stick-on thumbnail.

Table 8-3. Stick-On And Stick-Off Thumbnails

it transforms itself into a stick-on thumbnail, and the virtual desktops’ buttons change
aspect.

Now, go to the second virtual desktop: you will find exactly the same window. Change the displayed help
section, then switch to the fourth desktop, for example. The displayed section is the one you just selected. It is
one and only one window, not many help windows.

Click again on the thumbnail to un-stick the window.

However, it often happens that a window is in the way, this may be cumbersome. Naturally you can reduce
its size, but here is another possibility. Click on the right button of the help window’s title bar and choose To
Desktop→Desktop 1.

The window disappears! But you did not close it. If you look at the buttons on the virtual desktop, you will
see that its silhouette is now in the first desktop. Go in that desktop and without a doubt, you will find it. You
transferred it.

8.3.3. Virtual Desktops Numbers And Naming

According to your activities, you can estimate how many default virtual desktops you need. Right-click on
the virtual desktop and choose Preferences in the contextual menu.

Figure 8-4. Configuring Virtual Desktops Under KDE

On the upper-right part of the window is a slider which allows you to define the number of virtual desktops.
In our example, we considered six of them, but you can set up to 16 desktops (however, this does consume a
lot of memory).

Moreover, you can attribute a name to each desktop: here, the first four have been given names to describe
their role. This allows to organize your work easily and clearly. To see the names of your desktops in the
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buttons, you must first validate the preceding window. Then, right-click on the desktop’s buttons and choose
Name. You will then see the names appear in the buttons. However, this disables the desktops contents.

8.4. Desktop Personalization

8.4.1. Creating Icons

To create an icon, simply click on the desktop’s background. A pull-down menu will appear, in which you
must choose Create New. Another menu will pull down in which will be listed the objects you can create on
your desktop:

Figure 8-5. Creation Menu Under KDE

8.4.1.1. Icons Pointing Towards a File or a Folder

As you can see, you can create directories, many types of files, etc. In fact, it is not recommended to create files
or directories on the desktop: it is much more preferable to create them in the normal manner, that is from an
appropriate program.

You can create a desktop icon by pointing at a folder or a file and simply dragging the icon from the file
manager onto the desktop. This technique is detailed in the Copying, Moving or Linking Files, page 95 section,
dedicated to the Konqueror file manager.

8.4.1.2. Icons Pointing Towards Applications

We will now create an icon pointing towards an application. In the Create New menu, choose Link To Application.
This dialog box appears:
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Figure 8-6. Creating an Application Icon Under KDE

The Link To Application field is where you must enter the icon’s name. For example, let’s create an icon for
gqview , an image viewer. Type GQview in the said field.

For the moment, let’s not bother with the Permissions and Application tabs:

Figure 8-7. Program to Create an Application Icon Under KDE

Here, you must indicate which program you want to execute. If possible, enter the complete path to a program.
You can also use the Browse... button to find the file you need. Now type /usr/bin/gqview. Again, discard for the
moment the other parameters. When you are finished, click on OK.
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The new icon appears on the desktop: click on it to launch the program associated with it.

8.4.1.3. Icon Linking to a Web Site

Now, we will create an icon for an Internet site: choose Link to Location (URL) in the Create New menu. A dialog
box will pop up and you will need to enter the web address. For example, we chose the Linux Documentation
Project web site:

Figure 8-8. Creating an Icon For a Web Site Under KDE

Click on OK when you have entered the correct address. The icon will then appear on the desktop: click on it
to launch the web browser which will display the corresponding page (of course, you need to be connected to
the Internet in order to do so).

8.4.1.4. Deleting or Modifying Icons

If you do not like the default image or name of the icon, you can change it (like you can change any icon’s
parameters). Right-click on the icon and choose Properties in the pull-down menu. You will get a window very
similar to the one we saw when we created an icon pointing at an application.

In the text field, enter the icon’s new name. The big button allows you to chose another icon. Click on it and
you will get the following window.

Figure 8-9. Choosing an Icon Under KDE

The icons can come from different Icon sources: use the pull-down list on the right to change it. Then, just click
on one of the icons. On the other hand, if you choose Other Icons, you can choose any image for your icon’s
graphic look: use the Browse button in order to do so.

Like always, press on OK when you are done.
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8.4.2. Changing Styles

This time, we will use a module contained in the KDE Control Center . Launch it by clicking on its icon (see
The Panel, page 56) on the panel. This program will allow you to access practically every configurable aspect
of KDE .

The parameters you can change are sorted by categories, which helps your research. Each name is pretty
explicit. To start, you can use the LookNFeel category. You will be able to control the manner in which your
graphical environment is drawn. Choose the Style module which will display this window:

Figure 8-10. KDE’s Default Style

Style controls the manner in which the different graphical elements are drawn: the buttons, check-boxes, etc.
These elements are usually designed as widgets.

In the upper-list, select for example the Marble style and validate with the Apply button. You get:

Figure 8-11. The Marble Style for KDE

Use the list to find the style you prefer. You can always go back to the default style by clicking on the Use
Defaults button and then on Apply. Click on OK when you are finished.

The Other settings for drawing options deal more with the whole desktop:

Menubar on top of the screen in the style of MacOS

This option enables your desktop to work in a MacOS fashion. The pull-down menus of an application
are shown at the top of the screen, instead of being at the top of the window.

Apply fonts and colors to non-KDE apps

If you use applications which were not written for KDE , this feature will try to apply KDE ’s visual param-
eters. Note that this feature does may not work for every application.

Use Anti-Aliasing For Fonts And Icons

This allows you to soften the characters’ and icons’ anti-aliasing effect on the screen, which might be
easier on your eyes. However, this is resource-intensive and may slow your computer down.

Finally, the Style options for toolbars allow to modify the toolbar’s aspect in KDE applications. For example, if
you select Text aside icons, the text editor’s toolbar will resemble this:
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Figure 8-12. Text Aside Icons Under KDE

If, however, you choose Text under icons, this same toolbar becomes:

Figure 8-13. Text Under Icons in KDE

8.4.3. Background

Still in the KDE Control Center , in the LookNFeel section, choose Background. You can also obtain this module
by right-clicking on the desktop’s background.

Figure 8-14. Configuring The Background

At the top, you can see a list of your virtual desktops. You are configuring the one which is highlighted. Each
desktop can have its own configuration. If you want a unique configuration for all of your desktops, click in
the Common Background check box. In real time, you will get a preview of your configuration in the upper-right
corner of the window.

The first tab, Background, is used for a “simple” configuration. With the Mode tab, you can either define a flat
or different vertical/horizontal gradients. You can even choose a Background Program, that is a program which
will update periodically your background: click on the Configure button to choose your program. Try kdeworld,
for example, it’s not bad!
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Figure 8-15. Configuring The Wallpaper For The Background

The second tab, called Wallpaper, allows to display an image on the background. This time, the Mode list con-
trols the manner in which the image is displayed: tiled, if the image is too small for the screen; or scaled, to
adjust it to the screen’s size. You can choose a Wallpaper or use the Browse button to choose from your personal
images.

Figure 8-16. Background Advanced Effects

Finally, the third tab named Advanced allows to Blend the background (first tab) with the second wallpaper
(second tab). The background is a vertical gradient from white to gray, and the wallpaper is a tiled image. The
image on the left shows the wallpaper without blending, whereas the image on the right applies a Horizontal
Blending.

Figure 8-17. Example of Advanced Effects
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This chapter is dedicated to GNOME , another favorite graphical user interface. Although its features resemble
a lot those of KDE , the user interface is a bit different to what you might be accustomed to. GNOME and KDE

provide roughly equivalent functionalities (even though each one of them have their own die-hard fans who
would argue otherwise). Moreover, you can use GNOME applications in KDE and vice versa. So you can get your
work done with either one of them – choose the one you prefer. All Mandrake Linux tools and menus work
equally well in GNOME and KDE : our goal is to provide you with the best of both worlds.

9.1. GNOME at a Glance

When you log in to a GNOME session, you will see the GNOME desktop, similar to the one shown in figure 9-1.

Figure 9-1. GNOME Desktop

9.1.1. Panel

The long bar at the bottom of the GNOME desktop is called the GNOME Panel . It contains a number of useful
applets/programs. Applets are tiny programs designed to work inside the panel. The most important one of
them is the Main Menu (button with a footprint at the left side of the panel). It provides access to all GNOME (and
not only GNOME ) applications and commands. We will discuss the Main Menu in GNOME Main Menu, page 72.

The GNOME Panel also contains buttons for launching applications, for logging out and locking your screen,
and a number of other applets. For example, the Clock applet on the far right shows the current time, and the
Tasklist applet (in the middle of the panel) shows the list of all application windows on your desktop. The
GNOME Panel will be discussed in The GNOME Panel, page 68.

If you change virtual desktops, you will only see the windows opened
in that specific desktop.

9.1.2. Desktop

Everything outside the panel is called “desktop”. You can place icons for files, applications, and other items
on it. For example, the default configuration of GNOME shipped with Mandrake Linux contains icons for your
home directory (at the top left corner), several useful applications (such as Mandrake Control Center ), Man-
drake Linux web sites and a trash can. To open any of these objects, double-click on it:
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• if the item is a program, that program will start;

• if it is a data file, the appropriate program will start up with that data loaded;

• if it is a directory, the file manager will be launched and show the contents of that directory;

• if it is a web address, GNOME will start your default web browser to show this site.

You can also right-click on any of these icons to produce a pop-up menu, which contains list of actions for
this icon. This list contains items Show Properties (which also allows you to change some of the properties. For
example, select a new icon), Move to Trash, as well as other options.

In fact, the same conventions (double-click to open, right-click for
pop-up menu) apply to almost every GNOME component.

9.1.2.1. Desktop Menus

Finally, here are some useful menus for your GNOME desktop:

Desktop Background Menu

Right-clicking anywhere on the desktop (away from the icons, application windows, and the panel) pro-
duces the Desktop Background menu. Among other things, this menu gives you access to your CD-ROM,
floppy disk, and other removable drives. It also enables to change the desktop background image, place
new icons on the desktop, and more.

Root Menu

Clicking on your desktop (away from the icons, application windows, and the panel) with the middle
mouse button produces the Root menu (also called the Window Manager menu). (If you have a two-button
mouse, press left and right mouse buttons simultaneously to emulate a third one.) Its most useful sub-
menu is the Windows, which contains a list of all your application windows. This is very convenient when
you have so many opened windows that you can not find the one you need. The Root menu also holds
the Help sub-menu, providing a quick way to access the GNOME Help System.

9.2. The GNOME Panel

In this section, we will describe the many features of the GNOME Panel . It sits at the bottom of your screen and
contains buttons for the the tools you frequently use. A typical GNOME Panel is shown in figure 9-2.

Figure 9-2. GNOME Panel

The GNOME Panel can contain several types of objects:

• menu buttons, such as the Main Menu button (with the footprint);

• buttons that launch applications (in short, launchers);

• applets, i.e. small programs that work inside the panel, such as clocks or various load monitors;

• some other types of buttons, such as the Logout button.

To use any of the buttons, just click on it with the left mouse button. As for applets, many of them (such as
the Clock applet) just do their work without your interaction; others (such as GKB Keyboard Switcher ) will
react to your mouse clicks. You can also learn more about any object on the panel, configure it, or remove it
from the panel by right-clicking on it and choosing the appropriate action from the pop-up menu.
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9.2.1. Some Useful Panel Buttons And Applets

To show some of the most useful buttons and applets you can place on the GNOME Panel , we list below all
objects shown in the panel in figure 9-2. You can easily add these and other buttons to your panel, or remove
unneeded objects as described in Configuring The Panel, page 71.

Starting on the left-hand side is the GNOME Main Menu, which contains all your applications, from text
editors to office applications to configuration tools. (And games, too!) This is the most frequently used
button in the GNOME Panel . An overview of what you can find in this menu will be given in GNOME
Main Menu, page 72.

Next to it is the Log Out button. It allows you to log out of your session, either because you are leaving
work, or to let other users to use the computer. If you click on it, it will prompt you for confirmation and
ask if you want to save the changes you made to your session. Selecting this option will save the current
state of your session, i.e. the list of applications you currently have running and their state, so that next
time you login, GNOME will start the same applications for you and you can continue your work. (The
logout dialog can be configured in GNOME Control Center , which we will discuss later on). After you
click OK in the logout dialog, GNOME will close all your applications and the computer will return to the
login screen (this is the screen where you have to enter your user name and password).

Next is the Lock Screen button. As you probably noticed, most GNOME application and applet names are
extremely logical. This button allows you to lock your screen while you are away from your computer. To
unlock the screen, you must enter your password. This helps to avoid unpleasant the surprise of someone
reading your documents or messing up your files while you are away.

This icon symbolizes the Nautilus file manager. Clicking on it will launch a powerful, multi-functional
application with which you can browse through your files and access the GNOME Help System . You can
also check out your favorite news sites headlines through the News tab, as well as browse the web.

The Help icon gives you access to the GNOME Help Browser which comprises the GNOME User’s Guide,
Man Pages, Info Pages and GNOME Documents.

Although the information contained in the GNOME Help Browser

is accurate, it is considered to be slightly out of date. Please use
Nautilus ’s Help tab to consult GNOME -specific documentation.

The GNOME terminal is a GNOME -specific command line. It gives you access to the most powerful tool of
all: the command line. Please note that there are many different terminal programs, each one providing
access to the command line. If you explore the Terminal section in GNOME ’s Main Menu, you will find many
options for command lines, such as eterm , xterm , etc.
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The GNOME Control Center will help you configure your graphical environment to your liking.

Here’s a screen shot of it:

Figure 9-3. GNOME Control Center

Feel free to explore it as it contains many options. You can personalize the appearance of your menus and
panels, desktop background and mouse settings, default start-up applications, and much much more.

This applet is called the Takslist and shows you the list of all application windows (including mini-
mized, or iconified ones). You can use this applet to quickly switch to the window you want (by clicking
on its name in the tasklist), close a window or even kill a misbehaving application (right-click on the
window name and choose the appropriate action from the pop-up menu).

The GNOME Desktop Guide applet (sometimes also called GNOME Pager ) allows you to split your work
area into several workspaces (sometimes also called virtual desktops). Think of them as being several
desktops, containing different applications and your physical screen showing only one of them at any
given moment. In our example, four workspaces are set up. In your daily work, you can separate your
applications logically: in the first workspace, you could place your communication applications (Internet,
chat, e-mail); in the second one, your favorite text editor, and so on. To surf through them, simply click on
the one of the four areas of the GNOME Desktop Guide applet and your physical desktop (the one you are
looking at right now) will change and show the contents of that workspace.

The clock. You may change its properties by right-clicking on the icon and choosing Properties: you can
change it to 12/24 hour and a couple of simple options. However, you may select another clock in the
Main Menu→Panel→Add to panel→Applets→Clocks. Some clocks even have a mail-check option.
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Finally, the Mail check. By default, it is not configured. Right-click on it and access the Help section which
will open the Mail Check Applet Manual inside the Nautilus file manager. It is fairly simple to configure
and when done, very convenient.

9.2.1.1. Other Practical Applets

Here are other applets which can come in handy. You can access them through the Main Menu→Applets menu
and add them to your GNOME Panel by right-clicking on the panel and choosing the Panel→Add to panel menus.

The GKB Keyboard Switcher allows you to switch your keyboard to one of many available layouts, cov-
ering languages from Azerbaijani to Vietnamese. If you are trilingual, you can easily select, for example,
French, English and Spanish as your main keyboard languages. The flag (Québec in our screen shot) repre-
sents the language you are currently using. Simply click on the icon to change your keyboard’s language.
To add or modify it, right-click on the icon and choose Properties.

Please note that currently, the keyboard switcher will only work co-
rrectly if the language you have chosen uses the same character set
as your default language (the one you selected during installation
or during login). For example, if your default language is English,
you can use French or Spanish keyboards but you won’t be able to
use Russian or Greek ones. Thus, if you need to type in Russian,
you will need not only to select Russian keyboard but also switch
your default language (locale) to Russian. You can do this by is-
suing /usr/sbin/localedrake on the command line. Note that
you must be root in order to launch it.

Next is the Load Average applet, which indicates your processor’s load state. If you see it skyrocket and
get all yellow, green and gray, it means one or many of your applications is going crazy... We will see later
how to fix this in the Reference Manual.

To insert this applet on your panel, choose the Main Menu→Panel→Add to panel→Applet→Monitors→Load
Average item.

9.2.2. Configuring The Panel

The panel (as well as most GNOME components) is highly configurable: you can add or remove objects, change
the panel size, color, or button appearance, and more. For a comprehensive description of these options, we
refer the reader to GNOME Panel Manual (you can find it in Main Menu→Panel→Panel Manual...). Here are some
of the most useful operations:

• To remove an object from the panel, right-click on it and choose Remove from panel;

• To add an application launcher button to the panel, find this application in the Main Menu, right-click on it
and choose Add this launcher to panel;

• To add an applet, logout button, or other object to the panel, choose Main Menu→Panel→Add to panel and
choose the desired object;

• To move a panel object, drag it to the new location with the middle mouse button (if you don’t have a
three-button mouse, press on the two buttons simultaneously);

• To move the whole panel to a different side of the screen, drag it with the middle mouse button.
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9.3. GNOME Main Menu

The GNOME Main Menu holds everything you need to fully utilize your new Mandrake Linux system, such as
applications, configuration tools, and more. Note that it uses a special menu configuration which ensures that
all of the applications you installed will appear in both GNOME and KDE menus.

You can launch Main Menu by using the shortcut key Alt-F1 or the
Windows key in between the Ctrl and Alt ones.

Don’t be surprised if you think you saw some of the utilities previously. In fact, we already mentioned the
Panel sub-menu and Log out buttons, only to name those. So when you open your GNOME menu, the first items
you should see are the Log out, Lock screen and the Panel sub-menus. The latter allows you to configure your
panel (color, location, size, etc.). Surf through the different options to fully personalize them to your liking,
and read the GNOME Panel Manual for more detailed information.

Figure 9-4. Getting Around The GNOME Menu

Run Program

This item allows you to enter a command to be executed by your system. This is an efficient tool, for
example, for launching applications which are not in your menu. Say you want to run Emacs , simply
choose Run and type emacs in the blank field and voilà, Emacs is launched.

You can also launch Run Program dialog by using shortcut key Alt-
F2.
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Figure 9-5. Run Your Favorite Applications

Applets

This sub-menu is split into six other menus: Amusements, Clocks, Monitors, Multimedia, Network and Utility.
Choosing one of these applets will add it to your panel. This sub-menu is equivalent to Panel→Add to
Panel→Applets.

Figure 9-6. Add Applets to Your Panel

Documentation

Two default items located in this sub-menu are About Gnome and Help System (for the latter, you can also
click on the Help applet described previously or refer to Getting Help, page 74. The About Gnome sub-menu
leads you to an interface which gives you three choices: GNOME News Site, GNOME Main Site and GNOME
Developer’s Site. Depending on which packages you installed, you may also find HOWTOs.

Amusements

Guess what? Linux holds a set of fun games, such as GNOME Chess, Xgammon and KAsteroids, etc.

Configuration

Wishing you could modify configuration parameters? Explore this sub-menu as you will find useful
applications to better manage your Mandrake Linux system. Included are KDE (which contains utilities
for configuring the KDE desktop and applications), Boot & Init, GNOME , Hardware, Printing, Packaging and
Networking sub-menus. Be careful what you do in the Configuration menu, you may damage your system.
In doubt, please ask a qualified system administrator.

Networking

If your main computer use is Internet-related, this is the section for you. Here you will find Chat, File
transfer, Instant messaging, IRC, Mail, News, Other, Remote access and WWW sub-menus. Remember: many
programs exist for all of those items. Feel free to test a few clients before using by default software such as
Netscape netscape . For example, GNOME ’s default Web browser, Galeon (which we document in Internet
Browsers: Galeon, page 147) and e-mail client, Evolution have made tremendous progress over the last
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six months and are now stable and lean (although the latter is still pretty resource-intensive). Give them
a try – we guarantee you will never want to use Netscape again! Or you could use KDE applications such
as the Konqueror browser or KMail mail client (please refer to Internet Mail: KMail, page 150. This is one
of GNU/Linux ’s strong points: you have a wide array of software applications to choose from.

Terminals

As previously stated, this sub-menu contains many terminal emulators, giving you access to the com-
mand line. Once again, choose the one you feel most comfortable with.

Applications

This sub-menu (along with the next one, Office) is one you are most likely to explore in depth. The list of
applications is pretty long. Let us quote a couple of interesting sub-menus such as Text Tools, Communica-
tions, Editors and Publishing.

Figure 9-7. A Vast Array of Applications to Choose From

Office

Typical office tools are contained in this sub-menu: spreadsheet, text editor, PDF viewer clients.

Multimedia

MP3 aficionados and graphic artists, this is your hot corner. There you can opt for XMMS , your MP3 player
par excellence, GIMP to edit your favorite images and personal graphic work and different sound mixers,
etc.

Figure 9-8. Multimedia: XMMS, GIMP, etc.

9.4. GNOME File Manager: Nautilus

Nautilus is a user-friendly graphical file manager for GNOME . In fact, it is more than just a file manager: it
is also responsible for managing your desktop and its icons, it can be used as a help or web browser, an FTP
client – even as an MP3 player. We will discuss it in detail in Nautilus: GNOME’s File Manager, page 101.
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9.5. Getting Help

This chapter gave you just a brief introduction to GNOME . Fortunately, GNOME comes with extensive user do-
cumentation, including a short Introduction to GNOME, comprehensive GNOME User Guide, and on-line help
for almost all GNOME applications. The easiest way to access this help is to use the Help tab of Nautilus (see
Nautilus: GNOME’s File Manager, page 101), which lists all of these documents conveniently organized by
subject.

Unfortunately, Nautilus can be slow on older systems. In this case, you can use instead an older GNOME Help

Browser . To launch it, choose Main Menu→Documentation→Help System (you can recognize it by the question
mark icon). It provides less features than Nautilus (for example, it can only show an alphabetical list of
documents, not a subject one), but is much faster.

Both Nautilus and the GNOME Help Browser allow you to read documentation for non-GNOME applications,
such as man pages and info pages. The standard documentation format for command-line applications co-
mes in the form of Man pages. They are usually very detailed but rather technical. Info pages are the docu-
mentation format used by utilities from the GNU project, such as (arguably) the most powerful text editor
ever created, Emacs .

Finally, if your computer is connected to the Internet, you can also find a wealth of information about GNOME
on the web. Point your web browser to the GNOME web site (http://www.gnome.org/) and explore!

That’s all for our GNOME tour. The only way to master GNOME is to read, practice, read, practice, read... You
understand :-)
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III. Use





Introduction to Everyday Applications

This part will cover Office Work (StarOffice Writer, Gnumeric, StarOffice Impress), file managers (Konqueror
and Nautilus), graphics tools and practical devices (GIMP, digital cameras, scanners, printers), multimedia
(sound and video) as well as Internet usage.

1. Using Mandrake Linux on a Daily Basis

This chapter is an introduction to the many applications available under Mandrake Linux. First, we will
explore office tools such as StarOffice Writer , Gnumeric and StarOffice Impress . Then, we will describe
two popular file managers: Konqueror and Nautilus .

We will then describe the functioning of graphics tools such as The GIMP ; since graphics are very closely tied
to many devices, we will also talk about digital cameras using GTKam , scanning with ScannerDrake , printing
with KPrinter and CD burning with X-CD-Roast .

We will then explore the world of multimedia. On the sound side, we will describe XMMS , a multi-format audio
and movie player, Kscd , a simple CD player, as well as Aumix , a mixer. On the movie side, topics will cover
XMovie and Xawtv . For video-conferencing, we detail the usage of GnomeMeeting .

Finally, we will focus on the Internet. KMail is the mail client we chose to document while Galeon will let you
browse the web. The instant messaging client Gaim , which is compatible with many popular protocols, as well
as XChat , an IRC client, close out this chapter.

Enjoy!
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10.1. StarOffice Writer

StarOffice was conceived by Marco Börries in 1985 and he was so successful with this office suite that
he decided to offer it to a wider range of users, that is GNU/Linux , MacOS and Windows users alike. In this
chapter, we will refer to the 6.0 version, which is different from the OpenOffice.org suite developed by Sun
Microsystems and the open-source community. The latter, however, is completely GPL, whereas the one we
describe is still in binary form, therefore proprietary. This may mean absolutely nothing to you. If you feel
dazzled, please refer to the Reference Manual’s The GNU General Public License appendix.

As we are writing this documentation, we are still unsure whether
StarOffice or OpenOffice.org will be included in our distribu-
tion. The OpenOffice.org package should be either in the main
CD-ROM or in the contribs section.

The StarOffice Suite can be used for many purposes. It acts as a WYSIWYG (What You See Is What You
Get) word processor, a spreadsheet, a presentation software, etc. In this section, we will describe the word
processor’s functioning, while the StarOffice spreadsheet will be described in the section called Spreadsheets,
page 86.

10.1.1. Getting Started

Figure 10-1. Writing Documents

Let us go through the menu in order for you to grasp StarOffice ’s capabilities. But first, to launch StarOf-

fice , click on your KDE menu icon, then choose the Office→Wordprocessors sub-menu and choose StarOffice .
You can also create a symbolic link on your desktop. To do so, right-click anywhere on your desktop and
choose Create New→Link to Application.
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Figure 10-2. Linking to StarOffice

Then, write the name of the application in the dialog box followed by the extension .desktop and choose an
icon by pressing on the default one. Also, in the Execute tab, you must set the path for the application to be
launched. It should be:

/home/your_user_name/staroffice60/soffice

Figure 10-3. Linking Properties

A little comment about keyboard shortcuts... Many of us are still
fascinated by this little two-or-three button thing called the mouse.
Keyboard shortcuts allow to execute simple commands and apply
them for specific meanings, hence leaving your hands on the key-
board and accelerating the rhythm at which you can make your
work progress. As an example, Ctrl-O opens a document, Ctrl-C
copies a piece of document which you want to copy elsewhere, etc.
Browse through the menus, you will see that shortcuts are set for
most major functions.

File Menu

It enables simple commands such as Open, Close, Print, etc. This is probably the mostly used menu since
it holds the utmost basic commands. It is also through this menu that you access the latest opened docu-
ments.

Edit Menu

Since it contains the famous Cut & Paste commands, it is also largely utilized. The very practical Find &
Replace option is also found in this menu. Ctrl-H pops up this familiar window.
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Figure 10-4. Finding And Replacing Words

Notice the little underscore under each menu item. This is another
rapid way to access commands. For example, Alt-E (Edit Menu) and
the N character is a shortcut to the Navigator (F5 is another way
to access it).

Figure 10-5. StarOffice Navigator

View Menu

The Zoom, Toolbars and Nonprinting character are within this handy menu. If you have the unfortunate bad
luck of owning a 14” screen, you will surely appreciate the zoom option... By configuring your toolbar, if
you are a mouse aficionado, remove the buttons you never use and replace them with more often-utilized
ones. As for the Nonprinting character, it facilitates basic letter and document layout, in order to be very
precise.

Figure 10-6. Nonprinting Characters
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Insert Menu

This menu holds very practical features such as Manual Break, Headers, Footers and the Indexes. The first one
is often used when you prepare documents in which you want the sections to start at the top of a page,
not halfway through. Note that Ctrl-Enter gives you the same result. The Headers & Footers option avoids
repeating the same document title at the beginning or end of a page, which is, you will admit, tedious to
say the least. When you are responsible for medium-to-large documents, you might want to index them
and create a table of contents, which you can create through the index sub-menu.

To insert tables, files or images, this is the menu. Alt-I and the t
character pops up a dialog window in which you can choose the
number of table rows and columns you wish to insert.

Figure 10-7. Create Tables For Your Documents

Format Menu

This menu contains essential formatting features, such as Character, Paragraph and Page. The first one ap-
plies font, style and size parameters, amongst others, to your document. Click on the different tabs and
you will find font effects, hyperlinks and background features. The Page sub-menu allows general and
more advanced page formatting. In the Paragraph sub-menu, you determine background colors, indent
and spacing, tabs, etc.

Tools Menu

A writer’s best friends reside in this menu: Spellcheck, Thesaurus and Options. When you select the Spellcheck
option (or F7), you launch a corrector which indicates what words are badly spelled. Note that the lan-
guage must properly be set before trying to correct a document (i.e.: you want to correct an English
document but the French dictionary is active: mission impossible). If you wish to change the language for
a specific document, access the Tools→Option and then change the Language parameter to the desired lan-
guage. As for the Thesaurus option, it also pops a window from which you can select same-family words
and synonyms.

84



Chapter 10. Office Work

Figure 10-8. Spellchecking Documents

The Options menu, however, is the most important personalization tool. There, you can set the correct
paths for opening directories directly instead of having to browse your entire tree to find a file.

Figure 10-9. StarOffice Options

Windows Menu

This menu gives you access to all the documents you opened.

Figure 10-10. Accessing Your Documents

Help Menu

Finally, this is the one to go to if you need specific help on anything concerning StarOffice . Say you have
a question about hyperlinks. Just select that topic in the index. If you are not accustomed to software such
as the one we are describing, maybe you should enable the Tips and Extended Tips. Once you remember the
operations you do everyday, however, you will soon want to disable them since they can get annoying...

10.1.2. Getting Help

We hope our introductory tour of StarOffice will help you use this great software. However, if you were to
have any problems, here are a few sites which might help you out:

• Sun web site (http://www.sun.com.staroffice/): the StarOffice section describes all the features, in-
cludes a FAQ and a Support Forum (http://supportforum.sun.com/staroffice/);
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• OpenOffice web site (http://openoffice.org/): this site is dedicated to the free version of StarOffice .
Although it is not directly related to StarOffice , you might find relevant information there.

10.2. Spreadsheets

This section will speak about Gnumeric as a replacement for Microsoft Excel . Another very good, and now
free, option is StarCalc StarOffice ’s spreadsheet application.

This introduction won’t explain basic accounting principles and takes for granted you know why you would
like to use a spreadsheet.

10.2.1. What Is a Spreadsheet?

Spreadsheets are the replacement for an accountant’s ledger book and calculator. These software use columns
and rows to allow math calculation to be performed on data previously entered. Nowadays, spreadsheets do
a lot more as they are often used as (very) simple databases or as a charts and graph application.

Spreadsheets, as trivial as it may seem today, played a really important role to bring office and home computers
to reality. It was the “killer app” that justified buying a computer.

10.2.2. Gnumeric

Since release 1.0, Gnumeric is ready for prime time. It’s an advanced spreadsheet featuring an easy-to-use
graphic interface with all the advanced functionalities of such applications. Gnumeric offers a simple and
easily customizable interface, designed to minimize the learning curve for new users.

10.2.2.1. Getting Started

To start Gnumeric , access Office+Spreadsheets→Gnumeric in the menu.

Figure 10-11. Gnumeric’s Main Window
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10.2.2.2. Moving Around

Gnumeric’s Toolbar

Figure 10-12. Gnumeric’s Toolbar

The toolbars allow for a quick and intuitive access to Gnumeric ’s core functions. By pointing your mouse
on each icon, you get a brief description of its functions.

Gnumeric’s Menus

Figure 10-13. Gnumeric’s Menus

Shortcut keys

You may also use and personalize shortcut keys to match your needs. For example, Ctrl-S will save your
document.

10.2.2.3. Basic Functions

Gnumeric is an enterprise-ready spreadsheet application and includes loads of features way beyond the scope
of this document. The software includes an in-depth help system, and you will easily find more information
on the GNOME web site (http://www.gnome.org/).
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Opening Files

Gnumeric only opens its native format. To open other sources, use Import.

File→Open

Shortcut key: F3.

Creating a new file

By default, when Gnumeric starts, it creates a new spreadsheet to be used. Using File→New will open a
new spreadsheet.

Saving files

Save and Save As both offer exactly the same interface. Save As will allow you to rename an open spread-
sheet.

File→Save

File→Save As

Shortcut key: Ctrl-S.

10.2.2.4. Everyday Functions in Gnumeric

Gnumeric , like other spreadsheets, is primarily designed to allow mathematic operation to be performed as
formulas. Hence, you statically enter values, then define functions in other cells to view or calculate their value.
In Gnumeric , you can easily perform any mathematic formula, from simple additions to complex averages and
ratios.

Within cells, formulas are defined by the = sign. Anything else is treated as static data.

10.2.2.5. Simple Operations

You may perform simple additions, subtractions or any simple operations with the following syntax:

• =5+4

• =5-4

• =C2/C34

• =5XC5

• =(5+4(c3))/2

10.2.2.6. Functions

Functions simplify complex operations such as additions of numerous cells, averages, or absolute numbers.
We strongly encourage you to explore further on the subject. This is what spreadsheets are all about. Here are
a few examples:

• =sum(c2,d23), you may also specify a cell range for your function to operate on. =sum(c2:c23) will add
the value of every cell in between c2 and c23.

• =average(a1:a5)

You may combine both simple operators with functions. Just like
in the following formula: =(c1+c3)/(average(c4:c50))
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10.2.2.7. Formatting Your Work

One interesting aspect of spreadsheets is the ability to modify the format or the appearance of one or more
cells. You can achieve this by accessing the Format→Cells menu which offers the most extensive options such
as data type, border setting, background, etc.

Figure 10-14. Format Cells Menu

10.2.2.8. Advanced Features

Gnumeric offers extensive functionalities for advanced users. You can use it as a simple database, program
complete interface. You can also convert formats, define templates, etc. Gnumeric is light, fast and flexible and
will surely impose itself as the de facto standard for spreadsheet applications on Linux and Unix.

10.2.2.9. Graphs And Charts

Gnumeric recently added a very nice graph and chart tools, call the Graph Guru. It will enable you to create
stunning graphics and charts to impress both customers and partners.

Here are the steps to follow:

1. First, select a range of data.

2. Then click on Insert +Graphs

The Graphs Guru will appear.
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Figure 10-15. The Graphs Guru

3. Afterwards, it’s pretty straight forward. Chose your graph and, if not done, you will be prompted to
specify the data and define references.

In order for Gnumeric ’s graph guru to function, you need to make
sure you have Guppi installed.

10.2.3. StarOffice’s StarCalc

StarOffice has been a great office application on Linux for a few years now. Presently, it remains as one of
the only true features-complete office suite on Linux . StarCalc is part of that suite and offers spreadsheet
functionalities.

We will not detail StarCalc ’s basic functionalities as you simply have to read the previous section on Gnume-

ric . Obviously, you will have to read more documentation to benefit from all the available advanced functio-
nalities of this application.

An important difference between StarCalc and Gnumeric is that
StarCalc supports much more import and export formats. If you
use multiple operating systems, you will really appreciate this. There
is also a Windows version of this application.

10.2.3.1. Opening StarCalc

To launch StarCalc , access the KDE menu→Office→Spreadsheet→StarOffice sub-menu. If you have any problems
launching it, please refer to StarOffice Writer, page 81.

From the default StarOffice screen, access File→New→Spreadsheet.

10.2.4. Conclusion

Spreadsheets are one of the true killer apps of the computer age. They bring great benefits for their users and
are used all over the world, from the corner-store manager who wants to manage schedules, to the biggest
accounting firm who uses it to write extensive and consistent data reports.
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11.1. Konqueror: KDE’s File Manager

11.1.1. Getting Started

To manipulate your personal files, KDE offers Konqueror . To launch it, click on the icon in the toolbar.
You can also find it on the desktop.

Figure 11-1. Konqueror: The File Manager Under KDE

The left side of the window shows your files in a tree structure, while the right side displays the current
folder’s contents (when you launch Konqueror , the default folder is your home directory). Each file or sub-
directory is represented by an icon. You can always set the folder’s full path in the URL line on top of the
window.

Small precision: in this book, we use indifferently the terms folder
and directory. These two terms refer to the same thing, that is a
file holder, even a... folder or directory holder.

In the example mentioned above, you notice the recognized file types have specific icons associated to them.
Hence, Mail and tmp are folders.

Although Konqueror recognizes most file types, it might come across a type which it cannot inter-
pret. In that case, the file is represented with this icon.

11.1.1.1. Folders on The Left of Your Konqueror Window

The folders on the left of your Konqueror window are:

Bookmarks

Here are listed the places you visit the most often, whether it be system folders or Internet sites.

History

Here, you find the system folders and web sites you visit frequently (since Konqueror has “two faces”).

Home Directory

The folder in which you organize your work. Each user possesses one and, normally, only that user can
access it. This folder is designed on the desktop as Queen’s home.

Network

If you are in a local network environment, the files shared by the other computers on the network should
be displayed here.
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Root Folder

This folder is at the base of the tree structure: all other folders are directly or indirectly held by the root
folder. In principle, only the system administrator should manipulate that folder.

Services

This folder gives you access to services on your computer, such as the Audio CD Browser.

11.1.1.2. The Toolbar

Konqueror ’s tool bar offers numerous features which are easy to access. Here they are, along with their asso-
ciated icons.

It moves you to the parent folder. This function places you
one level higher in the tree structure, hence the parent
directory.

Alt+Up

Brings you back to the folder or web site you just visited. Alt+Left

If you used the preceding button, this one does the opposite:
it moves you in the opposite direction.

Alt+Right

Use this icon when you are lost. It brings you directly to your
home directory, the root of all your data, your house.

Ctrl+Home

If you click on this icon, you force Konqueror to reload the
current directory’s contents. This is very useful in a network
environment or if you delete files “outside” of Konqueror ,
that is in a Terminal or in another file manager.

F5

Stop the work Konqueror is currently doing. For example,
exploring a folder which holds numerous (too many) files, or
the very long loading of a web page.

Esc

“Cut”: deletes the selectioned files, but places them in a
temporary memory space called the clipboard.

Ctrl+X

“Copy”: stores the selectioned files into the clipboard. Ctrl+C

“Paste”: extracts the files held by the clipboard and places
them in the current folder.

Ctrl+V
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Obviously enough, this icon allows to print files or web
pages.

Ctrl+P

Use this icon to increase icon or character font sizes. Very
useful if you have a large screen and trouble to read tiny
fonts.

On the contrary, this icon reduces the size of icons and
characters.

Use the icon-type display: press and hold your finger down
on your mouse in order to get other options.

Use the list-type display: press and hold your finger down
on your mouse in order to get other options.

When the wheel turns (on the upper-right part of your
window), Konqueror is working... Hence, you can survey
the software’s activity. If you click on it, another Konqueror
opens up.

Table 11-1. Konqueror’s Icons

11.1.1.3. Moving Around in Your Documents

The tree structure on the left of your window is one way to move around within your documents.
To see the sub-folders contained in a folder, simply click on the + on the left of each folder name.
Hence, you can view your folder’s contents. If you click again, you only get a folder view, without
the contents.

You can also move around in the right side of your window. Simply click on the icons which repre-
sent the documents, like the one shown here.

11.1.1.4. Selecting Files

You only need to click to open a file or change directory. Then, how can you select one or many files? If, for
some reason, files are already selected, click on Konqueror ’s background (where there is nothing) to cancel all
active selections. The Esc key also possesses the same virtues.

To select only one file, click on its icon while pressing the Ctrl key.

You can also select many files with the mouse. Click on the right window’s background then move the mou-
se while pressing and holding its button: a rectangle will be drawn and everything contained in it will be
selectioned, as illustrated below.
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Figure 11-2. Selecting With Your Mouse in Konqueror

Selecting many files which follow each other in the tree structure is done by selecting the first document, then
while holding the Shift key click on the last document you want to select.

Finally, you can select isolated documents by clicking on each one of them while holding the Ctrl key. The
image below shows you the use of Shift on the left and Ctrl’s use on the right.

Figure 11-3. Selecting Many Files in Konqueror

11.1.1.5. Handling Files

Now that we know how to select files, it is time to handle them a bit.

11.1.1.5.1. Creating a File or a Directory

Right-click on the right window’s background (while avoiding the icons): you get a menu which offers many
functions. Choose Create New→Folder.

Figure 11-4. Creating a New Directory

In the displayed dialog box, type the name you want to give to the directory and hit the Enter key (or simply
click OK, which amounts to the same thing).

The Create New menu also allows to create different file types. For example, create a text file by
selecting Text file: like before, give it a name, for example text.txt. Once it is created, your file appears
in the right side of your window and is represented with a pencil on a white sheet.

It is not necessary to give a file extension (the group of letters
which follow the period) to your file. However, it is preferable to do
it systematically since it is a way to identify the file’s type. Here,
by convention, the extension of a text file is .txt.
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11.1.1.5.2. Opening a File

If you click on the icon of the file you just created, Konqueror will recognize its type (a text file) and display
it, that is: nothing. In fact, you simply created an empty file. This time, right-click on the icon and choose Open
with.

Figure 11-5. Opening a Text File

Many applications adapted to modify this file type will then be proposed. Choose Advanced editors, which we
already saw in KDE ’s tool bar, “The Desktop According to KDE”, page 55.

Type a few lines in the displayed window, what you write is not important. Click on the text file icon
to save what you just typed. If you do not do it, the editor will alert you when you try to quit it.

Now go back in the Konqueror window and use this icon (or the F5 key) to refresh the display of
the folder’s contents. Then, bring the mouse pointer on your text file’s icon. You will notice, in the
information bar at the bottom of the window, that its size is not equal to zero anymore.

Click on your file. This time, the window is not empty. It holds what you just typed. To go back to
the file list, simply click on Konqueror ’s Back button.

11.1.1.5.3. Renaming a File

Renaming a file is very simple. Right-click on the icon and choose the Rename item of the pop-up menu. Then,
type the new name and validate with the Enter key.

You can also select it and then press on the F2 key.

Finally, the last possibility is to right-click on the file and to select Properties. You just need to change the file
name in the appropriate field, at the top of the window.

11.1.1.5.4. Copying, Moving or Linking Files

Figure 11-6. Choosing The Destination Folder

Select the files or folders you wish to copy or move. Then, use the F7 (for copy) or F8 (to move) keys: a little
window will appear, in which you can type the destination folder. The Choose button allows to choose the
folder.
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Here is another method. Start by using the tree view on the left of the screen in order to see the destination
folder. However, do not display its contents, just its name. Then, select the files or folders you wish to mani-
pulate.

Figure 11-7. Drag’n’Drop With Konqueror

Now move your pointer on one of the selected elements. Then, while leaving your finger pressed on the
mouse button, drag your selection towards the destination folder, which should be visible on the left part
of your window. The preceding image showed two files which are dragged towards the home directory’s
tmp directory.

When the mouse pointer is on the destination folder, the latter is highlighted. Release the button and once the
pop-up menu appears, choose the operation you wish to do.

Copy a file duplicates the contents in another file. Move copies
the file and then deletes the original. Link a file creates in the
destination folder an access point towards a file, which resembles a
shortcut. If you delete the link, this does not imply that you delete
the original file as well.

Finally, you can also use the clipboard. To copy selected files, use Ctrl+C to place them in the clipboard. Then,
place your mouse pointer in the destination folder and launch the copy process with Ctrl+V. To move files,
use Ctrl+X instead of Ctrl+C.

11.1.1.5.5. Deleting a File

Sooner or later, you will want to remove files, either to gain disk space or simply to clean up your working
environment. Simply select the files or directories you wish to delete, then right-click on one of them.

Figure 11-8. Three Methods to Remove Files

You can delete files and directories in three different ways: the secure, the classical and the real method. The
secure method is named Move to trash: the files are not really removed. They are simply moved in the trash
can. Hence, you can recuperate them, until you empty the trash can... The trash can’s icon is on the desktop:

Figure 11-9. The Trash Icon, Empty or Full

Click on it to see the files it holds. A new Konqueror window will open. You can then retrieve files you placed
in it. To do so, click on them and move them where ever you wish (whether on the desktop or in another
Konqueror window). You can always recuperate stuff you placed in the trash can, until you empty it...
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To remove a file like it is generally done under UNIX , you must right-click on your file and choose Delete. You
will have to confirm you really want to delete this file. If you answer yes, its name will be deleted and the
space it took on your hard disk will be freed. However, it is still possible to recuperate part of the file, if you
ask an expert.

Last method, you can Shred your file. This means Konqueror will compress the disk space it took with random
data, in order to make sure the content will not be reconstructed. The file is then completely deleted and there
is no way of retrieving it.

To do so, select the file you wish to shred by clicking just below the file’s icon and by dragging your pointer
upwards until your file is highlighted, hence selected. Then, access the Edit menu, then Shred.

11.1.1.5.6. Finding Files

Konqueror offers a powerful tool to search for files according to different criteria. In the Tools menu, select Find
file. The following block appears on top of the right side of the window:

Figure 11-10. Finding Files With Konqueror

You can use generic characters such as ? and * in the Search field. For example, to find all the files with .txt ex-
tensions, type *.txt. To find all files starting with the letter C, type C*.

Keep in mind that Linux distinguishes uppercases from lowercases.
For example, in a directory, you could have a Mail.txt file and
a mail.txt file: they are two different files. You will not find the
latter if you look for C*.

The other tabs allow to pinpoint a search. For example, you can take into account the last modification date,
the file type, the presence of a certain text inside a file... Click on Find when you have chosen your criteria.

The result of the search is displayed in the lower part of the right side window. All common actions are
possible: opening a file, copying or deleting it, etc. Click on Close to go back to the normal display.

11.1.1.6. Modifying The Display

Konqueror ’s principal display options are grouped in the View menu.
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Figure 11-11. Konqueror’s Window Menu

11.1.1.6.1. Display Type

This controls the way files are represented. you will find the same choices from the corresponding icons on
Konqueror ’s tool bar.

The default type is Icons: large icons, the file name under each icon, the ensemble ordered from left to
right and from top to bottom.

In the MultiColumn View type, the file names appear on the right of the icons. The latter are organized
in columns from left to right and from top to bottom.

Figure 11-12. MultiColumn View Under Konqueror

The Tree View mode gives the same aspect to both sides of the window. However, the files are shown
with many details about them.

Figure 11-13. Tree View Under Konqueror

The Detailed List View displays the same details as the preceding mode, but does not use the tree view.

98



Chapter 11. File Managers

Figure 11-14. Detailed List View Under Konqueror

Finally, the most stoical type is the Text one. It displays information rapidly and exhaustively, but
without the icons and other decorations.

Figure 11-15. Text View Under Konqueror

11.1.1.6.2. Using index.html

If you browse frequently through files containing HTML, for example your distribution’s documentation,
these files generally hold a file called index.html. It is a very common name which gives you access to many
files.

Let’s take /usr/share/doc/mandrake/en/ as an example. If you do not activate the Use index.html, you will
only get a list of files and directories contained in that folder. If you activate the option, Konqueror displays
the contents of the index.html file, and you can easily browse through the documentation, as if you were on
the web.

To activate it, access the View→Use index.html

11.1.1.6.3. Sort

The usual file display order is alphabetical, with the directories shown first. You can choose to ignore or not the
case, that is the difference between upper- and lowercase letters. If you ignore it, you will get a dictionary-like
order. If you do not, then the uppercase letters will be displayed before. For example, a file starting with the
letter Z will be displayed before one which starts with the letter a.

If you use the list-display mode, you can click on the column’s titles to define on which file characte-
ristic to sort (for example, the size) as well as the sort’s order (for example, descending order). This is
what the header shows here: the arrow’s presence, on the right of the title, indicates that the element

is taken into account in the sort action, and its upward direction signifies ascending order. Click again on the
title to change direction or sorting order.

11.1.1.6.4. Contents Preview

Instead of file representation through icons, Konqueror can display a miniature preview of certain file types
(if you use one of the two large-icon display types). The Preview sub-menu allows to select the file types you
want to display in tiny aspect. Here is an example of preview displays:
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Figure 11-16. Preview of a File’s Contents With Konqueror

This option is as esthetic as it is practical. However, it requires more power from your machine.

11.1.1.6.5. Hidden Files

Select this option. Suddenly, numerous files will be displayed! They are hidden files which are not normally
displayed.

Figure 11-17. Viewing Hidden Files With Konqueror

Naturally, you can act upon those files like on any other. However, beware. Generally speaking, they are used
to back up your personal parameters and configurations.

11.1.1.6.6. Splitting Windows

Right-click on the bar at the bottom of the right-side window, the one which holds a big green button. You
obtain this menu:

Figure 11-18. Acting Upon Displays With Konqueror

In this menu, choose Split View Top/Bottom. The window is split into two, each one possessing its own infor-
mation bar, each one is independent. Only one window can be active at a time: click on the information bar to
activate the one you wish to interact with. To close a window, right-click on the information bar and choose
Remove View.
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Figure 11-19. Splitting The Konqueror Window

It can be interesting to link many windows into one group, in order for them to display the same
folder. For example, it is the case for both the left and right tree structures. However, the window
we created earlier is linked to no other window. To link it, click on the check box on the right of the

information bar. You will see a little chain inside the check box. This links it to the other windows, and when
those other windows change their displays, the new linked window will also follow that display.

Window splitting is also very practical to copy and move files from a folder to another: you can visualize the
contents of many folders at a time, and move many files from a window to another.

11.1.1.7. File Sharing

If file sharing is activated in the Mandrake Control Center (please see Allow Users to Share Directories, page
196) you can right-click on folders in your Konqueror window (or Nautilus see Sharing Files, page 107) and
choose the PropertiesShare tab. It allows to share one or as many folders as you like through NFS 1 or Samba 2

Then, you can browse the contents of those shared folders by typing lan://localhost/.

11.2. Nautilus: GNOME’s File Manager

11.2.1. Getting Started

GNOME ’s default file manager is Nautilus . With it, you can manage your files, browse the web
and even your LAN through Samba and NFS. It was originally developed by Eazel but the latter
unfortunately ceased its operations. However, since it is an open-source project, many developers
still maintain and enhance it.

Since Nautilus ’ main features function in a similar manner to
those of Konqueror , we will only describe functionalities specific
to Nautilus . Please refer to Konqueror: KDE’s File Manager , page
91 if you need more information.

1. NFS (Network File System) allows to share, export/import files from/to your computer in a networked environment.
Although the NFS setup is easier than the Samba one, it can only be used within a UNIX system based (like GNU/Linux ).
Moreover, NFS is an insecure protocol and should be used exclusively in a secure local environement.
2. Samba is a protocol by which PCs share resources such as files, and printers. Windows , GNU/Linux and OS/2 operating
systems, among others, support the Samba protocol. It can be considered an alternative to Netware and NFS .
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Figure 11-20. Nautilus’ Main Window

11.2.1.1. Exploring the Left Side of Nautilus

The left part of the window gives you a few options. In fact, you can have a single folder showing you where
you are in your tree structure. It includes basic information such as the file type, the number of items it holds
and the last access date.

The other options are located in the sidebar (which is the left side of the window):

• standard tree structure. You can access it through the Tree tab.

• notes. It allows you to write notes directly in the yellow window. Click on the Notes tab to try it out.

• history. This option allows to see a history of the folders visited. Hence, by clicking on the History tab, you
will get something like this:

Figure 11-21. Nautilus’ History Window

• news. With this function, you can add news web sites such as Linux Today (http://linuxtoday.com) and
access them directly through hyperlinks.

In our example, we added Linux Today (http://linuxtoday.com) and Linux Weekly News (http://lwn.
net). After this operation is over, you get a resume of these sites in your sidebar:
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Figure 11-22. Nautilus News

To add news sites, simply click on the Select Sites tab. You will get a list of popular Linux news sites. Simply
click on the check box or site name to add them to the news you wish to view. When you are finished, click
on the Done button.

Figure 11-23. Adding News Web Sites

If the news site you wish to add is not in the site list, you may add it by choosing Edit and this window will
appear:

Figure 11-24. Editing News Web Sites

• help. If you need more information about Nautilus or GNOME , click on the Help tab where you will find
useful information. This Help tab replaces the GNOME Help Browser (the question-marked applet on your
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panel) which use to hold all of GNOME ’s help center. It is not fully maintained anymore and should disappear
when GNOME 2.0 is ready for prime-time.

11.2.1.2. Exploring the Right Side of Nautilus

Most file managers use the right-part of the window to display files contained in directories, and Nautilus is
no exception to that. And like many file managers, you can change the look’n’feel of your window. To do so,
we will go through Nautilus ’ Preferences menu.

11.2.1.3. Nautilus’ Preferences

To access the Edit Preferences menu, you can use the Alt-P-E keyboard shortcut or simply click on the Preferences
menu and then on Edit Preferences. This window will then be displayed:

Figure 11-25. Nautilus Preferences

When you opened the Preferences menu, you probably noticed there
were three preference levels: Beginner, Intermediate and Advanced.
We suggest you set it to Intermediate as this is the one we will
document. The Beginner level includes less options while it’s the
opposite for the Advanced one.

11.2.1.3.1. View Preferences

As you can see, the main preferences are located in the View Preferences window. Here you can change basic
graphic looks such as your preferred font and its size, as well as the view mode (either icon or list view).

11.2.1.3.2. Appearance
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Next is the Appearance window. You can define your Default smooth font: this will affect the left window’s tabs
such as History, Help, News, etc.

Figure 11-26. Changing Default Smooth Fonts

This example shows Nautilus ’ sidebar with the DerDmonschriftkegel font.

Changing Nautilus ’ theme can be fun, although the difference between each theme is, to say the least, quite
subtle. Try them out. You can also Add New Themes.

Here is an example of the GNOME theme:

Figure 11-27. GNOME Theme For Nautilus
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11.2.1.3.3. Windows & Desktops

This is the window to tweak if you do not want Nautilus to draw your desktop. However, if you do not select
the Use Nautilus to draw the desktop, you will lose all your desktop icons!

By default, if you click on an icon (or on text, depending on the view you choose) in the left or right side of
Nautilus , the file’s contents will be displayed in the same window. In the Windows & Desktops window, you
can modify this by clicking on Open each file or folder in a separate window. The same principle applies to the
other options offered in this window.

11.2.1.3.4. Icon & List View

The features in this window are very useful. Here you can activate items with a single click (instead of the
default double-click), show hidden files (the ones that start with a period). You can view those in a Terminal

using ls -a) and backup files (the ones which end with a tilde). You can also list folders before files.

11.2.1.3.5. Icon Captions

This window has only one function. Here you determine in what order information about files is shown. You
find the typical size, date modified, type, etc.

11.2.1.3.6. Sidebar Panels

Here you define which tabs you want to see in your sidebar. Click or unclick on the different options to see
them appear or disappear. You may also choose to see only folders in your tree structure.

11.2.1.3.7. Search

Define your search options in this window. You can either choose to search by file name only or by file name and
file properties. You can select your default search engine (Google (http://www.google.com) by default).

11.2.1.3.8. Navigation

The Navigation window is where you determine your home page (/home/your_account by default). You can
also set your proxy settings, if you use one. Finally, you can disregard bookmarks created by Nautilus by
clicking on the Don’t include the built-in bookmarks in the Bookmarks menu.

11.2.1.3.9. Speed Tradeoffs

Here are located options concerning information displayed about icons. You can set Nautilus to show text in
icons, to list the number of items in a folder, to display thumbnails for image or sound files, etc.

11.2.1.3.10. News Panel

Two options are offered here:

• maximum items per site;

• update minutes.

The first one allows you to set the number of news which will be displayed in the sidebar’s news tab (default
is six news). The second one lets you set the update frequency (default is five minutes).
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11.2.1.4. Browsing The Web

Like Konqueror , Nautilus also acts as a web browser. Simply type a web address in the Location Bar and off
you go!

Figure 11-28. Browsing The Web With Nautilus

In order to view only the web page you typed, go in View→Hide Sidebar

11.2.1.4.1. Searching The Web

Simply click on the Web Search button located in the toolbar and your defined web search engine’s page will
automatically open. You can also access this feature by pressing on the Shift-Ctrl-F keys.

11.2.1.4.2. Sharing Files

By enabling file sharing in Mandrake Control Center (please see Importing Remote SMB Directories, page 194),
you can give access to your folders via Samba or NFS (see File Sharing, page 101. To do so, right-click on folders
in your Nautilus window (or Konqueror for that matter) and choose the Network Sharing menu. Then, simply
check the Shared entry and then on Configure File Sharing. A pop-up window will ask you for the root pass-
word in order to access diskdrake (one of Mandrake Control Center ’s components). Then, select between
No Sharing, Authorize all users or Personalize.

If, for any reason, you should have problems browsing your LAN with Nautilus , know that you can also do
so with Konqueror (please refer to File Sharing, page 101).
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12.1. Graphic Art And Image Manipulation

Linux offers a vast range of applications for graphic design and image manipulation. True to its Internet
origins, Linux is a really interesting option for web designers. With power-user tools such as Screem and
GIMP , especially combined with Linux’s server capabilities, any Internet application can become a reality.

Therefore, this chapter will mainly concentrate on GIMP , and introduce other interesting applications you may
want to discover on your own.

12.1.1. GIMP

What is GIMP

The GNU Image Manipulation Program (GIMP ) is a free software program challenging proprietary appli-
cations such as Adobe Photoshop or Corel PhotoPaint . In many aspects, GIMP is a flagship application
of the Free Software movement, not only because of the amazing technical excellence it demonstrates, but
also because of the astonishing creativity it exposes.

GIMP allows advanced photo editing tasks such as cropping, resizing, painting, drawing, modifying co-
lors, etc. Its true beauty lies in its extensibility and its scripting options, which open GIMP to a full in-
tegration in programs and scripts. This enables GIMP to perform as a mass production image rendering
application.

GIMP runs on most Unix-compatible systems, it relies on a large group of volunteer developers and it is
therefore in constant evolution. You are invited to contribute, test the latest releases, write plug-ins and
scripts. GIMP is a live example of what free software does best, join in and have fun!

Strengths

For normal users, GIMP will seduce through its advance functions for web images and formats. Easily
create animations and optimize your art for web publishing. You will also greatly enjoy GIMP ’s extensive
photo manipulation features.

Power users, publishers and document management specialists will truly benefit from GIMP through its
advanced scripting capabilities and API’s.

Weaknesses

GIMP , like most graphic design Free Software applications, suffers from the fact that pre-press standards,
such as the Pantone process, are proprietary, and closed. GIMP being open-sourced, there is no usable
implementation of these standards. Also, this world is dominated by Apple-compatible computers and
you will therefore have to put in the extra effort to print professionally with GIMP , but it is possible.

Where to find more information

GIMP includes extensive documentation available through the help menus. It offers two searching inter-
faces, through content and index.

type: F1

On the net, GIMP is a very well documented application and a lot of information is freely available. We
particularly recommend GIMP Manual written by Karin Kylander and Olaf S along with Grokking The
GIMP. Both books are available on The GIMP web site (http://www.gimp.org/docs.html). This link will
also guide you towards a series of more specific resources such as FAQ and Tutorials.

12.1.1.1. Getting Started

Concepts

GIMP embraces differences. Therefore, there are usually many ways to achieve the same goal.
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Menu

From GIMP ’s main window (called the ToolBox), you can access the basic program options such as opening
a file, creating a new file, etc.

Right-clicks

Once an image is opened or created, you can right-click in the image window and access the image’s
specific options such as: Open, Close, Save, Save as, Dialogs, etc.

Shortcut keys

There is a default set of shortcut keys you may use to accomplish the most common tasks, such as saving
files, accessing brush dialogs, etc. Note that you can easily customize that set according to your most
common use of GIMP . Also, they are always available, as long as a GIMP window has keyboard focus.

Layers, image modes and file formats

One of the key concepts to grasp in order to truly benefit from such an application is the one about layers,
formats and file modes. Roughly put, numeric image editing added a 4th dimension to art: layers. Images
are built vertically (so are animations) and each layer has user-defined properties which determines other
tasks that can be accomplished. File mode defines the inner logic of the graphic elements. Hence, an RGB
image doesn’t allow for the same operations and capabilities as, gray scale image, i.e. color. Finally, the
file format also impacts on which operations can be done on that file, especially for saving.

All that to illustrate that if you face difficulties accomplishing any task described below, check these 3
elements before running to conclusions.

12.1.1.2. Starting GIMP

From the console

To start GIMP from the console, type gimp &. You can also start GIMP and open a file. Type gimp file-
name.ext &.

From the program menu

GIMP is accessible from the

GNOME Menu→Program→Graphics→The GIMP

KDE Menu→Graphics→The GIMP

When you open GIMP , unlike Photoshop on Windows , only the basic ToolBox appears. It offers GIMP ’s core
functions and allows you to initiate anything forward.

Figure 12-1. GIMP’s Toolbox
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12.1.1.3. Basic Operations

Here are a few basic operations:

Opening a file

Figure 12-2. Opening from the ToolBox

Shortcut: Ctrl-O

File→Open

Your image will appear in a new window. From that window, you may access context-sensitive menus
available from the right mouse button. We will oversee these options a bit further.

GIMP supports many file formats. Depending on the file format you want to open, you may have to answer
questions pertaining to the details of that format and conversion information.

Creating a new file

Shortcut: Ctrl-N

File→New..

Then appears a new window dialog which enables you to determine width and height in pixels, but also
its real physical dimensions in inches or centimeters. You may also specify the file’s type. Once you click
OK, the image window appears and you may edit it as you would any other bitmap image, mainly using
the ToolBox.
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Figure 12-3. Creating a New File

Saving Files

Shortcut: Ctrl-S

File→Save

File→Save As

The first time you save or save as...

Figure 12-4. Saving Files

this interface pops up and allows you to set the name and location of your image. More importantly, it is
the place to define the file type such as JPEG or PNG in the case of web publishing.
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Recurrent Save And Auto-Save

If you hit Ctrl-S once the name, location and file type are known, you won’t be prompted with the previ-
ous window. To change file types, simply Save as.

Often, new users, at the stage of saving their work, run into multiple
problems such as losing layers or simply damaging their work. Most
of these problems come from the specific options allowed for each
file format. First, check if the format you specified supports the
image mode defined. Second, if you used layers, check if the file
format supports them. If you have no clue, save in XCF, GIMP ’s
own file format. You can always try multiple Save as later.

12.1.1.4. Basic Image Manipulation

The ToolBox

The ToolBox contains your basic graphic design tools. If you move your mouse over any item, its name
will appear in a yellow window. Each of them possesses its own set of options, accessible by double-
clicking the icon. We won’t detail each tool in this guide as it would be to long. Experiment with each
tool. Remember that layers may affect tools behavior. For example, the rectangular select tool won’t allow
to delete part of the background layer.

If you close the ToolBox, you close GIMP and all windows. But if
you close any other window, it will only effect that window.

Image window

Figure 12-5. GIMP Picture

This window manages either new or opened images. This is where you can right-click to view image-
specific menus. This is also where tools selected in the ToolBox may be used.
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View Size

At the very top of the window, you see a numeric value in percentage. This is the zoom ratio. You can
increase it or decrease it by right-clicking and accessing the View menu, or:

• to increase, press +;

• to decrease, press -.

You can also launch a window navigator which allows to pan and resize a window. You can do this with
Ctrl-Shift-N, or by right-clicking and accessing the View→Nav. Window... sub-menu.

Undo And Redo

Also very important, you can undo and redo all your operations. You can specify the number of available
undos. Note that it has a large impact on RAM and too many undos may make a large image impossible
to manipulate.

Right-click+Edit→Undo

Right-click+Edit→Redo

or:

Ctrl-Z = undo

Ctrl-R = redo

Cut And Paste

GIMP allows you to cut (Ctrl-X) and paste (Ctrl-V) within any window, as well as between any GIMP

window.

You can also paste as layers.

12.1.1.5. Layers, Channels And Path

Layers are one of the true innovations of computer-generated graphic design. It brings a fourth dimension
and a vertical concept to the work. GIMP allows for an unlimited number of layers. Each layer has a specific
set of properties.

To access the layers dialog:

Right-click+Layers→Layers, Channels & Path...

Figure 12-6. Layers Dialog

You may also access the layers’ menu by right-clicking on the layer.
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12.1.1.6. Filters

Filters are a set of programmed actions which modify your image according to some specified options. GIMP
offers a vast range of filters such as blurs, noise effects or image enhancement operations. Filters may be
applied to selections and layers.

The filters’ menu is accessible through:

Right-clicking→Filters

Figure 12-7. Filter’s Dialog

12.1.1.7. Dialogs

Dialogs basically give any tool further options. There are quite a large number of them and for the purpose of
this introduction, we will only discuss the Color Selection and Brushes dialogs.

Color Selection

Figure 12-8. Color Selection Dialog

115



Chapter 12. Graphics Tools And Practical Devices

It allows to determine the background and foreground colors that appears at the bottom of the ToolBox.
You may specify any color according to the possibility of the image type you defined. Rule of thumb,
always work in RGB, so you can always save as later.

To access the Color Selection dialog, double-click on the square which holds a black and a white rectangle
at the bottom left of the ToolBox.

Brushes

This dialog determines the type and size of the brushes (which applies to the Pencil and Fuzzy brush tools).

Right-click→Dialogs→Brushes

Figure 12-9. Brushes Dialog

12.1.1.8. Printing

GIMP is ideal for web development but printing from GIMP is sometimes tricky. Because of the absence of
CMYK and Pantone Process images, GIMP is not ideal for pre-press work.

GIMP internally supports many printers and it’s always feasible to filter images through GhostScript or print
to file (PostScript). Therefore, you can print images relatively easily. Remember to adjust your resolution to
match your printer’s capabilities.

There is quite a lot of online documentation to further your knowledge about printing with GIMP . In this book,
it is simply impossible to address this issue.

12.1.1.9. Advanced Features

It is way beyond this user guide to detail GIMP ’s advanced features. Here is an avant-goût of the possibilities.

Scripting

GIMP offers several scripting interfaces for power users. These may automate almost any GIMP operation
and allow external programs to talk to GIMP . You may use some script more or less like filters by:

right-clicking and accessing the Script-Fu menu.

Script-Fu is the first GIMP scripting language, but there are also other APIs such as GIMP-Perl , to use perl
scripts within GIMP .
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Plugins

Plugins are external applications which extend a program’s core functionalities. GIMP , like Photoshop ,
relies on a vast range of plugins to push its boundaries. You may also contribute plugins to the community
as most of them are free to use and distribute.

Xtns→Plugin Details to view all installed plugins.

12.1.1.10. Conclusion

Hopefully, this brief introduction caught your interest for this amazing application. GIMP is now a first-class
application and should be considered by any Linux web developer as the definite choice for web designs.

12.1.2. Vector Graphic Applications

Both the GNOME environment and the KDE project are now offering promising vector graphic applications. Dia
is now mature and, if properly used, a very useful application.

12.1.2.1. Diagrams

If you need to pull out system diagrams, flowcharts, and UML documentation, Linux has one great option,
Dia , and a promising option in the KDE office project.

Dia

Dia is a very interesting vector-based diagram application and it can be considered as an alternative to
Microsoft Visio . It contains a set of predefined symbols according to one of the 19 basic diagram you
may use. Dia is particularly interesting for document management since its native format is XML-based,
compressed by default, and therefore very light and flexible.

Dia offers many common look-and-feel features, like GIMP . Right-clicking in the image will give you
image-specific menus, and allow you to modify the image to your needs.

From the console, type: dia &.

Kivio

Very much like Visio , but at a very early stage. Well integrated in the KOffice suite, it really shows great
potential, but Dia remains much more complete and ready to use, primarily because of the quantity of
symbols available.

To open Kivio , access either the GNOME or KDE menu, then the Office→Graphs→Kivio sub-menu.

12.1.2.2. Vector Design

Kontour , a vector-based drawing program, is part of the KOffice suite. It’s a nice application and it shows
many promises, but it is no where near professional commercial products of this category. It’s great for begin-
ners, amateurs and kids.

To start Kontour , access either the GNOME or KDE menu, then the Multimedia→Graphics→Kontour sub-menu.

12.2. Digital Photo Cameras

We will speak about using a digital photo camera with GTKam under Mandrake Linux.
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12.2.1. Getting Started

So, you have a digital photo camera and you are wondering how to make it work under Mandrake Linux.
That is what this section is for. For the rest of this section it is assumed that you have a USB camera1. We will
also speak about webcams in Webcams And Video Conferencing, page 142.

Start GTKam and select Camera→Select Camera. Connect your camera to your computer, turn it on and click on
Detect. Your camera should be detected. If it is not, please select your camera from the Model: pull-down list
and the port it is connected to in Port:, as shown in figure 12-10. That’s all the configuration needed.

Figure 12-10. Configuring The Camera Connection

12.2.2. Manipulating And Transferring Pictures to The Computer

GTKam shows you how many pictures the camera holds by the name of the camera. To show thumbnails of the
pictures the camera holds, just double-click on the camera icon. Digital cameras name the pictures in different
ways (IMG_XXXX, PIC_XXXX, etc.). If your camera supports it, you can change those names by right-clicking on
the thumbnail and selecting Info. Then, type the new name in the Name: field and click on Ok.

You can transfer a single picture to your computer by right-clicking on the thumbnail and selecting Save. You
can also select all the pictures you want to transfer to your computer by clicking on them. The ones selected
will be highlighted as shown in figure 12-11. To de-select pictures, just click again on them. You can select all
pictures with Select→All and you can invert your selection with Select→Inverse.

When you are done selecting pictures, press the Save button (or Ctrl-S). A dialog pops up asking you whether
you want to save photos or thumbnails; it also inquires about the pictures’ file names. Do not change the
options (leave the default values) and press the Ok button. The pictures are then transferred to your computer
and saved in your home directory.

Figure 12-11. Selecting Pictures to Transfer

1. There are serial digital cameras, but they are outside the scope of this section since all new ones use USB.
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Now, you only need to rotate and/or edit some of them if needed/wanted under GIMP or your favorite ima-
ging software. Enjoy taking pictures with your digital photo camera... and GNU/Linux !

12.2.3. Using The GIMP Plug-In

GPhoto2 (the library used by GTKam ) has a GIMP plug-in which allows to open pictures directly in GIMP . You
need to install the package gtkam-gimp-plugin to be able to use it.

Run GIMP and select File+Acquire→Load from Camera.... The first time you do it, you will need to select your
camera as explained at the beginning of this section. Then, press Ok and double-click on your camera to get a
list of the pictures it contains as shown in figure 12-12.

Figure 12-12. Plug-In For GIMP

As previously stated, select the picture you want to work with and press on Ok to open it in GIMP .

If you want to open more than one picture, just select them by clicking on them in the list.

12.3. Scanners: ScannerDrake, Sane and XSane

This section will speak about ScannerDrake (scanner wizard), SANE and XSane (scanner interface software).
It will also give, at the end of the section, a list of other scanner interface software under Linux .

12.3.1. Getting Started

12.3.1.1. Introduction

Using scanners under Mandrake Linux has never been easier. If your scanner is supported by SANE , it’s only
a matter of installing the required RPMs, have your scanner identified and configured, and launch the image-
acquisition application.
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Since the configuration step could prove difficult in some cases, especially with very ancient or very recent
hardware, Mandrake Linux includes a brand new tool, ScannerDrake , which is part of the DrakX package.
Thanks to ScannerDrake , you will be able to install your scanner in less than a minute.

Before launching ScannerDrake , however, all of the SANE packages must be correctly installed on your Man-
drake Linux machine (see The SANE software, page 120).

Not that all scanners are supported under Linux: before buying
new hardware, it’s always a good idea to pay a visit to Man-
drakesoft’s Hardware Database (http://www.linux-mandrake.
com/en/hardware.php3) and to the Linux Hardware Database
(http://www.linhardware.com/) web sites, as well as to the SA-
NE home page (http://www.mostang.com/sane/), to check for
compatibility issues.

12.3.1.2. The SANE software

SANE , which stands for “Scanner Access Now Easy”, is an interface to scanners and other image-acquisition
devices like digital cameras and framebuffers. SANE sits in the middle between the device and the acquisi-
tion/image processing software, in order to allow developers to write application software without worrying
about device drivers.

The SANE software consists of three packages: the SANE library (libsane1), the SANE back-ends
(sane-backends, the modules for the scanner devices) and the SANE front-ends (sane-frontends, basic
programs for scanning images). Please refer to the “Package Management”, page 215 section if you are not yet
comfortable with package management.

Before trying to configure and use your scanner, you have to install all of these packages, unless you already
did so during the installation process. At this stage, it doesn’t matter if your scanner is turned on: SANE will
install gladly even if there’s no physical device connected to the computer (yet).

12.3.1.3. ScannerDrake

ScannerDrake is the Mandrake Linux scanner detection and configuration tool. At the moment of writing the
present manual, ScannerDrake only supported USB and some SCSI scanners, but support for the majority of
SCSI and parallel port scanners is under active development.

Before launching ScannerDrake , all relevant software packages have to be correctly installed, the USB inter-
face must be working properly, the scanner itself must be connected to your computer and the power turned
on. Refer to the manufacturer’s manual to know how to install and test your hardware.

When everything is ready, open a terminal and, as root, type scannerdrake. The program will detect the
manufacturer and model of your scanner, and ask you if you want to configure it. Answer Yes, and voilà, you
are ready to use the programs that come with sane-frontends, XSane or other acquisition software. If you are a
GNOME or KDE user, moreover, you will find a very convenient XSane icon on your desktop through “dynamic
icons” (provided that you installed the xsane package).

Figure 12-13. ScannerDrake Is Ready to Configure Your Scanner

To test that everything works correctly, launch xscanimage from a shell and try to acquire a picture with your
scanner. You can first acquire a preview of the scanned image clicking on the Preview window button, as shown
in figure 12-14.
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Figure 12-14. xscanimage, a Basic But Effective Acquisition Program

Note that xscanimage can also be invoked directly from GIMP , selecting the Xtns Acquire ImageDevice dia-
log... menu item, or choosing directly the [name of your scanner]:/dev/usb/scanner0 sub-menu, where [na-
me_of_your_scanner] will be the manufacturer name of your scanner, e.g. epson, mustek, hp, etc.

12.3.1.4. XSane

While xscanimage is more than enough for your basic scanning needs, more experienced and/or graphic-
oriented users will be glad to know that Mandrake Linux includes a more sophisticated program, XSane ,
which offers more options and a more informative display as regards the image acquisition process.

When you double click on the XSane icon on the desktop, or launch it typing xsane from a terminal window,
you will see several windows pop up on the screen, as shown in figure 12-15.
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Figure 12-15. XSane Multiple Windows And ScannerDrake Icon on Desktop

Moreover, if you install a supplementary package, xsane-gimp, you will have a GIMP plug-in at your disposal.
This will allow you to import your images directly in the GIMP for image retouching tasks (see the Graphic
Art And Image Manipulation, page 109 section). To do this, simply choose the File Acquire XSane: device window...
menu item to launch XSane . When you will go ahead and scan the image, it will be sent directly to GIMP , and
you will be able to edit and retouch it.

12.3.2. Advanced Configuration

12.3.2.1. Fine-Tuning The Resolution

Most modern scanners can boast a high resolution, typically 600 DPI (Dot Per Inch) or even more, which can
increase to higher values through interpolation. But it would be a mistake to perform all of your scanning at
the maximum available resolution. It could happen that there is very little, if any, quality difference between
a 300 and a 600 DPI image scan, but the file size will grow exponentially at higher values, up to many MBs of
disk space for a single image file.

The resolution value should be chosen according to the device on which the image will be reproduced. For
images that will be shown on computer monitors, e.g. web site images, the resolution will have to be as close
as possible as the monitor’s one, about 80 DPI (for a 1024x768 display, could be less for 800x600); higher values
will result not only in “heavier” images, but the dimensions will also increase, so that an image scanned at 160
DPI instead of 80 will be about twice as large2.

If you intend to print your images, a resolution of 150-200 DPI should be enough for many home printers;
increase this value if you have a very high quality ink jet printer or a dye-sublimation one. Keep in mind that
the value commonly used in printed magazines is 300 DPI.

Higher values should be chosen only for specific uses, such as enlarged images on very high quality printers,
or scans of black and white originals. You will have to experiment a little, until you are satisfied with the
results.

2. This, however, is a quick way to enlarge images taken from small originals. You could also scan at a higher resolution
and then save it at half size, using a graphic manipulation software like GIMP , to improve image quality if you are not
satisfied with the result obtained at 80-90 DPI.
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12.3.2.2. OCR Software

Unfortunately, OCR (Optical Character Recognition) software is not as common or sophisticated as the image
acquisition counterpart. There is at least one package, however, that is mature enough to be used: Clara OCR

(http://www.claraocr.org/). The graphic interface is very simple and doesn’t require a specific desktop
environment, such as GNOME or KDE , but it will be necessary to train the program on the scan of a sample page.
The training process can be quite tedious, and not very intuitive for the newbie3, so be sure to read the tutorial
file. More experienced users should also refer to the Advanced User’s Manual.

At least another project, GOCR/JOCR (http://jocr.sourceforge.net/), has reached an usable status. You
can download it from its web page and try it, but bear in mind that it’s still beta software (latest release at the
moment of writing was 0.3.5) that requires supplementary packages (please refer to its home page for more
information). Perhaps the best way to use gocr is as a Kooka plug-in (see the Other Scanner Interface Software,
page 123 section).

12.3.3. Other Scanner Interface Software

Here is a list of other scanner interface software which is known to work under Linux:

• if you installed KDE, you will be able to use Kooka , a simple graphical front-end to SANE which is also able
to perform OCR tasks using gocr as a plug-in;

• users of the FLTK (“Fast Light Tool Kit”) graphic user interface can try FlScan (http://digilander.iol.
it/fbradasc/FLSCAN_1_0_0.html), a FLTK front-end for SANE;

• for EPSON scanners, you can download Image Scan! for Linux (http://www.epkowa.co.jp/english/
linux_e/linux.html), a scanner utility provided free of charge to Linux users by EPSON KOWA Corpora-
tion. It aims at achieving the same level of user friendliness and image quality as the Windows/Macintosh
software bundled with the Epson scanners;

• while multi-functional HP devices are configured using printerdrake , owners of these devices should
have a look at the HP OfficeJet Linux driver project (http://hpoj.sourceforge.net/).

12.4. Printing Under Mandrake Linux

This section will deal with using printers under Mandrake Linux with KPrinter .

There are two ways to print documents with KPrinter : from applications, calling KPrinter as the “print
command”, or from the command line. Any application which supports the definition of its printing command
will be able to use KPrinter .

12.4.1. KPrinter’s Dialog Description

With KPrinter , you can set many options for printing your documents, like the output device (generally a
physical, local or remote printer), the number of copies, paper size, printer resolution, etc. It runs under every
window manager and desktop environment, not only KDE .

3. To quote the authors: “Clara OCR is not simple to use. A basic knowledge about how it works is required for using it”.
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Figure 12-16. KPrinter Window

KPrinter ’s window is divided in three areas: Printer (selection of the device and its properties), Page Selection
(selection of which pages to print) and Copies (how many copies and in which order).

12.4.1.1. The Printer Section

In this section, you set the device where you are going to print into and its properties, like page size, resolution,
etc. In the Name: pull-down list, all the available printers are listed. Just select the one you want to print to.

Press the Properties... button to change the device’s options. Please note that the options available will be
dependent of the chosen device.

Figure 12-17. Printer Properties Window

Most options available are self-explanatory. Maybe one worth mentioning is Pages per sheet (set to 2 in the
example). This lets you put up to 4 pages onto a single sheet of paper (or 8 if you print on both sides). This is
a nice feature to print book drafts or other lengthy material which change often.
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Figure 12-18. Changing Printer Resolution

If you want to change printer-specific options such as the resolution of the printing device, you have to click
on the Advanced tab. There, you will find the Resolution: option under some of the available categories. When
you click on it, all available resolutions will be displayed in the bottom part of the window. Select the one you
want from the list.

Among the many other settings available under the Advanced tab are printing modes which use much less
toner or ink (search for something like “economy mode” or “toner density”). However, the output is much
paler.

Once you are satisfied with your settings, press the Ok button. The Save button saves the current settings for
the next printing jobs.

12.4.1.2. The Page Selection Section

Under Page Selection, the following options are available:

All

Prints all of the document’s pages.

Current

Prints only the document’s current page. This option might not be available at all times.

Range

Allows you to specify page ranges to print. You can specify pages or groups of pages separated by com-
mas (1,2,5 prints pages 1, 2 and 5; 1-3, 7-21 prints pages 1 to 3 and 7 to 21, etc.).

The Page set: pull-down list lets you specify pre-defined sets of pages to print (All pages, Odd pages or Even
pages).

This allows you to print double-sided on a printer without a duplex unit: print the odd pages, turn the stack
of printed pages over and put them back into the input tray, then print the even pages.
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12.4.1.3. The Copies Section

Use the little arrows to increase/decrease the number of copies or just type the number of copies you want to
print in the Copies: field.

When you are printing multiple copies, you can check the Collate check box to print the whole document before
starting to print the second copy, instead of getting all copies of page number 1, then all copies of page number
2, and so on.

The Reverse check box makes the printing start at the last page and end at the first one (the document is printed
“backwards”). This option is useful if your printer leaves the paper sheets face-up in the output tray.

12.4.2. Using KPrinter

We will explain how to setup Galeon to use KPrinter .

For example, when you invoke Galeon ’s printing dialog (pressing Ctrl+P or with File→Print), all you have to
do is to type kprinter in the Printer field, as shown in figure 12-19, and click on the Print button.

Figure 12-19. Telling Galeon to Print With KPrinter

The procedure for other applications is similar to the one described above, so play around a little bit to find
out how to tell your application which printing command to use.

From the command line, its invocation is simple: kprinter file_to_print &.

You need to be under X for the above command to work.

Enjoy printing with your Mandrake Linux system and KPrinter !

12.5. CD Burning

We will introduce one of the many CD burning tools you can use under Mandrake Linux, X-CD-Roast .
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12.5.1. Getting Started

Under Mandrake Linux you can burn CDs using either a SCSI or an ATAPI CD-R(W) drive. It is assumed that
DrakX already configured your CD-R(W) drive properly, we won’t speak about configuring a CD-R(W) drive
under Linux but how to put your CD-R(W) drive to use.

All CD recording software treat CD-R(W) drives as SCSI, but the ATAPI drives make use of a feature called
“SCSI emulation” which is automatically configured during system installation.

You need to configure different parameters in X-CD-Roast . As always, all configuration tasks must be done as
root. So, become root, start X-CD-Roast and press the Setup button. Your CD-R(W) drive will automatically
be detected as shown in figure 12-20.

Figure 12-20. CD-R(W) Drive Detection Under X-CD-Roast

In the CD Settings tab, select the CD Writer Speed and the Audio Read Speed (used for digital audio extraction or
“ripping”) according to your CD-R(W) drive, as shown in figure 12-21.

Figure 12-21. Setting CD Reader And Writer Parameters

Next, you need to set up a temporary directory for CD images. Click on the HD Settings tab and type a directory
name in the Path: field (or click on Browse, and select the desired directory) and click on Add, as shown in figure
12-22.

To store a normal CD image, you need at least 650-700 MB avai-
lable space in this folder. You can check the amount of available
space by pressing the Update button, after you have added paths.
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Figure 12-22. Setting up Temp Space on Disk

Next, you need to tell X-CD-Roast which users will be able to burn CDs by clicking on the Users tab. Leaving
the settings in their defaults will allow all users from all hosts to burn CDs but not change any parameters of
the software as shown in figure 12-23.

Figure 12-23. Setting up Users Allowed to use the CD Burner

Once you are satisfied with the settings, click on the Save configuration button, Ok and then on the Exit button.
Now, X-CD-Roast is configured and “almost” ready to be used.

To finish the configuration, every user allowed to use the CD burning software must make a little additional
configuration step. When such a user runs X-CD-Roast for the first time, he has to hit the Setup button and
accept (or further customize) the settings, and save them. X-CD-Roast is now ready to burn CDs!

12.5.2. Burning CDs

12.5.2.1. Burning From an ISO Image

Let’s assume you downloaded a CD-ROM ISO image from the Internet and you want to burn it on a CD. The
ISO image is in the /tmp directory (the one configured in the 3rd configuration step of X-CD-Roast ).

Press the Create CD button, then press the Write Tracks button. In the Layout tracks tab select the ISO image you
want to burn to a CD and then click on the Add button. Once you click on the Accept track layout button to
confirm the CD layout, you will get something similar to what is shown in figure 12-24.
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Figure 12-24. Selecting The ISO Image to Write to CD

You can change Write parameters or just accept the defaults and then click on the Write tracks button to burn
your CD.

12.5.2.2. Burning a Set of Files or Directories

If you want to build your own CD, or to back up some files to a CD, you also need to press the Create CD
button in the main menu, but this time you will need to press on Master Tracks in order to be able to select
the set of files or directories to include on the CD. In the Master source tab, you can select files/directories to
include in the CD.

By default only directories are shown. Removing the mark from the Display directories only check box will let
you select individual files as well. Select the directory/file you want to include and press on the Add button to
add it to the CD. See figure 12-25.

You can also exclude files or sub-directories, part of an already
selected directory, by selecting them and then pressing the Exclude
button.

Figure 12-25. Selecting Files/Directories to Include on The CD

Once you are satisfied with the set of files/directories to include, in the Create session/Image tab, press on the
Calculate size button to calculate the extents of the CD. Then you have two choices: writing an ISO image of the
CD (handy if you want to make multiple copies or want to burn the CD later), pressing on the Master to image
file button; or Master and write on-the-fly if you do not want to make an ISO image and burn the CD right away.

If you chose to make an ISO image first, then you need to proceed as explained in Burning From an ISO Image,
page 128 in order to burn the CD. If you chose to master and write on-the-fly, just put a blank CD-R(W) and
voilà!
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12.5.3. Going Further

12.5.3.1. Burning Audio CDs

CD recording is not limited to data CDs, you can also record audio CDs. By audio CDs, we mean CDs that you
can play in your car stereo or home equipment, not data CDs with OGG, MP3 (or other digital audio format)
files on them.

Please note that data/audio CD copying is forbidden by copyright
law. The examples provided here are informational only and are not
intended to make a CD pirate out of you; it is assumed that if you
want to duplicate copyrighted material, it is because you have the
right to do so.

To record an audio CD, you first need to have your audio tracks digitized in the wave format (*.wav)4. Once
you have the audio tracks in the directory defined in the 3rd configuration step, all you need to do is to proceed
as described in Burning From an ISO Image, page 128 to write them to CD.

12.5.3.2. Erasing CD-RW media

If your drive is a CD-RW (re-writable) one and you use CD-RW media, you might want to format your CD-RW
media in order to re-write it with different things. To do so, press the Create CD button, then the Write Tracks
button, put a CD-RW medium in the drive, and press the Blank CD-RW button. This GUI doesn’t support
multi-session writing yet. Also, it supports blanking of new disks only. You will have to use the command line
to blank previously written CD-RW.

Here is an example of the command to use as root: cdrecord -force -v blank=all dev=0,0. Be patient, it
can take up to 90 minutes to do a full blanking.

12.5.3.3. Final Notes

As you can see, CD recording under Mandrake Linux is well supported with GUI programs. This section was
a kind of mini-HOWTO of CD recording for the most common tasks you might want to do. However, CD
recording uses are not limited to things described here. Please refer to the program’s documentation in order
to make the most out of your CD recording experience.

4. At the moment of this writing, OGG and MP3 compressed audio support was in the works for X-CD-Roast .
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13.1. Introduction

If you can not live without your MP3 and video files, this chapter is for you! We will explore the wonderful
world of multimedia, especially XMMS , Aumix and Kscd on the audio side; list the best movie applications in
the next one; while the last section will be dedicated to webcams and video conferencing. Of course, all these
tools are available within your Mandrake Linux distribution.

13.1.1. Using XMMS

First off, XMMS stands for X Multimedia System. With it, you can play a variety of audio sources, such as regular
music CDs and MP3s. Let us start with the basics.

We assume that you have used a CD-ROM player before so we will
not describe the play, rewind, etc. keys.

To launch XMMS , go in your KDE or GNOME menu and choose Multimedia→Sound→XMMS. You can also create a
desktop link as previously described. For command-line aficionados, simply type xmms &.

Figure 13-1. XMMS Main Window

The upper part of the window is called the title bar and holds three buttons on the right part of it:

• the first one is to minimize the window;

• the middle one will only show the title bar, along with an oscilloscope and the elapsed time;

• the last one ends the XMMS session.

Below, you can see the elapsed song time (clicking on it shows the remaining time of the song) and under it,
the “Spectrum analyzer” (clicking on it displays one of two spectrum analyzers or disables it); on its right is
the name of the audio track playing which also holds its total time; just under is the bit rate in kbps (kilobits
per second) – 96 kbps in our example – and the sample rate in kHz (kilohertz) – 44 kHz in our example.

On the left of the spectrum analyzer are 5 letters: you might not see them at first, they are in very dark gray.
Here are those letters and what they represent:

• O: pops up the options menu;

• A: means the XMMS window will always be on top;

• I: pops up a file-info box;

• D: doubles the size of the XMMS window;

• V: pops up a visualization menu.

Now let’s look at the different sliders. The one lying beneath the kbps info is the volume slider; to its right is
the balance one. The longest slider is used to browse through your file (rewind and forward functions inside
one track).
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13.1.1.1. Equalizer And Playlist

Figure 13-2. XMMS Main Window With Equalizer And Playlist

The latter figure shows XMMS ’s equalizer and playlist. To access them, simply click on the EQ and PL buttons
on the right-side of the main window.

13.1.1.1.1. Configuring The Equalizer

The equalizer window acts exactly like the one you probably have on your stereo. If you wish to change the
settings, click on the ON button. You can then change the bass and treble levels to your liking. You can also
choose the AUTO button, which loads one of several default values you can change (click on the PRESETS→
Load buttons to personalize them).

While accessing the above-mentioned menus (PRESETS→Load),
you can load from a WinAMP EQF file as well.

13.1.1.1.2. Using The Playlist

The playlist is where are shown the tracks you wish to listen to. It holds 5 buttons which can help you set up
your playlist:

FILE +

Clicking on it once pops up a window from which you can select your songs. For example, if you wish to
listen to a CD, select /dev/cdrom.

If you want to be able to listen to an audio CD, you will need to
install the xmms-cdread package from the contribs CD.

Clicking and holding the mouse pointer on the FILE + button will pop up 2 other buttons: DIR + and
URL +. Release the mouse button on DIR + and choose the appropriate directory where your music is
filed (such as /home/queen/MP3/, for example); clicking on URL + lets you enter a specific web address.

FILE -

If you want to delete a file from the playlist, select it with your mouse, than click on FILE - (you can
also use the Delete key). Clicking and holding the mouse pops up a three-item sub-menu which holds
CROP -, ALL - and MISC -. The first one deletes all files from the playlist except the one(s) highlighted; the
second one deletes all files in the playlist. Leave your mouse pointer on the MISC - sub-menu and another
sub-menu will pop up. You can now Remove dead files or Physically delete files.

SEL ALL

Clicking on that button will select all the files in your play list. If you click and hold, you will have to other
choices: SEL ZERO and INV SEL. The first one selects no files while the latter inverts the file selection.
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MISC OPT.

Clicking and holding this button gives you a pull-up menu which shows FILE INFO and SORT LIST. The
first one pops up a file-information window where you can edit the title, name of the artist, etc. The
second one gives sorting and randomizing options.

LOAD LIST

Clicking once on this button will pop a window from which you can choose the list you wish to listen to.
Clicking and holding this button displays a pull-up menu containing two choices: SAVE LIST and NEW
LIST. The first one saves the files in your playlist as a list of audio track (in the .m3u format), while the
latter simply clears up the list.

13.1.1.2. Playing Audio Tracks

To play audio tracks, simply follow the instructions given in Using The Playlist, page 132. Then, just hit the
Play button. You can also press on the Eject button: a pop-up menu will appear from which you can load files
into your playlist. Right-clicking on the Play button pops up the same menu. Select the desired files with your
mouse and then, click either on Add selected files or Add all files in directory. When this is done, click on Close.

Figure 13-3. Loading Files Into XMMS

You can also access your files by right-clicking in the Playlist. This handy menu includes all the Playlist’s menus.

13.1.1.3. Using The Options Menu

Now that we are done talking about the basics, let’s explore the Options menu. To access it, you may click on
the O on the left of the spectrum analyzer (see above). This menu will pop up:
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Figure 13-4. Options Menu

These functions are pretty self-explanatory, so we will let you use and discover them by yourself. Let us now
speak into more details about the Preferences sub-menu located on top of the Options menu.

13.1.1.3.1. XMMS Preferences

Setting your preferences correctly is of utmost importance if you want to be able to listen to your audio tracks.
To access it, either put your mouse pointer on the Preferences entry in the Options menu or simply type Ctrl+P.
The first tab, Audio I/O Plugins, holds the input and output plugins necessary to make XMMS function correctly.
Make sure the plugins you need (i.e. CD Audio Player to listen to an audio CD) are enabled and configured.
If you see (disabled) next to a plugin, audio tracks using that plugin will not work.

Figure 13-5. XMMS Preferences Window

Also, make sure you select the right Output Plugin. If you use KDE , there is a good chance you should use the
aRts Driver 0.4, especially if you selected Start aRts soundserver on KDE startup in the KDE Control Center:
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Figure 13-6. aRts Soundserver With KDE

If you use GNOME , chances are you will need to use either the eSound Output Plugin or the OSS Driver.

The Effect/General Plugins tab holds a set of effect plugins which range from voice removal to echoing. General
plugins can allow you to control XMMS with your stereo, tv or VCR remote control.

Next is the Visualization Plugins tab. You can select one or more plugins while listening to your music.

Figure 13-7. G-Force Visualization Plugin

The Options tab is where you can fully personalize the way XMMS displays information, as well as some general
features such as the number of seconds XMMS should (or shouldn’t) pause between songs.

The Font and Title tabs allow respectively to choose specific fonts and the information to be displayed in
regards with the audio track playing.

13.1.1.4. Skins

Now let’s discuss the aesthetics part of XMMS . Like other players, it’s possible to change XMMS ’s skin, that is
its window design. To do so, access the Preferences menu and then select Skin Browser. You can also simply
combine the Alt+S keys to pop it up.
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Figure 13-8. XMMS Skins Browser

As you can see, the Skin Browser selects no skin by default. Simply click on one of the skins and you will get a
real-time look at what the skin looks like. Try chaos_XMMS for instance.

Figure 13-9. Chaos Skin

If you wish to add skins to your Skin Browser, you can do so by visiting sites such as the XMMS site (http:
//www.xmms.org/skins.html), the Skinz site (http://www.skinz.org/) and the Customize site (http://www.
customize.org/).

When you have found the skin you like, download it in the .xmms/Skins directory. Then select it in the Skins
Browser and XMMS will be “wearing” that new skin.

13.1.1.4.1. Other Types of Skins

If you already use another type of audio player, you might be wondering if you can import skins from other
applications. The answer is yes... at least for WinAMP skins (in the .wsz format).

Here’s an example of a skin found on the WinAMP site (http://www.winamp.com/) which you can add to your
Skins Browser:

Figure 13-10. Using WinAMP Skins With XMMS

Simply download the file in your skins directory and XMMS will be able to display it.
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13.1.1.5. Streaming

With the wide popularity of streaming radio, XMMS now supports this type of media. Hence, you can listen
to your favorite radio sites, whether it be from Shoutcast (http://www.shoutcast.com/), Icecast (http://yp.
icecast.org/index.html) or plain radio sites such as Cool FM (http://www.coolfm.ca/).

When you have found a channel you like, simply save it to your hard disk. Shift+Click on the link to save it
to your hard disk. Then, insert it in your playlist.

Figure 13-11. Listening to a Streaming Channel

13.1.2. Using Aumix

Aumix is a very small application which allows to control your sound card’s mixer. It is user-friendly and does
not contain many features, but it will be of great help in order for you to listen to sound files.

In fact, it may happen that you are unable to listen to sound files when launching them from XMMS or any CD
Player. Tuning the sound mixer will usually solve that problem.

To launch it, access either your KDE or GNOME menu and select Multimedia→Sound→Aumix. If you prefer using
the command line, type aumix &. You can also pass options to it. For more info, please refer to its man page
under aumix(1).

Figure 13-12. Aumix Application

Now, let’s explore the File menu.
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13.1.2.1. File Menu

In the File menu, you can access basic functions which either allow you to load or save mixer settings. The
available menu items are:

Load

This menu allows you to load the default mixer configuration contained in the .aumixrc file.

Save

Enables to save new settings to the .aumixrc file.

Load From

Allows to load a different file than .aumixrc.

Save To

Enables to save new settings to a different file than .aumixrc. For example, you might want to save
different settings for work, entertainment, raising or lowering the CD volume according to the place
where you use your computer, etc.

Quit

Quits the application.

when you launch Aumix , it loads by default the last configuration
file you used. Hence, if you used .aumixrc2 – a file which you
created – the last time you opened Aumix , this file will be used.
However, if you click on the Load sub-menu, it will automatically
load the .aumixrc file.

13.1.2.2. View And Mute Menus

The View and Mute menus are pretty self-explanatory. The first one allows to choose which components will be
shown in the Aumix window. Hence, if you never use a microphone, you may choose not to view that entry.
You can do so by clicking on the check-box next to Mic in the View pull-down menu. The Mute menu allows
one feature: to completely mute the sound.

Figure 13-13. Aumix View Menu
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13.1.3. Kscd CD Player

Although you can play CDs with XMMS , we will briefly describe one of the available CD players under Man-
drake Linux, that is Kscd . It stands for The KDE Project’s small/simple CD player.

Figure 13-14. Kscd’s Main Window

You can access this application through your KDE menu, then choose Multimedia→Sound→CD Player. From the
command line, simply type kscd &.

If you use GNOME , you can access a very similar CD player called
gtcd or Gnome CD Player . Choose Multimedia→Sound→Gnome
CD Playerto open it or type gtcd & on the command line. However,
if you issue kscd & from GNOME , you will still be able to access
Kscd .

The buttons on the right are typical CD player ones, such as Play, Stop, Rewind, etc.: we will not describe those.

The ones on the left, however, are more “obscure”.

Figure 13-15. The Left Side of Kscd’s Main Window

The rectangle labelled Compact Disc Digital Audio permits to switch between available play modes. Click on it
and you will be able to display the elapsed and remaining time of a specific song, as well as those of the whole
album.

Right below is a box which holds an i. Clicking on it pops up a pull-up menu which holds three subjects:
Information, Purchases and Performances. Select one of them and a web browser will open the appropriate link.

On its right is the eject button. And below it is the quit button. You know what those do. Then comes the
trickier part.

If you put your mouse pointer on the next button, it will display freedb Dialog. Click on it. The CD Database
Editor will appear.
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Figure 13-16. CD Database Editor

If you wish to change the title of a song, you can do so in the Edit Track Title field. As for the Edit Play Sequence
field, it allows to give Kscd a predetermined playing order. Simply enter the track numbers separated by
commas.

The button marked by a ? acts as the shuffle button.

The next button, showing a hammer and a screwdriver, opens up Kscd ’s configuration menu.

Figure 13-17. Configuration Menu

In the freedb tab, click the check box next to Enable Remote freedb. By enabling this feature, you will have access
to the Compact Disc Database hosted on the freedb server (freedb.freedb.org cddbp 888 - is the default
value in the freedb server field). Hence, if the album you are playing is in the database, the name of the group,
album and songs will be displayed.

In the SMTP setup tab, you can Enable submission via SMTP to the freedb servers. If your album is not included in
their database that is. Simply type in your SMTP address and the port (25 by default) and enter a valid e-mail
address.
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Figure 13-18. Kscd Options

The Kscd Options tab allows you to personalize Kscd ’s basic options. You may choose the foreground and
background colors. The CD-ROM Device field is the most important one, since it tells Kscd where to find the
audio source: this should be set to /dev/cdrom. The WWW Browser let’s you choose the browser you wish to
open when you access information links (through the i box); Konqueror is the default browser.

The right part of the window holds miscellaneous but useful features which are pretty self-explanatory:

Show Tool Tips

Shows information about a button when the mouse pointer is over it.

Enable KPanel Docking

This icon is displayed on the right side of the panel called the “Kicker panel”.

Play on Tray Close

Plays the first song on the CD when the tray is closed.

Stop Playing on Exit

CD playback stops when you close the application.

Eject on Finish

Ejects the audio CD when all the songs have been played.

Random is Shuffle

Songs are played only once when in random mode, they do not loop.

Help

Launches the KDE HelpCenter in the Kscd section.
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13.2. Movie Applications

This section will discuss movie players available with Mandrake Linux. It will introduce the subject (i.e:
codecs problem1) and suggest resources to get it going.

13.2.1. Introduction

Video players exist under GNU/Linux , but they are still quite limited as to what they may accomplish. The
main problem is that most popular video codecs are proprietary and to implement them in a free software
application (mainly due to the cost of licensing), the codecs have to be reverse-engineered. Which is very
complex and not always legal.

For example, you will have lots of trouble playing Quicktime files or DVDs. Actually, it’s not so complicated,
but you will have to download the plugins from the Internet to complete your installation.

In some countries, the status of the DVD playback and reverse-
engineered codecs is still under review. That is why MandrakeSoft
does not include all the plugins to those codecs. The information
included in this section is meant to help Mandrake Linux users
who know that, in their country, using these is legal. MandrakeSoft
does not encourage law violations and you should verify with
local authorities before you download these codecs and plugins.

13.2.2. Applications

Xine

This is one of the most interesting video application for GNU/Linux . It supports a wide range of formats
and offers interesting customization of the GUI (skins). It’s fast, flexible and extensible. Version 0.9 is quite
stable and you can extend it to support all popular formats.

XMovie

This software is tailored to playback high resolution movies such as MPEG1 , MPEG2 and AVI files. It is
really not made to playback compressed files such as Quicktime , but supports MPEG2 streams.

MPlayer

Another quite interesting application, MPlayer has the advantages of supporting multiple output drivers,
even old video cards. Like the previous applications described above, it supports DVD, AVI , VideoCD .
Unfortunately, you will also probably have to download and install winDLLs and proprietary codecs to
make it work properly.

Finally, there are other video applications for GNU/Linux such as vlc , Ogle and RealPlayer (which is a
proprietary software). We encourage you to discover them as they might answer your specific needs.

13.3. Webcams And Video Conferencing

13.3.1. Getting Started

You heard it everywhere, but you don’t have a clue how to do it with your new Mandrake Linux system:
video-conferencing. Well, here we will show you how to do video (and audio) conferencing using your web-
cam and GnomeMeeting . We will speak about USB webcams since the parallel models are really old and do
not have the image quality of USB devices.

1. coder/decoder
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Before buying your new webcam, it would be a good idea to see
if it’s supported under GNU/Linux . Refer to Linux USB (http:
//www.linux-usb.org/devices.html) and to the excellent Li-
nux USB device overview (http://www.qbik.ch/usb/devices/
devices.php) web sites for more information on USB webcams.

You need the hotplug package installed on your system in order to
enjoy automatic USB devices detection under Mandrake Linux.

The hardware setup is very easy. Just plug your webcam in an empty USB slot and it will be automatically
recognized and configured. You should see GnomeMeeting ’s icon appear on your desktop with a legend like
GnomeMeeting /dev/v4l/video0 underneath it; if not, you can run it from Networking+Other→Gnomemeeting.
Also, remember to connect your microphone and speakers in their proper place in your sound card.

Run GnomeMeeting and select the Edit→Preferences menu (or press Ctrl+S) to open the preferences dialog.
Under the General category you can set things like your name and e-mail address, GnomeMeeting ’s GUI pre-
ferences, directory settings and audio and video devices settings. Under the Codec category you can ena-
ble/disable/prioritize the different audio codecs available and change the audio and video codec settings.
Make sure you check the Video Transmission option in Video Codecs Settings to be able to transmit video to the
remote party.

If you want to use GnomeMeeting to do video conferencing with NetMeetingTM users, you need to set up the
ILS options in Directory Settings; make sure you check the Register option.

Figure 13-19. GnomeMeeting’s Main Window

On the leftside of the main window you have the toolbar with six buttons. The first three are:

Opens/closes the ILS window to find and connect with friends registered on ILS.
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Opens/closes the text chat window on the rightside of GnomeMeeting ’s main window
so you can chat with the remote party. Just type the text you want in the Send Message
field and press Enter.

Opens/closes the control panel at the bottom of GnomeMeeting ’s main window where
you can see the history log and also adjust the audio and video controls.

Table 13-1. GnomeMeeting’s toolbar buttons

In the control panel’s audio tab you can use the sliders to set the speaker and microphone levels as shown in
figure 13-20.

Figure 13-20. Setting Audio Levels For GnomeMeeting

In the control panel’s video tab you can adjust the following video parameters (from top to bottom):

• Brightness level. The higher the value, the brighter the image will be.

• The level of white. This tells the video device which signal level should be considered “white”.

• The color level. This adjusts the amount of color the image from your camera will display. It might have no
effect with certain cameras/light conditions.

• The contrast level. With the lighting conditions of an office the contrast is normally set to zero.

Figure 13-21. Setting Video Levels For GnomeMeeting

Example video settings are shown in figure 13-21. Please note that usually, these settings are automatically
configured when GnomeMeeting starts up according to light conditions of the environment and your webcam.
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13.3.2. Connecting With Another User

Figure 13-22. Video Conferencing With a Remote Party

To connect directly (end-to-end, no servers) to another user, you need to input the remote user’s host or IP
address in the pull-down list at the top of GnomeMeeting ’s main window and click on the button on its right
(the one with the plug). If the connection can be established and the remote party accepts your call, right-click
on the video window and select Remote to see only the remote party or Both, that is yourself and the remote
party, as shown in figure 13-22.

13.3.3. Connecting With ILS (NetMeetingTM) Users

You can use GnomeMeeting to connect to an ILS server and do video conferencing with people using Net-

MeetingTM or other compatible software. Click on the directory toolbar buton (the little book, remember?) to
get the ILS directory window. Then, click on Refresh to update the list of available users connected to that ILS
server, as shown in figure 13-23.

Figure 13-23. Finding People on ILS Servers
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Now, right-click on the person you want to call and select Call This User to initiate the call. You can change ILS
servers in the ILS directory pull-down list. If you connect to more than one ILS server, multiple tabs will appear
in the ILS window. Just click on them to change servers.
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14.1. Introduction to The Internet

This section is an introduction to the Internet section.

14.1.1. Using The Internet With Mandrake Linux

Using the Internet with Mandrake Linux is very easy. And since it includes many mail clients and web brow-
sers, you can choose which one really suits your needs.

However, for the purpose of this book, we will speak about KMail as a mail client, while we choose to describe
the Galeon web browser. Keep in mind that most mail clients and web browsers function in a very similar
manner. The information in the following sections should apply to most mail clients and web browsers.

The Internet does not limit itself to sending e-mails and browsing web sites. We will also present an instant
messaging software called Gaim , as well as an IRC (Internet Relay Chat) client named XChat .

14.2. Internet Browsers: Galeon

This section will speak about the Galeon web browser. It will also give, at the end of the section, a list of other
web browsers you can use under Mandrake Linux.

14.2.1. What Is Galeon?

Many web browsers are available under Mandrake Linux. For the purpose of this book, we chose to docu-
ment Galeon since it’s arguably the fastest browser on the planet! It manages standard technologies such as
JavaScriptTM, JavaTM and Flash, and its interface is lean and beautiful. It is based on Gecko , which is Mozilla ’s
rendering engine. In case you are wondering, Mozilla is the open-source version of Netscape . To use Galeon ,
then, you need GNOME and Mozilla .

14.2.2. Getting Started

To launch Galeon , access your GNOME menu (or KDE menu, if you use that environment). Then, choose the
Networking→WWW→Galeon sub-menu. A wizard will pop up and ask you several questions. The first ones
concern the migration of bookmarks and preferences from other browsers, namely Netscape and Mozilla . If
you did not use those browsers before, simply forget about it and click Don’t import bookmarks and move on to
the next step. If you did, choose Netscape or Mozilla according to what you already used.

Then, the wizard will ask you if you want to create a Smart Bookmarks Toolbar. This includes a very useful
toolbar holding specific search engines such as Google . Choose the ones you want and click the Next button.

If, after all, you don’t like that toolbar, you can always hide it by clic-
king on the Bookmarks→Smart Bookmarks Toolbar→Folder actions→
Show as toolbar menu. (You can also type Ctrl-B, then right-click
on Smart Bookmarks Toolbar and uncheck the Show as toolbar item.)

The next step concerns GNOME Integration. This allows you to configure Galeon as the default browser when
you click on an URL inside a GNOME application. Choose the protocols you wish Galeon to handle.

Then comes the Configure Internet Configuration window which allows you to enter the appropriate settings if
you use a proxy behind a firewall. If you don’t, just click the Next button. And that’s it. This is what you should
get once the configuration is over.
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Figure 14-1. The Galeon Browser

Nice isn’t it?

14.2.3. Exploring The Menus

Now, let’s explore Galeon ’s Menubar starting with the File menu.

File

This menu holds the most basic operation such as opening a new browser window or tab, opening pages
or URLs directly from your hard disk, and printing. One interesting option is Save session as... which
enables to to save the current session to a file. A dialog box will appear with which you can save your
session to the /home/username/.galeon/sessions/ path. To open a saved session, simply choose the
File→Open session menu and the same dialog box will pop up.

Edit

Includes 4 basic options: Cut, Copy, Paste and Find.

View

Allows to enable or disable the different toolbars. You can also select a different stylesheet than the one
loaded by the viewed page with the Stylesheet sub-menu. Other options include Zoom and language en-
coding.

Tab

Permits to integrate all your Galeon windows into one. For example, open a new window by accessing
File→New window (or simply Ctrl-N). Then, click on Tab→Move to another window→> Mandrake Linux <. This
will merge the two windows into one and tabs will appear below the Bookmarks toolbars.

Figure 14-2. Tabbed Windows Under Galeon

Clicking on the X will close the tab and the window associated to it.
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Settings

Includes technology-related options such as enabling/disabling of JavaScript and Java, Proxy settings
and image-specific options. This is also where you set your Galeon preferences.

Figure 14-3. Galeon Preferences

Browsing→General

Enables to set your home, startup and new pages. Save session option also available.

Browsing→Bookmarks

Allows to set your general, Autobookmarks and Smart Bookmarks options.

Browsing→History

Enables the setting of your history (in days). The completion option is very useful since you only
have to type the first letters of an URL and then the Tab key to complete it if you visited the said URL
recently.

User Interface→Tabs

Allows to set the Tabbed Browsing, Tab Names and Tab Colors you prefer. For example, you can set
Galeon to open every web site in a different tab.

User Interface→Windows

Permits to set what you see in the title bar, to choose which menus should be displayed in full-screen
mode, as well as the default windows layout.

User Interface→Toolbars

Allows to choose the toolbar’s appearance (Text only, Text beside icons, Text under icons and Icons only),
to add functions to your toolbar, to change your toolbar theme as well as the spinner (the little GNOME
foot at the extreme-right of the toolbar).

User Interface→Mouse

Enables you to modify the Context Menus, Mouse Buttons and Mouse Wheel options.

Handlers→Downloading

Permits to select the wanted Downloader and FTP handlers, as well as destination folders.

Handlers→Programs

Allows to choose the external program to view sources, with what program should the Help files
be displayed, as well as the default Mailer. Since we documented KMail (see Internet Mail: KMail,
page 150, we suggest you set this parameter to kmail --composer %t. Note that the default mailer
is Evolution , a suite of groupware applications resembling Microsoft Outlook . Although it has
made giant steps towards stability and ease-of-use, it is still resource-intensive on slow/old systems.
We still suggest you try it out because it’s a great, well-integrated application.
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Figure 14-4. Mailer Preferences

Handlers→MIME Types

Enables to set the program you want to associate to file types. For example, you could set the audio-
x-mp3 MIME (Multipurpose Internet Mail Extensions) type to XMMS by editing the default value.

Rendering→Fonts/Colors

Permits to define your preferred fonts.

Rendering→Languages

Allows to set your preferred languages.

Advanced→Networks

Enables to define the HTTP protocol and proxy options.

Advanced→Filtering

Permits the enabling/disabling of Java, JavaScript and image loading.

Advanced→Persistent Data

Allows to set the parameters for cookie handling, password recognition and cache.

Bookmarks

Allows to manage your bookmarks, Autobookmarks and Smart Bookmarks. This is where you will find
the bookmarks editor (Bookmarks→Edit bookmarks or simply Alt-B).

Go

A substitute to the toolbar. You can also access the last-visited sites from that menu.

Tools

Enables to change parameters concerning cookies, images, passwords and history. Also allows to open
the Java console (not functional), the JavaScript console as well as the first time wizard.

Help

Finally, the Help menu is a direct access to the Galeon manual and home page.

14.2.4. Other Web Browsers

Here is a list of other web browsers which work well under Mandrake Linux:

• Konqueror (a file manager which can be used as a web browser);

• Lynx (text-mode only);

• Mozilla ;

• Nautlius (a file manager which can be used as a web browser);

• Netscape Communicator ;

• StarOffice (the StarOffice suite has a built-in URL toolbar which can be considered as a web browser).
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14.3. Internet Mail: KMail

There are many GUI mail clients for Linux : KMail , Evolution , Netscape Messenger , etc. This section will
speak about configuring and using KMail to compose/read/organize your e-mail messages.

14.3.1. Configuring KMail

When KMail is run for the first time, a window pops up stating that the directory holding mail does not exist
and it will be created. Press OK to create it. Only the minimum configuration steps will be explained, please
feel free to explore the various configuration options.

Clicking on Settings→Configure KMail will bring the configuration window. It is organized as a list of categories
(on the left) and the configuration options for each of those categories (on the right). Under Identity, type your
name and e-mail address as shown in figure 14-5.

Figure 14-5. Setting User Parameters

To configure the mail servers, select the Network category. In the Sending Mail tab, check the SMTP option and
fill the SMTP server name or IP address of the outgoing mail server as shown in figure 14-6.
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Figure 14-6. Setting The Outgoing Mail Server

To receive mail, you need to create at least one mail account. At the moment of this writing, KMail supports
the following types of mail accounts:

• POP3 (Post Office Protocol V3);

• IMAP (Internet Mail Access Protocol);

• Local Mailbox (mail is not retrieved from the Internet, but from some local directory).

Most mail servers use the POP3 protocol: that is the one shown here. If you want to set an IMAP account, the
configuration will differ slightly.

To add a mail account, click on Add... and select POP3. Your ISP should have provided you with an e-mail user
name and password which you need to fill into the Login: and Password: fields. In the Host: field, enter the POP3
server name or IP address and check the Store POP password in configuration file option as shown in figure 14-7.
If you want KMail to handle more than one mail account repeat the above procedure for each of them.
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Figure 14-7. Configuring a POP3 Mail Account

Once you are satisfied with your settings, click on OK to accept those settings. KMail is ready to read/send
mail on the Internet.

14.3.2. Using KMail

Press on this button (or Ctrl-N) to compose a new message. You will need to fill the
To: and Subject: fields in the message-compose window.

Press on this button (or Ctrl-L) to check for new e-mail messages on all defined
e-mail accounts.

Select the message you want to reply to and press this button (or R) to reply to the
author of the message.

Select the message you want to reply and press this button (or A) to reply to all the
original recipients of that message.
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Select the message you want to forward (send to a third party) and press this button
(or F). You will need to fill the To: field in the message-compose window.

Select the messages you want to delete and press this button (or D) to move them to
the trash folder. If you want to delete messages permanently, open the trash folder,
select the message(s) and press D again. Please note that deletion from the trash
folder cannot be undone!

Table 14-1. KMail’s Tool-Bar Buttons

Figure 14-8. The Message-Compose Window

Click on the blank part of the window and type your message. If you want to attach a file to your e-mail
message (a picture, for example), press the clip button (or select Attach→Attach from the menu) and a standard
file dialog will pop up. Select the file(s) you want to attach and click on OK.

Click on this button to send the message immediately (you need to be connected to
the Internet). A copy of the message will be kept in the sent-messages folder.

Click on this button to queue the message in order to send it later. The message will
be saved in the outbox folder and will be sent the next time you request mail to be
sent.

Table 14-2. Message Send Button

14.3.3. Folders and Filters

You can sort mail in different folders according to specified criteria (sender, subject, date, etc.) using filters in
order to organize incoming e-mail. Filters are very powerful. However, we will speak about simple filter rules.
Feel free to explore the filters tool ( Settings→Configure Filters ).

Let’s assume you want to filter incoming messages according to the sender and you have at least one message
from that sender in your inbox folder. You want all incoming e-mail from someuser@somecompany.net to go
directly into the SomeUser folder. First, you need to create a new folder to store the messages.
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To create a new folder select Folder→Create from the main menu. In the Name: field, enter the name for the new
folder (SomeUser in our example). The Belongs to: pull-down list specifies if this is a sub-folder or not (Top
Level). Press OK to create the folder.

All that is left is to create the filter. Select the message from the sender you want to filter and right click on it.
From the contextual menu, select Create Filter→Filter on From... and the filter rule will be automatically created
for you. You just have to select the destination folder in Filter Actions and accepta that rule pressing OK. You
can create as many filtering rules as you want.

14.4. Instant Messaging And IRC

This section will discuss Gaim , an AOL AIM clone. We will also discuss the X-Chat IRC client later in this
section.

14.4.1. Instant Messaging With Gaim

Gaim is a very complete instant messaging (IM) client. With it, you can chat with people using other protocols
than Gaim ’s (Oscar), that is AIM, Gadu-Gadu, ICQ, IRC, Jabber, MSN, Napster, Yahoo and Zephyr. Gaim is
based on AOL’s AIM client but as the developers say, “Gaim is NOT endorsed by or affiliated with AOL”.

14.4.1.1. Using Gaim

To start using Gaim , access the KDE menu→Networking→Instant messaging→Gaim menu. If you use GNOME , use
the same path starting with the GNOME menu. From a command line, simply type gaim &.

Figure 14-9. Gaim Login Window

To use Gaim , you need an AIM account which consists of a Screen Name name and password. If you already
have one, simply fill in the respective fields and click on Signon. If not, you need to access the AIM site (http:
//www.aim.com). Once you are there, click on New Users.

Then, you will be prompted to enter a Screen Name and other information has shown in the image below.

Figure 14-10. Gaim Registration

If all goes well, you now have an AIM Screen Name and password. If not, read on and correct what went
wrong.
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Below the Congratulations! message on the next page of the AIM registration process are download steps: forgot
about those since the software is already installed on your Mandrake Linux system.

14.4.1.2. Signing On

Once you have your Screen name and password, type them in and press on Signon or Enter after you have
entered your password. This window will appear.

Figure 14-11. Gaim Buddy List

This is Gaim ’s main window and it holds two small menus, along with the help menu on the right, which only
gives out very generic information such as the developer’s names and web site (http://gaim.sourceforge.
net).

14.4.1.2.1. File Menu

The first item you will find is Add A Buddy. Click on it and add the relevant information.

Figure 14-12. Adding a Buddy

You can activate the Gaim –Buddy Ticker in order to see which
buddies are online. To do so, access the Tools→Preferences sub-
menu. Then, when you see one of your buddies, click on its icon,
and an instant messaging window will open.

The next item, Join A Chat, enables you to chat with many people at a time. Simply give the chat a name and
invite your buddies to participate.
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Figure 14-13. Joining a Chat

The next two items are self-explanatory: we will skip those and go straight to the Import Buddy List item.
Clicking on it will pop up a window from which you can select the path to buddy lists for other instant
messaging clients.

14.4.1.2.2. Tools Menu

Again, the items in this menu speak for themselves. But nevertheless, let us discuss a few of them.

14.4.1.2.2.1. Plugins

If you wish to chat with buddies who use Yahoo! Messenger, Jabber or whatever other protocol Gaim supports,
you need to enable the plugin first.

Once you click on the Plugins menu, a window will pop up in which you will see a Load button. Click on it and
a window displaying all the available plugins will be shown.

Figure 14-14. Loading Plugins

Once this is done, you can now add other identities through the Tools→Accounts sub-menu. Just enter your
Screenname, Password and choose the right Protocol (i.e.: Yahoo for Yahoo! Messenger).

Figure 14-15. Managing Accounts
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14.4.2. Other Instant Messaging Client Software

Here is a non exhaustive list of other instant messaging client software which work well under Mandrake
Linux:

• Gabber;

• GnomeICU;

• LICQ.

14.4.3. IRC Using XChat

Jarkko Oikarinen is the original writer of Internet Relay Chat (IRC). His main goal was to improve on the talk
program. Although it proved to be functional, it only allowed for 2 users to chat at the same time.

Nowadays, thousands of IRC servers exist around the world, giving millions of users the chance to talk simul-
taneously with many users. These servers are dispersed in Asia, Europe, North America and Oceania. IRC
servers are grouped in networks (also called “nets”), the largest ones being DALnet (http://www.dal.net),
EFnet (http://www.efnet.net) – the original IRC network, Newnet (http://www.newnet.net) and Undernet
(http://www.undernet.org).

IRC servers are made up of channels where users regroup to chat with their keyboards. Anyone can make up
a channel name, if that channel does not already exist. And although many people join a channel to discuss
with many users, it is also possible to send private messages which other users will not see.

Channels are server-dependant. Hence, the #linux channel on the
irc.somechannel.net server is different from the one on the
irc.someotherchannel.net serve: they do not communicate with
one another.

The XChat application we will speak about in this section is only one of many multi-user, graphical IRC chat
clients. We will give a list of other clients at the end of this section.

14.4.3.1. Launching XChat

Since XChat is used in a networked environment, you will logically find it in the Networking→IRC sub-menu of
both KDE and GNOME menus. As always, you can also launch it through the terminal by issuing xchat &.

Figure 14-16. XChat Server List

Once XChat is launched, the server-list window will pop up. First of all, you must enter a nickname (Peter
Pingus in our example) in the appropriate field by which you will go by on IRC. Then, select a server (in
our example, irc.openprojects.net). Finally, choose a channel. The typical syntax to join a channel is /join
#channel.

Now, let’s join the #mandrake channel. Type /join #mandrake. If all went well, you are now “in” the Mandrake
channel which targets Mandrake Linux new users.

158

http://www.dal.net
http://www.efnet.net
http://www.newnet.net
http://www.undernet.org


Chapter 14. Using The Internet

Figure 14-17. XChat Channel

14.4.3.2. The XChat Window

The XChat window has 5 major components.

Menu Bar

Contains the 7 basic menus: X-Chat, Windows, User Modes, Settings, Scripts & Plugins, User Menu and Help.

Tool Bar

Under the menu bar. It shows 4 buttons on the left of the the Text Box (see next entry). The first one
marked by an X closes the current channel/server, the button on its right links/unlinks the current win-
dow (which means you can attach/detach a specific window from the main window). The two arrows
either move the current tab window to the left or right. On the text box’s right are buttons displaying a
series of letters (starting with T and ending with K) used to set channel modes. You need to be channel
operator to use these but this exceeds the scope of our section.

Text Box

Shows one and only one thing: the channel’s topic.

User List

Located on the middle-right, it displays the list of users currently in the channel. A green dot means that
user is the channel operator. A yellow dot means that user can post to a moderated channel. Under the
user list is a series of buttons which are linked to the Settings→User-list Buttons sub-menu.

Input Box

At the bottom of the window. On the left is your nickname. On the right is the mini-buffer where you can
type your text. Leaving your mouse pointer on the arrow at the right of the mini-buffer, it will display
Open Toolbox. Clicking on it will show plain, bold and underline options, a series of colors which you can
apply to your text, an ASCII chart, a color paste option as well as conference mode.

14.4.3.3. Essential XChat Commands

The input box’s mini-buffer is where you issue your commands. All IRC commands start with a / and are
followed by the name of the command. Here’s a list of useful ones:

AWAY

Shows a message signifying you are busy (by default). If you type /away eating, this is what will be
shown:
* peterpingus is away: eating
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BACK

Tells other users you are available again. It will also display how much time you were away:
* peterpingus is back (gone 00:00:23)

HELP

Displays the list of available commands in your XChat window.

JOIN

Used to join a channel. /join #mandrake will cause you to join that channel.

ME

Indicates what a user is doing/feeling. /me in a good mood displays:
* peterpingus in a good mood

MSG

Sends a private message to another user which other users will not see. However, it does not open a new
tab (channel) like the QUERY command. The syntax is:
/msg nickname_of_the_recipient message

Hence, /msg Queen Pingusa how are you? displays:
>queenpingusa< how are you?

NICK

Allows to change your IRC nickname. For example, if Peter Pingus wanted to change his nickname to
Johnny, he would issue /nick Johnny. Then, this will be displayed:
--- You are now known as Johnny

PART

Tells other users you are leaving the channel. The syntax is:
/part #channel message

Once you issue that command, you will be disconnected from the channel you were connected to. To
reconnect, simply type:
/join #channel

QUERY

Opens up a new tab in your XChat window and starts a private conversation with a user. The syntax is
the same as for the MSG command:
/query user message

QUIT

Terminates your IRC session. You can add a comment, like /quit going to bed.

14.4.3.4. Basic IRC Line of Conduct

Here are basic rules we strongly suggest you follow strictly. They are common-sense rules, but unfortunately,
not everyone follows them.
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Spoken Language

Most IRC users speak English, that’s just plain fact. However, it’s not the only language spoken on IRC.
Before starting a thread, let’s say in Portuguese, you should inquire about the channel’s language policy.
If it is obvious the channel on which you are is an English-speaking one, create or choose another channel
where you can write in the language you prefer.

Some channels may also be multilingual.

Greetings

Depending on the number of users on a specific channel, it might not be welcomed to greet everyone that
enters/leaves the channel. Usually, one “Hello!” or “Goodbye!” is quite enough.

Attitude

If you do not know the people with whom you chat, chances are they will only know you through what
you write. Hence, if you don’t want to be perceived as a jerk, don’t act as one! This means:

• do not dump large amount of data on a channel/user;

• do not harass others or flame them for no reason.

14.4.3.5. Other IRC Clients Under Mandrake Linux

Here is a short list of other IRC clients which work well with Mandrake Linux:

• ksirc;

• KVIrc;

• BitchX (text-mode only).
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Chapter 15. Securing Your Machine

Mandrake Linux ships the Bastille security tools suite. It is a set of two tools — one for basic configuration,
and one allowing complex settings, which should make your machine much more secure. It is highly recom-
mended that you run one of those tools just after installing your machine, and even before connecting it to the
network.

15.1. Easy Configuration

The BastilleChooser tool allows inexperienced users to easily secure their machine, while not imposing too
many constraints on the daily use of the machine. The tool is a little wizard whose steps we are now going to
describe. To launch it, you need to run the command BastilleChooser from a Terminal as root. It is part of
the Bastille-Chooser RPM package.

1. Introduction (figure 15-1): click Next to go to first step, or Cancel to abort the wizard.

Figure 15-1. Introduction to The Bastille-Chooser Wizard

2. You can see figure 15-2 the first step to using the wizard is to select the level of security to be applied to
your machine. As the text states, a high level of security has to be balanced against the ease of use — the
friendliness of your system.

Figure 15-2. Choosing a Security Level

3. When this is done, you are asked whether your machine will act as a server or not (see figure 15-3). If you
choose No here, all ports on the machine will be closed, and the wizard will finish. If you choose Yes, you
will be presented with another dialog, where you can choose which services will be used by the machine.

See Security Levels in Details, page 167 for explanations on the different security levels for both workstation
and server uses.
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Figure 15-3. Is Your Machine Acting as a Server?

4. As you chose Yes in the previous wizard, you are now asked to select the services allowed to get in your
machine (figure 15-4). Check the corresponding choice for each available service, and click the Finish but-
ton. The firewall will allow requests concerning the services marked as Yes in this dialog.

Figure 15-4. Choosing Allowed Services

That’s all! If you found that this wizard does not offer all the options you would have liked to configure, read
the next section.

15.2. Advanced Security Configuration

We are now presenting InteractiveBastille , a much more advanced tool, which allows even inexperienced
people to make choices on a large number of security-related parameters. Running all the wizards available
may take up to an hour if you wish to do it carefully. But what is an hour compared to a break-in in your
system?

Figure 15-5. A Typical InteractiveBastille Screen
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To launch this tool, you need to run the command InteractiveBastille from a Terminal as root. It is part
of the Bastille RPM package.

This tool is made of 14 wizards, each one in charge of a particular security aspect. The screen, an example of
which you can see in figure 15-5, is made of five parts:

1. The menu has 16 entries: one for the title screen, 14 corresponding to the 14 wizards, and an End screen,
where you can validate the choices made in all wizards and make them active on the machine.

2. The question asked.

3. An explanatory text about the question, read it carefully before answering.

4. The answer is either a simple Yes/No choice or a field to fill with values, as explained in the explanatory
text.

5. The navigation buttons:

• Previous: will return to the previous screen of the current wizard;

• Next: goes to the next question of the current wizard;

• Explain Less/More: ask for more or less information.

This then, is the preferred way to proceed:

1. Open each wizard in turn. You probably do not need to run them all, as the first question generally deter-
mines whether you need to run that wizard or not.

2. At the End Screen answer Yes to make your changes effective.

3. Test the main features of your machine, test that access is denied for unauthorized services. In a nutshell,
check that your new settings act as you expect them to act and that there are no annoying side effects.

4. You may have to run the tool again until you get the desired result.

15.3. Security Levels in Details

Here we review the details of the three security levels: Lax, Moderate and Paranoid used in the security level
settings either during the install or afterwards using BastilleChooser .

15.3.1. Workstation Configuration

15.3.1.1. Lax Security Level

• No firewalling

• Disables SUID status to the news server tools and DOSEMU

• Setup password aging -- old unused accounts will be disabled, though the owners will be warned

• Password protects single-user mode

• Applies limits to any one program/user’s resource usage, to block Denial of Service attacks.

• Configures additional logging

• Deactivate the DHCP Server daemon

• Disable the SNMP daemons

• Disable the VRFY/EXPN data mining commands in Sendmail

• Deactivate the DNS server
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• Deactivate the Apache server

• Deactivate Apache Server Side Includes (SSI)

• Set umask to 022

• Set security level to 2

• Apply file permission level 2

• Restrict "." from the PATH variable

• Deactivate telnet

• Deactivate ftp

• Activate security checks

15.3.1.2. Moderate Security Level

• Moderate firewalling

• Disables SUID status to dump, restore, cardctl, rsh, rlogin and rcp

• Disables SUID status to the news server tools and DOSEMU

• Disables rsh/rlogin access to this machine

• Sets up password aging -- old unused accounts will be disabled, though the owners will be warned

• Password protects single-user mode

• Applies limits to any one program/user’s resource usage, to block Denial of Service attacks.

• Configures additional logging

• Deactivates the APMd daemon

• Disables NFS and Samba

• Disables GPM

• Deactivates the DHCP Server daemon

• Disables the SNMP daemons

• Deactivates Sendmail’s network listening mode, so this WORKSTATION doesn’t operate as a mail server

• Disables the VRFY/EXPN data mining commands in Sendmail

• Deactivates the DNS server

• Deactivates the Apache server

• Deactivates the Apache Server Side Includes (SSI)

• Sets umask to 022

• Sets security level to 3

• Applies file permission level 3

• Restricts "." from the PATH variable

• Deactivates telnet

• Deactivates ftp

• Disables FTP’s anonymous mode capability

• Activates security checks

• Applies TMPDIR protection
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15.3.1.3. Paranoid Security Level

• Tight firewalling

• Disables SUID status to mount, umount, ping, at, usernetctl, and traceroute

• Disables SUID status to dump, restore, cardctl, rsh, rlogin and rcp

• Disables SUID status to the news server tools and Disables SUID status to the news server tools and
DOSEMU

• Disables rsh/rlogin access to this machine

• Restricts use of cron to root account

• Disables the pcmcia startup script

• Sets up password aging -- old unused accounts will be disabled, though the owners will be warned

• Password protects single-user mode

• Applies limits to any one program/user’s resource usage, to block Denial of Service attacks.

• Configures additional logging

• Deactivates the APMd daemon

• Disables NFS and Samba

• Disables GPM

• Deactivates the DHCP Server daemon

• Disables the SNMP daemons

• Deactivates Sendmail’s network listening mode, so this WORKSTATION doesn’t operate as a mail server

• Disables the VRFY/EXPN data mining commands in Sendmail

• Deactivates the DNS server

• Deactivates the Apache server

• Deactivates the Apache Server Side Includes (SSI)

• Deactivates the Apache Server follow-symbolic links behavior

• Deactivates the Apache Server CGI’s

• Deactivates all remaining daemons, with the exception of crond, syslog, keytable, network, gpm, xfs and
pcmcia

• Sets umask to 077

• Sets security level to 4

• Applies file permission level 4

• Restricts "." from the PATH variable

• Deactivates telnet

• Deactivates ftp

• Disables FTP’s anonymous mode capability

• Disables FTP’s user mode capability

• Activates security checks

• Applies TMPDIR protection

15.3.2. Server Configuration

The server configurations include three security levels. They start with the following major servers turned off:
DNS, Mail, web, FTP and DHCP. And then modify them, based on which of the five major server types the
user asks for.
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15.3.2.1. Lax Security Level

• No firewalling

• Disables SUID status from dump/restore, cardctl, dosemu, news server programs

• Enforces password aging

• Password protects single user mode

• Adds additional logging

• Disables apmd, NFS, Samba, pcmcia, DHCP server, news server, routing daemons, NIS, SNMPD

• Disables VRFY/EXPN data mining commands in sendmail

• Deactivates named (dns)

• Deactivates apache (web)

• Deactivates apache Server Side Includes (SSI)

• Sets umask to 022

• Sets security level to 2

• Applies file permission level 2

• Deactivates telnet

• Deactivates ftp

• Activates security checks

15.3.2.2. Moderate Security Level

• Moderate firewalling

• Disables SUID status from dump/restore, cardctl, dosemu, news server programs

• Disables SUID status from rsh, rlogin

• Disables rhost-based authentication

• Enforces password aging

• Password protects single user mode

• Adds additional logging

• Disables apmd, NFS, Samba, pcmcia, DHCP server, news server, routing daemons, NIS, SNMPD

• Disables gpm

• Disables VRFY/EXPN data mining commands in sendmail

• Deactivates named (dns)

• Deactivates apache (web)

• Deactivates apache Server Side Includes (SSI)

• Deactivates apache CGI script execution

• Disables FTP user mode

• Disables FTP anonymous mode

• Sets umask to 022

• Sets security level to 3

• Applies file permission level 3

• Restricts "." from the PATH variable

• Deactivates telnet

• Deactivates ftp

• Activates security checks
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15.3.2.3. Paranoid Security Level

• Strong firewalling

• Disables SUID status from dump/restore, cardctl, dosemu, news server programs

• Disables SUID status from rsh, rlogin

• Disables SUID status for mount, umount, ping, at, usernetctl, traceroute

• Disables rhost-based authentication

• Disables cron use to everyone but root

• Enforces password aging

• Enforces limits on resources to prevent DoS attack

• Password protects single user mode

• Adds additional logging

• Disables apmd, NFS, Samba, pcmcia, DHCP server, news server, routing daemons, NIS, SNMPD

• Disables gpm

• Disables VRFY/EXPN data mining commands in sendmail

• Deactivates named (dns)

• Deactivates apache (web)

• Deactivates apache Server Side Includes (SSI)

• Deactivates apache CGI script execution

• Deactivates apache’s following of symlinks

• Disables printing

• Disables FTP user mode

• Disables FTP anonymous mode

• Activates TMPDIR protection

• Sets umask to 077

• Sets security level to 4

• Applies file permission level 4

• Restricts "." from the PATH variable

• Deactivates telnet

• Deactivates ftp

• Activates security checks
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Mandrake Control Center is the main configuration tool for your Mandrake Linux distribution. It enables the
system administrator to configure the hardware and services used for all users. The tools accessed through
the Mandrake Control Center greatly simplify the use of the system, notably by avoiding the use of the evil
command line :-)

Not all tools accessible from the Mandrake Control Center are described in this chapter: notably “Package
Management”, page 215 and “Configuring Internet Connections”, page 211.

Figure 16-1. The Control Center Icon

Control Center is also available from the command line in text
mode by running DrakConf or mcc.

The following image shows you the window that pops up when you click on the Control Center icon on the
desktop (figure 16-1).

Figure 16-2. The Control Center’s Main Window

The only menu worth detailing is the Options one:

• Display Logs. When activated, this option displays a Logs frame at the bottom of the main window. This frame
will display all the changes made on the system by the configuration tools launched from within the control
center.

• Embedded mode. Configuration tools launched from the Mandrake Control Center can be displayed in two
different modes. The embedded mode will display the tool in the main frame of the control center. If you
deselect this option, the tools will be displayed in their own window.

The tools are sorted into six categories (or more depending on the packages installed) on the left of the window.
You can open a category by clicking on the label. Following are all the tools and references to the corresponding
manual sections.
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Boot Creating a Boot Disk, page 174

Changing Your Boot-Up Configuration, page 174

Creating a Boot Disk For a (Semi-) Automated Installation, page 175

Hardware Controlling The Graphical Configuration, page 176

Configuring Your Hardware, page 178

Changing Your Mouse, page 183

Configuring Printers, page 183

Changing Your Keyboard Layout, page 189

Mount Points Managing Your Partitions, page 190

Managing Removable Devices, page 193

Importing Remote NFS Directories, page 196

Importing Remote SMB Directories, page 194

Network & Internet “Configuring Internet Connections”, page 211

Configuring Your Machine as a Gateway, page 197

Security Setting Your Security Level, page 199

System Customizing Your Menus, page 200

Configuring Start-Up Services, page 203

Managing The Fonts Available on Your System, page 204

Adjusting Date And Time, page 207

“Package Management”, page 215

Searching Through The Log Files, page 208

Access to The Console, page 209

Table 16-1. A Fast Review of Mandrake Graphical Tools

A seventh category, Configuration Wizards, appears if the wizdra-

ke package is installed. The documentation for those wizards is
available inline or in the Server Reference Manual . This category
contains 12 wizards allowing basic configuration of common LAN
services as well as web and FTP servers.

16.1. Creating a Boot Disk

If you did not create one at installation time, this tool allows you to create a boot disk. This
rescue disk allows you to perform some maintenance tasks on your system in case of failure.

See the section Using drakfloppy to Create a Boot Disk of the Reference Manual for more information on the use of
this tool.

16.2. Changing Your Boot-Up Configuration

This tool allows you to change two aspects of the boot process. The boot mode: text or graphi-
cal, and the system or login mode.
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Figure 16-3. Choosing The Boot Mode

The main dialog is divided into three zones, each one corresponding to a special configuration of the boot
process:

16.2.1. Configuring of The Bootloader

Clicking the Configure button of the first zone launches the bootloader setup. You will be presented two dialogs.
The first one enables you to switch from one bootloader to another, and to its physical location. The second
allows you to manage the different entries available through the bootloader.

Unless you really know what you are doing, it is not recommended
to change those settings as this may prevent you from booting your
machine the next time you try to power it on.

16.2.2. Configuring The Login Mode

Here, you can control the way people can log onto the machine. There are two aspects:

1. graphical interface: if you wish to have the X-Window (graphical display) system at boot time, check the
box Launch the X-Window system at start. If you leave it unchecked you will be presented the text login.

2. autologin: if you are the only one to use your machine and nobody else has access to it, you may choose
to be automatically logged in at boot time. If you check Yes, I want autologin, just choose the user to be
automatically logged in in the first combo box, and the preferred Window Manager in the second.

16.3. Creating a Boot Disk For a (Semi-) Automated Installation

This tool allows a system administrator to replicate an installation on many machines while
not having to reconfigure all steps by hands for each machine.
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Figure 16-4. Choosing The Steps to Replay or Not

After a warning screen about what we are going to do, a list of most of the installation steps is displayed. For
each step is associated a two-entry menu choice:

• replay: choose this if you want to reuse the choices you made during the manual installation for the automa-
ted installation;

• manual: choose this if you prefer to manually reconfigure this step during the automated installation.

When you have made your choice for each installation step, click the OK button. You will be asked to insert a
blank floppy disk (if it is not blank, all data it contains will be erased).

After clicking OK again, the boot floppy disk will be created with the following characteristics:

• the installation method (from CD-ROM, via NFS, FTP, etc.) is the same as the one used during the installa-
tion of the machine currently worked on;

• all the steps marked as replay will be replayed with all choices set to the ones made during the installation
of the current machine;

• all the steps marked as manual will have to be manually configured during the installation;

• for security reasons, the partitioning and formatting steps will have to be done manually.

Then all you have to do is insert the resulting floppy in the machine you want to replicate the installation on,
turn it on, and configure the few remaining steps manually, saving you a lot of time.

16.4. Controlling The Graphical Configuration

This little tool allows you to change the video resolution of your screen, if the one you configu-
red at installation time does not fit your needs. When something really goes wrong or if you
could not manage to configure your graphical server at installation time, there is an expert
mode allowing you to configure your hardware.
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If you cannot get the graphical environment at boot time, and only
the command-line interface, log in as root and launch the XFdrake

command. You will get the exact same tool as described here, but
in text mode.

16.4.1. Changing The Resolution of Your Display

This little tool allows you to change the video resolution of your screen, if the one you configured at installation
time does not fit your needs.

Figure 16-5. Choosing a New Video Resolution

You get two choices on the window (figure 16-5): resolution (in pixels) and depth (number of colors) of your
system. Simply choose the one you wish to use and click the OK button.

Figure 16-6. Test The New Video Mode?

Then a new dialog will ask you whether you wish to test the new choices or not (figure 16-6). It is highly
recommended you test it, because if it does not work, it will be harder later to recover a working graphical
environment. If the test fails, or if you are not happy with the proposed settings and choose No, you go directly
to the X Configuration Expert Mode, page 178.

Figure 16-7. Text or Graphical Login?
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If all goes well, you will be presented a new dialog offering to start the graphical server at boot time or not.
Answer No if you prefer to have a text login at boot time. Selecting Yes will launch the graphical login manager.

The changes will be activated after you quit and restart your graphical environment.

16.4.2. X Configuration Expert Mode

You can access a more advanced tool with which you can even modify the screen or video card in use. Simply
click the More button while in simple mode. You will be presented various options:

Change Monitor

This option displays a tree with all major monitor brands and models. First, expand the branch corre-
sponding to your monitor brand, then choose the model you are using.

Change Graphic Card

Same principle as for monitors, choose your video card brand and model. Next, depending on the chosen
video card, you may be proposed various X server versions, with hardware acceleration or not. Choose
the one which best suits your video use.

Change Resolution

This choice simply presents resolution and color depth combo boxes.

Show Information

This is a simple window summing up the current hardware choices.

Figure 16-8. The X Information Window

Test Again

It is recommended that you make a final configuration test before closing xfdrake : this will ensure you
have no problems when rebooting the graphical server.

When you have successfully tested your configuration, choose the Quit option. You will be presented a sum-
mary of the new configuration. Choosing Yes will activate the changes, No will discard them, keeping old
configuration parameters.

You are then finally presented the figure 16-6 dialog.

16.5. Configuring Your Hardware

16.5.1. Introduction
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The HardDrake project has been developed to simplify hardware configuration under
GNU/Linux by providing an easy-to-use interface.

HardDrake is composed of two parts:

1. A main tool called harddrake, used to configure hardware by launching:

2. A HardDrake Wizard or external configuration tool(s) (which can be configured).

16.5.2. harddrake

16.5.2.1. Description

When was the last time you had to install a new sound card on your GNU/Linux system and just could not
quite get it to work? Sure, you know which model it is and can even guess which driver supports it and may
even have some idea as to the IRQ DMA and I/O port it uses.

Here comes HardDrake .

HardDrake is a fully GUI-based tool which ties together many of the tools already included in a GNU/Linux

distribution. It automates and simplifies the process of installing new hardware. Some items will be detected,
others can be selected from a drop-down list. The various I/O, IRQ and such X86-annoyance settings can be
adjusted from within this interface.

On one hand, HardDrake is used to display information. On the other hand, it can launch configuration tools
as well. With its easy-to-use interface, you will be able to browse (hopefully) all the hardware your system
consists of.

HardDrake uses the “detect library”, so if your new hardware is not detected, you only need to upgrade
detect itself.

16.5.2.2. Usage

To launch HardDrake , you can start it from:

• Control Center : just click on the HardDrake icon.

• a terminal: type harddrake. In a terminal, you can also pass parameters to it.

• GNOME and KDE : go to the start panel. The HardDrake entry is in the Configuration→Hardware→HardDrake sub-
menu.

After a wait screen (indicating the detection process), you will see a window like figure 16-9.
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Figure 16-9. HardDrake Main Window

On the left, you can see the device tree showing you all categories.

For some categories, you will notice a “[+]” symbol. By clicking on it, the subtree will be expanded and all
detected hardware of this category will be listed. figure 16-10 shows such a window.

Figure 16-10. HardDrake – Selected Device

If you select a device, you will get some useful information about it. In some cases, you will see a configuration
button, which will allow you to configure the selected device. In figure 16-10, we expanded some parts of the
tree and selected a device in one of the categories. On the right, you can see information about the selected
card. If you press the Run Configuration tool button, the configuration tool associated with this device appears
and lets you configure this card.

There is a special category called “Other Devices”, which contains all currently unknown hardware in your
system. There is information available on how to help us to add this unknown hardware to our database. By
reporting the requested information, you can hope to see your hardware recognized in future versions!
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In figure 16-11, you can see a special case where the user is asked to report an ID to the harddrake team
(mailto:harddrake@mandrakesoft.com). In most cases, you will be asked to send the output of a “pnpdump”.

Figure 16-11. HardDrake – Unknown Device

At the top of the window, a menu provides four items. First is the File menu with four actions. Save report file
is used to write a system report to disk. Load report file is used to load the report file generated. Reload and Exit
let the user restart and exit HardDrake , respectively.

The second item, the Options menu, is for configuring HardDrake . The first menu entry, Probing Options, allows
to disable some tests and to configure actions associated with the Run Configuration Tool button and the Tools
menu. Hence, you can easily select your preferred configuration program for a hardware category.

Figure 16-12. HardDrake – Probing Options Window

The last menu is the HardDrake ’s integrated help.
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16.5.3. HardDrake Wizard

16.5.3.1. Introduction

The HardDrake Wizard is a generic configuration tool. It replaces the former configuration tools etherdrake
and sounddrake.

16.5.3.2. Usage

As an example, we will now focus on the sound Wizard .

The Wizard , if available for a certain component class, is launched from HardDrake by pressing the Run Confi-
guration Tool button. After a few moments, a window like this figure 16-13 should appear.

Figure 16-13. HardDrake - Sound Wizard

You can change the current selection, but in most cases it is not a good idea, as the detected device is already
highlighted. For an ISA card, you need to specify the I/O and IRQ settings if the values proposed by default
are not correct. After checking the configuration, press the OK button to test it. Three samples should be played
(if MIDI is available and you have a sound card supporting 16 bit DMA channels). If you did not hear them
without any error messages, it may be due to one of the following reasons:

• your speaker volume is too low;

• a hardware problem, maybe your sound card is damaged?

• your sound card is not correctly installed.

An error message may occur because of the following problems:

• bad settings (I/O, IRQ, DMA, etc.);

• old sound modules from another configuration are still in memory. In this case, unload them by running
modprobe -r <module_name> from a terminal.

If you heard proper sound samples, you can press OK to confirm the configuration. Check sound configuration
by starting a program which uses sound (specially from a non root account). After these tests, you should
reboot your system and check that the modules are loaded correctly at boot time.
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16.5.4. Problems/Troubleshooting

If your hardware is not recognized or your system freezes, contact the harddrake team (mailto:harddrake@
mandrakesoft.com) and use the subject “[Detect]” in your e-mail.

If you think it is a bug related to HardDrake (bugs with the user interface), contact the same e-mail address
but use “[HardDrake ]” as the subject.

16.5.5. Other Information

• The HardDrake home page (http://www.MandrakeLinux.com/harddrake/) (for news, updates, informa-
tion, etc.)

• The HardDrake FTP archive (ftp://www.MandrakeLinux.com/pub/harddrake/) (download HardDrake , old
versions, tools)

• IsaPnPTools home page (http://www.roestock.demon.co.uk/isapnptools) (used by the detect library)

16.6. Changing Your Mouse

This dialog figure 16-14 allows you to set up another mouse, in case the mouse you are using
is different from the one you chose at installation time.

Figure 16-14. Choosing a Different Mouse

Mice are sorted in a tree view by connection type and model. Highlight the mouse of your choice.

Changes made are effective immediately after clicking the OK.

16.7. Configuring Printers

This tool allows you to configure a printer newly installed on your machine, or to configure
your machine to act as a server for a printer newly connected to your local network.
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Figure 16-15. Managing Printers

The printer’s main configuration tool window (figure 16-15) contains four buttons:

• Add a new printer: to launch the printer configuration wizard described below;

• Refresh printer list: to browse all printers accessible by this machine, either locally or served by other cups
servers on the local network. The said cups servers are accessible for printing, without reconfiguring them.

• Expert mode: this mode will add extra functionalities to the tool. See Expert Mode, page 188.

• Quit: when you are finished configuring or reconfiguring the printers.

Additionally, you get a tree view of accessible printers on top of the
window, in case printers are already available.

16.7.1. The Printer Configuration Wizard

Click on the Add a new printer button, and the configuration wizard will come up. To go from one step to
another, click the OK button. Use Cancel to abort the installation.

Figure 16-16. Auto-Detecting Printers

The first screen offers to enable auto-detection of locally connected printers. Try first Do auto-detection; if it
works, the next step presents which printer(s) was/were detected. If you are happy with it, click on Next ->
and jump to figure 16-22. If the configured printer is wrong, or if auto-detection failed, click Manual printer setup
and follow the instructions below.
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Figure 16-17. The Printer Port

First of all you need to tell on which port your printer is connected; either a parallel or USB port.

Figure 16-18. HP Multi-Function Device

Then, you are asked whether your printer is a multi-function device. Answer according to your actual printer.
If so, additional packages will be installed on your system and you will be told how to scan with your device.

Figure 16-19. Choosing a Name For Your Printer
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Then, you need to provide a name for your printer to easily identify it, and optionally, a Printer description and
a Physical location (figure 16-19).

Figure 16-20. Choosing The Printer Model

You are then presented the list of supported printers. It is a tree view with the manufacturer’s name first and
then the printer’s model. Select the printer you have or a compatible one (figure 16-20).

Figure 16-21. Configuring The Printer’s Options

After that, you are presented the options associated with the chosen printer (figure 16-21). It is important you
choose the proper paper size and the ink type which is currently selected. Indeed, if those settings are not
correct, the printing may fail.
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For settings regarding the printout quality, keep in mind that higher
quality levels make the printer substantially slower.

If you already have one or more configured printers, you will then
be asked whether you want to use the printer being configured as
the default or not. If you say No, the former printer default will
remain.

Figure 16-22. Test The Printer

Finally, you are asked whether you want to test the printer or not. Two test pages are available (figure 16-22)
so you can adjust the parameters according to your future use. It is advisable to print at least one test, so you
can immediately correct the parameters if something goes wrong. After a moment, the printer should begin
to print, and you will be asked whether the printing was successful or not.

Figure 16-23. Was The Printout Successful?
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If the printing was successful, answer Yes, and you will return to the printers list. Congratulations, you are
ready to print! If not, you will get the printer configuration menu (figure 16-25) in order to correct the settings.
See the Reconfiguring an Existing Printer, page 188 section.

Your printer will now appear in the list of local printers in the main window (figure 16-24).

16.7.2. Reconfiguring an Existing Printer

Figure 16-24. A Printer Is Now Configured

Double-clicking on a printer’s name in the list displays a menu where you can choose actions to take on that
printer, as shown in figure 16-25. Each option gives access to a particular step of the wizard we described
above (The Printer Configuration Wizard, page 184) in the case of a new printer, but with predefined values in
all fields, which you may update.

Figure 16-25. Modifying an Existing Printer

There are two additional options:

• Know how to use the printer: displays much information about how to use that printer model. In the case of a
multi-function device from HP, scanning information are also displayed;;

• Remove printer: if you want to delete the configuration of that printer from the system. The printer won’t be
available anymore for printing.

Select an option in the dialog and then click the Do it! button.
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16.7.3. Expert Mode

The expert mode basically has three additional features:

• Switch from one printing system to another. This is allowed by the new Configure printing system which
appears in the main menu. Three systems are available: CUPS (by default), LPRng , and PDQ . Choosing one
or the other is out of the scope of this manual.

• Choose a different driver than the default for a printer. There are generally different drivers available for a
same printer. In expert mode, a third level appears in the printer model selection list (figure 16-20) allowing
to change the driver for each printer.

• Install a remote printer. Below, we show this feature, which allows to print on remote printers installed
anywhere on a local network.

If you start the new printer wizard in expert mode, there is an additional step at the beginning.

Figure 16-26. Configuring a Remote Printer

Five different connection types are available:

• Local printer: a printer directly connected to a parallel/USB port of your computer. In most cases, the printer
model will be auto-detected;

• Printer on remote lpd server: a printer already served by another machine on a lpd server;

• Network printer (TCP/socket): a printer directly connected to your local network;

• Printer on SMB/Windows 95/98/NT server: for printers already connected to a computer running an OS that
serves printers with the SMB protocol, including Samba printers (the necessary Samba components will be
automatically installed in this case);

• Enter a printer device URI: this option allows to directly enter the Universal Resource Identifier (hence URI)
of the printer on your network. It can be used for any of the above remote connections and more. This is
useful when your system administrator directly provided you the printer’s URI.
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16.8. Changing Your Keyboard Layout

This dialog figure 16-27 simply allows you to define another keyboard layout, in case the
keyboard you are using is different from the one you chose at installation time.

Figure 16-27. Choosing a Different Keyboard Layout

Changes made are effective immediately after clicking OK.

16.9. Managing Your Partitions

We already learned from “Structure of a hard disk, page 7 ” what partitions are used for; and
you initially set up your partitions during the installation process. DiskDrake allows you, to
some extent, to resize your partitions, move them, etc.

DiskDrake is a very powerful, and therefore dangerous tool. Misu-
se of it can very easily lead to data loss in your hard drive. Conse-
quently, you are advised to take some protective measures before
using it:

1. Back up your data. Transferring them on another com-
puter, ZIP disks, etc.

2. Save your current partition table (the table describing
the partitions held on your hard drive(s)) on a floppy
disk (see A Note About The Expert Mode: Save The
Partition Table, page 193).
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16.9.1. The Interface

Figure 16-28. DiskDrake’s Main Window

DiskDrake enables you to configure each physical hard drive on the machine. If you only have one IDE
disk, you will see a single hda tab below the filesystem types. This tab is in fact repeated for each hard drive,
reproducing the Linux name of that drive. The tool available here allows you to control the partitioning of
each drive.

The window (figure 16-28) is divided into four zones:

• on the top. The structure of your hard drive. When you launch DiskDrake it shows the current structure of
the drive, and is modified in real time when you modify your partitions. Note however that changes are not
made effective on the drive until you press the Done button;

• on the left. A menu relevant to the partition currently selected in the above diagram.

• on the right. A description of the selected partition.

• at the bottom. Buttons for taking general actions. Note that the Toggle to expert mode button allows you to
access expert (even more dangerous) functions.

16.9.2. In Practice: Resize an Old Partition And Create a New One

In this section, we are going to do a little exercise that will use the more useful features of the tool. Let’s
imagine that you decide to use your machine as an FTP server. You then choose to create a separate /home/ftp
partition in order to host the FTP files.

This is what the current /home partition looks like (figure 16-29), before any modification. We chose to shrink
this partition in order to create the new one on the free some space.

In order to perform this example, you must log directly as root,
not using your user account.
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First of all, you need to unmount the /home partition by selecting it, then pressing the unmount button.

Figure 16-29. The /home Partition Before Resizing

As you may have guessed, just click on the Resize button. A dialog will appear (figure 16-30), in which you
will choose a new size for that /home partition.

Figure 16-30. Choosing a New Size

When this is done, you will notice that the graphic representation of your hard drive has changed. The
/home partition is smaller, and an empty space appears on the right. Click on that empty space and then
on the Create button that just appeared. A dialog (figure 16-31) where you can choose the parameters for the
new partition pops up. Change the start sector if you want to leave a new free space between the /home and
/home/ftp partitions. Define the needed size, choose the filesystem you want (generally Linux native) and
then enter the mount point of that partition, in our case /home/ftp.

Figure 16-31. Defining The New Partition
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This is what our projected partition table looks like now (figure 16-32).

Figure 16-32. The New Partition Table

Up until now, we did not really modify the partition table, we just
redesigned and rejected it. Further steps will effectively make our
changes active, so if you do not intend to modify your system, click
on the Undo button until you come back to the beginning.

You finally need to format (prepare to host files) the newly created partition: click on it, then on the Format
button. Confirm the writing of the partition table, and then the formating of the partition. You may be asked
to reboot the computer to make changes effective.

Figure 16-33. Confirming The Writing of The Partition Table

16.9.3. A Note About The Expert Mode: Save The Partition Table

Among many available features, the save and restore from file is one of the more interesting ones. It allows
you to save the current partition table to a file on a disk (floppy for example) and then restore it in case you
totally messed up your partition table. It can prove useful as long as you do not reformat partitions, otherwise
data will be lost.

16.10. Managing Removable Devices

This tool simply allows the system administrator to control most options that affect the beha-
vior of removable devices such as floppy and CD disks. This tool is available through a diffe-
rent icon for each removable device available on the machine.
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Figure 16-34. Choosing What to Change For That Device

Three properties that can be changed for each device:

• Mount point. The directory where the device’s files will be accessible. If the directory does not exist, it will
be created.

• Options. Controls various device options, notably whether it is mounted automatically (supermount) or not.
Note that if the supermount option is selected, the two others (user and noauto) must be deselected.

• Type. Proposes a list of filesystem types. If you have a specific media with an uncommon filesystem on it,
this is where you can tell Linux how to access it.

Whenever you make modifications to a removable device configu-
ration, you need to unmount and remount that device, especially if
it is set up as supermount.

16.11. Importing Remote SMB Directories

Sharing files among various machines have been available for a long time on UNIX systems.
The new facilities brought by recent tools make this feature easily available for all users. Sha-
ring data among two users on two different machines is made in three simple steps:

1. Admin authorizes sharing: Allow Users to Share Directories, page 196.

2. Users share directories: File Sharing, page 101 or Sharing Files, page 107.

3. Users browse remotely shared directories: File Sharing, page 101 or Sharing Files, page 107.

This tool allows the system administrator to import remote shared directories on the local machine. This tool
affects shares based on the SMB protocol, used mainly by windows OSs.

While users can individually access remote shares through their file managers, it may be interesting in some
cases to import a specific share for it to become available at once for all users. We will go through an example
showing how to import a template directory from a Windows machine.
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Figure 16-35. Scanning The Whole Network

When you click on the Search servers button (figure 16-35), the local network is scanned and all machines that
might share directories (including the local one) are shown. In our example, test is our local machine, server
is the machine that holds the templates we want to make available locally for all users.

Figure 16-36. Choosing The Machine to Import Files From

Clicking on a machine’s name displays the available directories on it.
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Figure 16-37. Choosing The Remote Directory to Import

Once a share is selected, a Mount point button appears. Clicking on it displays a dialog where you can type the
local directory where remote files will be accessible.

Figure 16-38. Where to Make Remote Files Accessible

Once this is done, two more buttons appear:

• Mount. Will actually make the resource available locally. When this is done, users simply have to point their
file manager to /mnt/templates to get the templates hosted on machine server .

• Options. These are advanced options about sharing which we won’t discuss here.

16.12. Importing Remote NFS Directories

This tool is the exact same as the one previously mentioned, except for one thing: it controls
shares made with the NFS protocol, instead of the SMB one. This means that this tool allows
to locally import shares from NFS-friendly machines. The interface is the same as described
above and the effects are similar, only the correspondent machines are different: UNIX for NFS
and Windows for SMB.

16.13. Allow Users to Share Directories

This feature allows the users of a machine to make some of their personal files accessible to
other machines on the same network. This is very useful for coworkers in a same building
wishing to share files among heterogeneous systems such as GNU/Linux and Windows .
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Figure 16-39. Choosing Export Protocol

The first time you run this tool, you are asked in which protocol you are interesting in. Check one or both of
the following:

• nfs. If you wish that you users can share files with other users using UNIX systems (like GNU/Linux );

• smb. If you wish that you users can share files with other users using Windows systems.

When you have checked the desired box(es), click OK. The needed packages are then installed.

By default both protocols are authorized. If you wish a protocol
not to be available make sure the packages nfs or samba are not
installed.

Figure 16-40. Controlling Exports

Then, three different options are available:

• No sharing. Prevent users from sharing data with others.

• Allow all users. All users without distinctions are allowed to share data with others.

• Custom. By choosing this option, only users in the fileshare group are allowed to share data. Of course,
you then need to add allowed people to this group (see Managing Users on Your System, page 204).

Once a user is allowed to share data, he can select the directories to be shared through his preferred file
manager: File Sharing, page 101 or Sharing Files, page 107.
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16.14. Configuring Your Machine as a Gateway

This tool configures your system so it acts as a gateway to the Internet for other machines
connected to it via a LAN. To do so, you will need an already configured connection to the
Internet, as well as a network connection to your LAN. This implies at least two interfaces, for
example, a modem and an Ethernet card.

After you complete this wizard, all computers on the network will be able to access the Internet as well.

Figure 16-41. Choosing The LAN Network Adapter

First of all, the wizard will ask you to choose the interface connected to your LAN. You may have more than
one in case the Internet connection already uses one Ethernet interface. Make sure to select the other one in
that case.

Figure 16-42. Configuring The LAN Interface

Next, and in case your interface has been previously configured, the wizard will propose to reconfigure the
LAN interface so that it will be compatible with the gateway services. You are recommended to just click on
Next ->.

Once this is done, the interface is reconfigured and required packages are automatically installed.

Basically, a DHCP server is installed on the machine. Then, you simply tell all the clients on the local network
to use your server by configuring them using an automatic IP configuration (DHCP). This way, they can
auto-configure themselves to use the Mandrake Linux machine as a gateway to the Internet. This works for
Windows , GNU/Linux or any other OS.

For a Mandrake Linux system, you just have to check the DHCP box when configuring its network:
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Figure 16-43. Configuring a Client For Using DHCP

16.15. Setting Your Security Level

There is a graphical interface to MSEC , called draksec . It is available through Control Center

and allows to change the security level of your system.

Figure 16-44. Choosing The Security Level of Your System

You simply click on the button corresponding to the security level you need, the change is immediate. Please
read very carefully the help text so you know what a specific security level involves for you and your users.
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Depending on your installation mode (Recommended or Expert),
you will be presented with different security options.

16.16. Customizing Your Menus

In order to help you manage the main menu of your preferred window manager, Mandrake
Linux provides you with a menu editor that ensures menus from all desktop environments
(like KDE or GNOME ) are coherent.

This tool allows system administrators to control the menus for all users (the system menu) but can be used
also by users to personalize their own menus.

Figure 16-45. Launching menudrake in System or User Mode

If started by root, menudrake can be used in two different modes: either changing menus for all users, or
customizing your own menus. Click on:

• System menu if you want to make changes on the menu available for all system users;

• Root menu to customize the menus for the root user only.

When you launch menudrake , it first scans your current menu structure and displays it. The main window
(figure 16-46) is divided in two parts: the menu itself on the left, and on the right a form about the highlighted
menu item.

Figure 16-46. menudrake’s Main Window
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You can click on the + signs of the tree to view the content of the related sub-menu, - to hide it.

You may see in your tree entries that do not appear in your menu.
These are empty directories which are not displayed.

16.16.1. Add a New Menu Entry

This should seldom happen as all Mandrake Linux graphical applications should provide a menu entry. Ho-
wever, if you want to add a menu entry for a package you compiled, or for a console mode program, you may
use this function. Let us imagine you want to check your home directory disk usage through a menu entry in
Applications+Monitoring.

Select the Monitoring directory, and click on the Add entry on the toolbar. An entry called Application 1 appears.
You now need to edit it to what you want. First change the title to say “Home usage”, this is the name that will
appear in the menu. Then enter a more detailed description, Long menu if you wish to, it will appear on the
explication balloon. Let’s put “Displays the size of your home directory”. Finally, you need to provide
the action to be executed by the system (Command:): “du -shc”. Do not forget to check the Open in a terminal
box, as du is not a graphical application.

If you wish, you can also choose an icon for your entry from the list you get by clicking on the icon itself.
figure 16-47 reflects the above modifications. Once you are satisfied, click on the Save icon.

Figure 16-47. Adding a New Menu Entry With menudrake

If you think you have made a big mess of your menus and wish to
come back to the previous state, you can go to File→Reload user
config (Ctrl+R) (this reloads the menus as they were when last
saved) or File→Reload system menu to load the virgin menus as they
were at system installation time.

Finally, to activate your changes, click on the Save button, and voilà. Congratulations! You can now test your
work by going to the real menu and launching your new creation.

Depending on the window manager you currently use, the changes
on your menu may not be shown immediately. In some cases, you
may need to log out and log in again for the changes to take effect.
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16.16.2. Advanced Features

16.16.2.1. Different Menu Styles

Depending on the experience of the people working on your machine, you may want to provide them with
different menu styles. Mandrake Linux provides three template menus that you can eventually customize.
Those templates are available through the Menu Style button in the main window.

Figure 16-48. Choosing a Menu Style

Choose one of the three1 options available:

• All applications. This is the traditional menu shipped with Mandrake Linux holding nearly all available ap-
plications sorted in functional categories.

• What to do. This is a menu specifically designed by our ergonomics team to provide a fast access to most
common applications sorted by usage like Play a game, Use the Internet, etc.

• Original menu. These are the plain menus as provided by the KDE or GNOME desktops. This menu probably
lacks some applications.

For the two first styles, note that you can activate a sub-menu to the other one by checking the Add link to box.
That will allow to access the other menu from the main one, thus ensuring all applications remain available.

When you have chosen a menu style and possibly an option, click OK. You will then be able to see the corres-
ponding menu structure in the main window, and you can now customize it.

16.16.2.2. About the Environment Menu

The entry we just added to the menu is now available in all graphical managers menus. It is also possible to
make modifications to a specific menu by switching the Context you are working with. For example, if you
wish to add an application that should be available only in the KDE menu, simply switch from context all to
kde.

All entries that apply to the selected context only appear in blue in the tree structure on the left.

1. If you started menudrake as a simple user, there is an additional menu style, Use system administrator settings, which will
set your personal menu to the system menu prepared by the system administrator.
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16.16.2.3. Moving and Removing Entries

menudrake entries support the drag-and-drop feature. This means you can take an entry from a directory and
move it to another simply by clicking on the entry and dragging it to the new directory without releasing the
mouse button.

Similarly, you may have noticed that whenever you remove an application from the menu, it appears in the
“attic”, that is the Available applications list on the bottom right corner. If you ever wish to add them again, you
simply have to drag them again to the desired directory.

16.17. Configuring Start-Up Services

At start time, a number of services (programs running in background) performing a variety
of tasks are started. This tool gives the administrator control over those services. See the The
Start-Up Files: init sysv chapter of the Reference Manual for more information.

Figure 16-49. Choosing The Services Available at System Start-Up

For each service, this is the list of items found in each column:

• Service name;

• Current Status: either running or stopped;

• Info: click on that button to get a little explanatory text on that service;

• On Boot: check this box if you wish this service to be automatically brought up at boot time;2

• Start: immediately starts the service, or restarts it (stop+start) if it is already running;

• Stop: immediately stops the service.

2. Generally in runlevels 3 and 5
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16.18. Managing The Fonts Available on Your System

This tool allows one to review the different font families, styles, and sizes available on the
system. It also allows the system administrator to install new fonts, from the local Windows
installation or from other sources.

The main window (figure 16-50) even renders a visual appearance of all font combinations.

Figure 16-50. drakfont’s Main Window

It allows you to add fonts you downloaded from the Internet, for example, and to remove fonts in order to save
space. But the most interesting feature is probably the one that allows you to use the fonts that are available
somewhere else on your machine in your Windows installation. Simply click on Get Windows Fonts, and the list
of all fonts available on your Windows partitions will be displayed. You may then choose to install some or all
of these fonts.

To select a range of fonts, click on the first font you wish to select,
move to the last one to select and click on it while keeping the Shift
key pressed. To select individual fonts, hold the Ctrl key down as
you click on the selections.

16.19. Managing Users on Your System

userdrake is an advanced utility for Mandrake Linux which allows the system administrator to easily add
users to the system, to remove others, to arrange users in groups, and to manage groups in the same manner.

We will only focus on users here. Group management is very similar.

16.19.1. The Interface

Launching userdrake will display the main window (figure 16-51), which lists the users currently defined on
the system. You can switch from users to groups while accessing the View→View groups sub-menu.
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Figure 16-51. The Users List in userdrake

The topology of the window is standard, the three buttons Add, Edit and Remove are also accessible from the
Action menu.

You can make as many changes as you wish, the effect on your user database will be effective only after
pressing the Save button. You can go back to the current users database at any time by accessing the File→
Reload menu entry.

16.19.2. Adding a New User

We created the standard user Queen Pingusa at installation time, and now we want to create a new user called
Peter Pingus, and then make them both members of the group urpmi, so they can install packages without

having root password.

Click on the Add button, the dialog to add a new user will pop up (figure 16-52). The only field required is the
login . You can also choose to add a comment, generally this is the full name of the user.

Figure 16-52. Adding a New User in The System

We now have two users in our list. Select both of them with your mouse (clicking the first one, and moving
the cursor to the second without releasing the button), and click on the Edit button. The following dialog
(figure 16-53) shows the list of available groups on the right, and the list of groups of which the selected users
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are members. Look for the urpmi group on the right, highlight it by clicking on it and click the Add button
between the two lists.

Figure 16-53. Affect Users to a Group

All dialogs under userdrake have a little message just above the
buttons. It generally says All is correct, but if you choose something
ambiguous or which is not allowed, this message will warn you.

After clicking OK, you can check in the users list that the last field (Groups) contains the urpmi group.

16.19.3. Other Features

The parameters dialog (figure 16-54) accessible through View→Edit Parameters (Ctrl-P) allows you to tune the
way lists are displayed and some other options.

Figure 16-54. userdrake’s Parameters Window
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First of all, users whose UID is lower than 500 are the virtual users utilized by the system and which are not
valid for real users. You can choose to display them or not in the users lists here. This dialog also allows you
to choose default options for new users.

The following User view tab (figure 16-55) allows you to select the fields to display in the users list. Simply
deactivate the check box associated to the fields you are not interested in. The aim of the Group view is exactly
the same as the preceding one.

Figure 16-55. userdrake’s User View Parameters

When you select various users and click the Edit button, if the
groups to which they belong are different, then the display will be
slightly different (figure 16-56): in that case, only the user Peter
is a member of the audio group, then the audio item appears in
light gray in both lists.

Figure 16-56. Groups Are Different For Two Users

207



Chapter 16. Mandrake Control Center

16.20. Adjusting Date And Time

This little tool allows you to set up the correct internal date and time for your system.

Figure 16-57. Date And Time Changing

You can set the date on the left and the time on the right:

• to change the year, click on the little arrows on each side of the year;

• to change the month, click on the little arrows on each side of the month;

• this updates the month view where you can click on the current day in order to highlight it;

• it is recommended to check that the time zone settings are correct for your physical location. Click on the
Time Zone button and select the correct place in the tree view;

• to change the time, you can then either move the hour, minute and second hands of the analog clock or
change the numbers below.

When you are finished, click OK to apply your settings or Cancel to close the tool, discarding changes. If you
want to come back to current settings, click Reset.

16.21. Searching Through The Log Files

This tool allows you to search for specific entries in various log files, thus facilitating the search
for particular incidents or security threats.
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Figure 16-58. Browsing And Searching Through System Logs

To browse or make a specific event search into the system logs, these are the steps:

1. you can first choose to match lines containing specific words filling the matching field; or not containing
others through the but not matching field;

2. you then need to choose the file you want to perform the search in, into the Choose file area. Then, simply
check the corresponding box;

3. optionally, you can restrict the search to a specific day. In that case, choose the desired day in the calendar
on the right, and check the Show only for this day box;

4. when all is set up, click the search button. The result will appear in the Content of the file area at the bottom.

16.22. Access to The Console

This menu entry will simply open a console for the root user. You can use it to issue any
command, but be careful! There are no restrictions on the actions you can take on the machine,
and you could end up with an unusable system.
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Your Mandrake Linux system contains a tool which allows easy Internet services configuration. It also helps
you connect to the Internet in a few different ways. To launch it, first open Control Center and click on
Network & Internet, then on Connection. Here is a look at the main interface (figure 17-1):

Figure 17-1. Connecting to The Internet

Let’s review the different elements available:

• Profile combo box: if your machine is likely to be connected to different environments (typically a laptop
moving from a modem connection at home from LAN at the office), you can choose here the correct profile.

• Del profile: to suppress the selected profile.

• New profile: to create a new connection profile. You will then have to configure it with the connection wizard.

• Disconnect or Connect button: for non-permanent accesses (like with a traditional modem), allows you to
control the state of your connection.

• Configure: launch the configuration wizard described below.

• Expert Mode: non documented, allows to you configure access without using the wizard.

• OK: validates choices and exits the application.

• Apply: validates choices without exiting the application.

• Cancel: exits the application and discards all modifications.

Here are some words about the Internet access configuration wizard. On launching it, you will first get a
screen asking whether you wish to detect interfaces (say no if you notice any problem after clicking on yes).
Then some tests will be performed to detect the network devices available on your machine.
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Figure 17-2. Choosing The Internet Connections to Configure

You are then presented with a list of possible connection types (figure 17-1) on which the detected devices
have been selected. If you have an additional connection which has not been detected, you can now manually
slect it to configure it later on. Click then OK, and you will go to the configuration dialog.

We will now take an example with a traditional modem connection.
Other connection types are not documented here but are very simi-
lar. Always make sure to have all the information provided by your
ISP at hand.

Figure 17-3. Configuring The Internet Connection

Fill all required fields with the parameters provided by your Internet service provider. Depending on the
connection type chosen, the parameters may differ.
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Then come some optional steps depending on the type of connection you are configuring. If it is a permanent
connection like ADSL or cable, you will be notably asked whether you wish to activate it a boot time or not.

Figure 17-4. Try The Internet Connection

You can then test your Internet configuration to ensure it actually works. It is advisable to do so, so that you
can correct possible errors right now.

After the configuration is done, you can bring the Internet connection up and down by using the Con-
nect/Disconnect buttons of the main dialog (figure 17-1).
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Maybe you have already noticed that your system is made of a large number of small pieces, in the same way
a house is made of bricks. Here, we do not call these pieces “bricks”, but packages. A package can then be
seen as a box containing all the elements necessary to install and run a specific software.

In this chapter, we will speak about package management, which includes the installation of new packages
(i.e.: adding software to your system), updating already installed packages when new releases or corrections
appear, and also removing packages from your system. This management is eased through the use of a few
tools. Nevertheless, these actions are not available to users, so you need to have super-user permissions to
use the tools described below. If you launch the tools from a user’s account, you will be prompted for a root
password. You can always start from a sudo shell.

18.1. The Main Tool: RpmDrake

RpmDrake is the main package-management tool. You can launch it from the Mandrake Control Cen-
ter+System+Software Manager sub-menu.

Figure 18-1. First RpmDrake Message

When you launch it for the first time, a dialog box appears offering you to configure a “source” for “security
updates”. We will explain these concepts later, so for now, simply answer NO to this question.

18.1.1. The Main Window

When launched, RpmDrake does some analysis and configuration checking, which can take some time. Finally,
you see the main window, showed in this figure:

Figure 18-2. RpmDrake’s Main Window

As you can see, RpmDrake ’s main window is basically divided into three parts.
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1. On the left, a tree showing package names (sorted and grouped by categories) along with some other
information; note that you can change the view to a flat, alphabetically ordered list, just by clicking on the
Flat list tab.

2. The top-right box shows the packages you selected. If you double-click on a package name, it will be
removed from this window and de-selected for maintenance.

3. At the bottom-right, various information about the currently highlighted package, such as its name, de-
tailed description, file list, and so on.

Take a random package in a category (remember, you just have to click on the + sign to expand a tree branch),
then click on its name. The bottom-right block displays general package information as well as the packagers
name. In the File list, you get a tree view of the files contained in the package, as shown below.

Figure 18-3. A Package’s File List

If you click on the first column’s label, the question mark, RpmDrake will check if the
files contained in the package already exist on your system.

If so, they will be marked with a green check sign.

If the files are not present, they will be marked with a red X.

Table 18-1. RpmDrake Icons

Let’s have a look at the Deep size column. You can see it shows only for directories. The size of a directory is
defined as the sum of all files contained in it. If the directory does not contain any sub-directory, that’s enough.
Now, if a directory contains one or more sub-directories, then the depth size is defined as the directory’s size,
plus the depth size of each of its sub-directories.

In the above example, the usr directory’s size is zero, because it does not contain any files. But it holds sub-
directories (bin and share): therefore its depth size is the sum of the depth sizes of each sub-directories. On the
other hand, if the directory bin contains some files but no sub-directory, its depth size is the same as its size.

Now we will select a package. Simply click in the little square box on the left of the package name: immediately,
this package is added in the Selected block, located in the window’s top-right corner (actually, you can double-
click anywhere on a line associated with a package and that package will be added to the Selected packages).

You can select as many packages as you want. You may also simply browse through the packages, choosing
some on the way for later use. Notice that if you click on a package, its description is displayed in the block
below the Selected box.

Finally, let us talk a bit about the Find text field: as you may have already guessed, this will look for a word
through all the packages’ names. Simply type in a word, then click the Search button. Packages whose name
contain the given word are then displayed under the Search Result tree node in the tree view, or only listed
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packages in the Flat List view. Also note that if you want to use the plus sign (“+”) in your search (as in “C++”,
for instance), you have to prefix it with a backslash sign, for example: “C\+\+”.

For expert users, the Find field supports standard regexps (regular
expressions), as defined in regexp(7).

If you type another word and then click Search again, the result of your second inquiry replaces those of your
preceding one. If you want to clear your search results, use the Reset button.

18.1.2. Installable And Installed Packages

Two kinds of RpmDrake packages exist: the Installables, which holds the not yet installed packages and those
you can upgrade, while the Installed RPMs are, you guessed it, already installed on your Mandrake Linux
system but unfortunately, there are no upgrades available. Click on the according tab (just under the button
bar) to switch between the two lists.

When you start RpmDrake , you see the list of installable packages by default, according to what is writ-
ten just below the tab. This can be a rather long list, so for your convenience, use the box just below
the tabs, which says All by default. Click on it, then select Updates only: this time, you get a list of the
packages installed on your machine but for which there exists a more up-to-date release of the sources

(more later about sources and updates). Notice that those “updating packages” are displayed with a symbol
on the left of their name. For example, the symbol shows updates that come from Cooker, the development
version of Mandrake Linux.

On the other hand, if you select Uninstalled only in the list instead of All or Updates only, you will see the packages
that are not yet installed on your system.

18.2. Installing Packages

In previous releases, some users complained about problems caused
by kernel updates. These problems should now be a matter of the
past. However, it is always a good idea to be very careful when
playing with kernel packages.

Now that you are familiar with the global interface, we will install a package. We will choose a clear example,
but it may be possible that this package is already installed on your system. If this is the case, it does not
matter, just use another one in order to experiment. Of course, to experiment we must choose a package in the
Installable packages list. So select this list if you have not done so yet.

As an example, we will chose the emacs-pcomplete package. To find it more easily, use the Flat List, which is
alphabetically ordered, or the search field. Once you have found it, select it by clicking in the square box next
to its name. It then appears in the Selected block on the right-hand side, and various information are given
such as the package’s version and its size.

Now, to install it, simply click on the button labeled Install / Remove, on the left of the button bar
at the top of the window. RpmDrake will then invoke RpmInst, the wizard which will guide you
through the various steps for installing the package.
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Figure 18-4. RpmInst Replacing RpmDrake

After a few seconds, you see the wizard’s window covering RpmDrake ’s window. When launched from Rpm-

Drake , RpmInst starts by giving you information about the needed dependencies: either a list or a short text
telling you everything is fine. If there are dependencies, you will see either only one package or a list, with
information displayed in the same fashion as in the bottom-right part of RpmDrake .

Dependencies? Some packages can not work if other packages are not installed. In our example, the emacs-
pcomplete package can not work if the emacs package is not installed. In this case, we say that emacs belongs
to emacs-pcomplete’s dependencies. This is what is displayed in the above window. This information is pro-
vided by urpmq , a command-line tool (you can find more information about urpmq in the associated man
page: urpmq(8)).

However, in some cases, all the dependencies of the package you want to install are already installed. In those
cases, you won’t even see this page, and continue directly on the next page.

Figure 18-5. Install in Progress Under RpmInst

Now the installation really begins. In the window, you see three rows, to show you what is happening and the
overall progression: these rows come from urpmi (another command-line tool, see urpmi(8) for more details).
During the process, some events may occur:

• if the package you want to install is on a CD-ROM, the program may ask you to insert it: click OK when you
are done;

• you may also get a message telling you that a package is not signed or has an incorrect signature. The
signature is used to make sure a package can be safely installed, from a security point of view: it has been
validated by someone, and not altered by a malicious user. If you get this message, then make sure you
know where the package comes from. You can install it, but do so at your own risk!

When the installation is done, you can exit the wizard and go back to RpmDrake .
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18.3. Uninstalling Packages

Before you start uninstalling packages, make sure you know what
you are doing and inquire about the dependencies carefully. Rpm-
Drake manages dependencies, but it is always sound to be very
careful.

Uninstalling a package means removing it from your system. This is useful to gain disk space or prevent
security incidents. Of course, you can only remove already installed ones: so select a package in the Installed
list. For example, let us try to uninstall the emacs package, which has been installed so emacs-pcomplete can
work. Again, use the flat list to find it easily, then select it. You can also use the Find tool.

Figure 18-6. Uninstalling Packages

When this is done, click on the Install/Remove button. The RpmDrake window is replaced by another wizard,
which tells you that another package will be removed, in our example emacs-pcomplete . This makes sense:
we said earlier that emacs was necessary for emacs-pcomplete to work. If we remove emacs , then emacs-

pcomplete will not work any more, so we should also remove it – to keep the whole system consistent.

At this point, if you click on Next, the packages are removed from your system. Note that you can still install
them again, if you wish to use them after all... Just click on Quit to go back to RpmDrake .

18.4. Sources Management

Sources are package repositories where you can find packages to install on your Mandrake Linux. It can
be a local directory on your hard drive, a CD-ROM, or even a remote directory somewhere on a network –
the Internet, for example. There is always a specially defined source: the one from which you installed your
system. Now we will explore sources management.

18.4.1. Adding Sources

Imagine you find a wonderful CD-ROM with plenty of packages, or a directory on the web. This is
clearly a new source of packages and you would like to use it with RpmDrake . Then you must define
a new source by clicking on the Define sources button.

In the new pop-up window, click on New to define a new source. You then see the following dialog:
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Figure 18-7. Adding a Source in RpmDrake

In every case, you must give your source a name: this name will be used to identify the source later.

You can define several different source types, such as:

• Removable. This is a generic name for sources like CD-ROM, ZIP , and so on. You must tell RpmDrake the
appropriate device (i.e.: which drive) and its mount point.

• Local. If your computer directories contain packages, you can “register” them here. Just give the full,
absolute path to the directory.

• FTP or HTTP. These types are for remote package repositories. In both cases, you must give the full
remote directory URL, beginning with ftp:// or http:// according to the type. Also, give the hdlist file
path, which contains a compact description of what is available in regards with the previously given path. A
typical example would be ../base/hdlist.cz. This means you can only use “Mandrake-compliant” remote
repositories, where a hdlist is present. If unsure, ask the remote site’s administrator. The only difference is
that you must provide a user name and a password for FTP sources.

• Security Updates. This describes remote repositories (like FTP and HTTP) where you can find package
updates in regards with security issues. You should use a trusted mirror for that: the Update the list of mirrors
button gives you a list of trusted mirrors. Try to use those closest to your geographical location. Note that
you may have to give a user name and a password, if the mirror uses the FTP protocol.

• Cooker. These packages are for those who want to closely follow the evolution of the software: they are the
very latest releases. So, be sure you know what you are doing! These packages are mostly of development
type, therefore prone to unstablility and may damage your system, especially when talking about kernel
updates, file systems, etc. Migrating Debian users should compare cooker to the testing distribution.

18.4.2. Updating Sources And Packages

From time to time, the packages contained in a source may change, especially if they are not on a CD-ROM:
some RPM files may be deleted or added. To keep the internal database synchronized with the actual state of
your various sources, it is necessary to update them (the sources).

You can achieve this operation very easily by clicking on the Reload lists button. But note that it can
take a rather long time: as each package is being checked to see if it needs to be updated, and the
dependencies are recalculated to reflect the changes.

Now suppose the content of a source has changed. Usually, it means some packages were added or changed:
a package is changed when the “old” release is buggy or insecure, or simply because there is a new and better
release available. It is possible that some old packages were installed on your system, due to a lack of available,
updated packages.

So, after updating the source, you have the opportunity to update some packages installed on your system
and to take advantage of various new releases: you can see them in the Installable list: they appear in a different
color. Simply select and install them, and there’s no need to say we strongly suggest you do this...
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18.5. Updating Your System

Remember, don’t update the kernel packages without thoroughly
understanding what you are doing.

There is an easy way to completely update your system, with the latest available software release:
MandrakeUpdate . This tool will query known and trusted package repositories, then list the available
new packages. To launch the MandrakeUpdate wizard, click on the button in RpmDrake ’s toolbar.

Figure 18-8. Update Types in MandrakeUpdate

First, you need to choose which type of update you want, among:

• bugfixes. These updates are related to software misbehaviors. Choose this if some of your tools do not work
properly: you may find an update which corrects the problem.

• normal updates. Simply a new release of a software package, with new features.

• security updates. These updates are related to security, i.e. to prevent crackers from gaining unauthorized
access to your system. It is strongly advised to always check these, even if you do not spend your life on a
network.

You then get a window very similar to RpmDrake ’s. Available updates are listed. You only have to check the
ones you want. Select any one for which information about it is displayed in the now familiar, three-tab box
at the bottom. When you have selected some updates, click Next, and the installation wizard will be launched,
as usual.

If you are interested, you can see the list of mirrors used by MandrakeUpdate on this page: Mirrors Full Page
(http://www.mandrakelinux.com/mirrorsfull.list).
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A.1. GNU Free Documentation License

Version 1.1, March 2000

Copyright (C) 2000 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA Everyone
is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other written document "free" in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it,
either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must themselves be
free in the same sense. It complements the GNU General Public License, which is a copyleft license designed
for free software.

We have designed this License in order to use it for manuals for free software, because free software needs
free documentation: a free program should come with manuals providing the same freedoms that the software
does. But this License is not limited to software manuals; it can be used for any textual work, regardless of
subject matter or whether it is published as a printed book. We recommend this License principally for works
whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work that contains a notice placed by the copyright holder saying
it can be distributed under the terms of this License. The "Document", below, refers to any such manual or
work. Any member of the public is a licensee, and is addressed as "you".

A "Modified Version" of the Document means any work containing the Document or a portion of it, either
copied verbatim, or with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to
related matters) and contains nothing that could fall directly within that overall subject. (For example, if the
Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The
relationship could be a matter of historical connection with the subject or with related matters, or of legal,
commercial, philosophical, ethical or political position regarding them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License.

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts,
in the notice that says that the Document is released under this License.

A "Transparent" copy of the Document means a machine-readable copy, represented in a format whose speci-
fication is available to the general public, whose contents can be viewed and edited directly and straightfor-
wardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings)
some widely available drawing editor, and that is suitable for input to text formatters or for automatic trans-
lation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent
file format whose markup has been designed to thwart or discourage subsequent modification by readers is
not Transparent. A copy that is not "Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input for-
mat, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple
HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary formats that
can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or proces-
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sing tools are not generally available, and the machine-generated HTML produced by some word processors
for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are needed to
hold, legibly, the material this License requires to appear in the title page. For works in formats which do not
have any title page as such, "Title Page" means the text near the most prominent appearance of the work’s title,
preceding the beginning of the body of the text.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provi-
ded that this License, the copyright notices, and the license notice saying this License applies to the Document
are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You
may not use technical measures to obstruct or control the reading or further copying of the copies you make
or distribute. However, you may accept compensation in exchange for copies. If you distribute a large enough
number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies of the Document numbering more than 100, and the Document’s license notice
requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover
Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also
clearly and legibly identify you as the publisher of these copies. The front cover must present the full title with
all words of the title equally prominent and visible. You may add other material on the covers in addition.
Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy
these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as
many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
publicly-accessible computer-network location containing a complete Transparent copy of the Document, free
of added material, which the general network-using public has access to download anonymously at no charge
using public-standard network protocols. If you use the latter option, you must take reasonably prudent steps,
when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain
thus accessible at the stated location until at least one year after the last time you distribute an Opaque copy
(directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any
large number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3
above, provided that you release the Modified Version under precisely this License, with the Modified Ver-
sion filling the role of the Document, thus licensing distribution and modification of the Modified Version to
whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those
of previous versions (which should, if there were any, be listed in the History section of the Document).
You may use the same title as a previous version if the original publisher of that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modi-
fications in the Modified Version, together with at least five of the principal authors of the Document (all
of its principal authors, if it has less than five).

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

224



Appendix A. GNU Free Documentation License

F. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

H. Include an unaltered copy of this License.

I. Preserve the section entitled "History", and its title, and add to it an item stating at least the title, year, new
authors, and publisher of the Modified Version as given on the Title Page. If there is no section entitled
"History" in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the "History" section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

K. In any section entitled "Acknowledgements" or "Dedications", preserve the section’s title, and preserve in
the section all the substance and tone of each of the contributor acknowledgements and/or dedications
given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

M. Delete any section entitled "Endorsements". Such a section may not be included in the Modified Version.

N. Do not retitle any existing section as "Endorsements" or to conflict in title with any Invariant Section.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections
and contain no material copied from the Document, you may at your option designate some or all of these
sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license
notice. These titles must be distinct from any other section titles.

You may add a section entitled "Endorsements", provided it contains nothing but endorsements of your Mo-
dified Version by various parties--for example, statements of peer review or that the text has been approved
by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-
Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover
Text and one of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the
Document already includes a cover text for the same cover, previously added by you or by arrangement made
by the same entity you are acting on behalf of, you may not add another; but you may replace the old one, on
explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined
in section 4 above for modified versions, provided that you include in the combination all of the Invariant
Sections of all of the original documents, unmodified, and list them all as Invariant Sections of your combined
work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections
may be replaced with a single copy. If there are multiple Invariant Sections with the same name but different
contents, make the title of each such section unique by adding at the end of it, in parentheses, the name of the
original author or publisher of that section if known, or else a unique number. Make the same adjustment to
the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections entitled "History" in the various original documents,
forming one section entitled "History"; likewise combine any sections entitled "Acknowledgements", and any
sections entitled "Dedications". You must delete all sections entitled "Endorsements."
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6. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in
all other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other
respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works,
in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version
of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation is
called an "aggregate", and this License does not apply to the other self-contained works thus compiled with
the Document, on account of their being thus compiled, if they are not themselves derivative works of the
Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one quarter of the entire aggregate, the Document’s Cover Texts may be placed on covers that
surround only the Document within the aggregate. Otherwise they must appear on covers around the whole
aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under
the terms of section 4. Replacing Invariant Sections with translations requires special permission from their
copyright holders, but you may include translations of some or all Invariant Sections in addition to the original
versions of these Invariant Sections. You may include a translation of this License provided that you also
include the original English version of this License. In case of a disagreement between the translation and the
original English version of this License, the original English version will prevail.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this
License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will automati-
cally terminate your rights under this License. However, parties who have received copies, or rights, from you
under this License will not have their licenses terminated so long as such parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns. See Copyleft (http://www.gnu.org/copyleft/).

Each version of the License is given a distinguishing version number. If the Document specifies that a particu-
lar numbered version of this License "or any later version" applies to it, you have the option of following the
terms and conditions either of that specified version or of any later version that has been published (not as a
draft) by the Free Software Foundation. If the Document does not specify a version number of this License,
you may choose any version ever published (not as a draft) by the Free Software Foundation.

A.2. How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put
the following copyright and license notices just after the title page:

Copyright (c) YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this document under
the terms of the GNU Free Documentation License, Version 1.1 or any later version published by the Free Software

226

http://www.gnu.org/copyleft/


Appendix A. GNU Free Documentation License

Foundation; with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and with
the Back-Cover Texts being LIST. A copy of the license is included in the section entitled "GNU Free Documentation
License".

If you have no Invariant Sections, write "with no Invariant Sections" instead of saying which ones are invariant.
If you have no Front-Cover Texts, write "no Front-Cover Texts" instead of "Front-Cover Texts being LIST";
likewise for Back-Cover Texts.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their
use in free software.
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APM

Advanced Power Management. A feature used by some BIOS es in order to make the machine enter a
standby state after a given period of inactivity. On laptops, APM is also responsible for reporting the
battery status and, if it is supported, the estimated remaining battery life.

ASCII
American Standard Code for Information Interchange. The standard code used for storing characters, includ-
ing control characters, on a computer. Many 8-bit codes (such as ISO 8859-1, the Linux default character
set) contain ASCII as their lower half.
See Also: ISO 8859.

BSD
Berkeley Software Distribution. A Unix variant developed at the Berkeley University computing depart-
ment. This version has always been considered more advanced technically than the others, and has
brought many innovations to the computing world in general and to Unix in particular.

CHAP
Challenge-Handshake Authentication Protocol: protocol used by ISP s to authenticate their clients. In this
scheme, a value is sent to the client (the machine who connects), the client calculates a hash from this
value which it sends to the server, and the server compares the hash with the one it has calculated. It is
different from PAP in that it re-authenticates on a periodic basis after the initial authentication.
See Also: PAP.

CIFS
Common Internet FileSystem The predecessor of the SMB filesystem, used on DOS systems.

DHCP
Dynamic Host Configuration Protocol. A protocol designed for machines on a local network to dynamically
get an IP address from a DHCP server.

DMA
Direct Memory Access. A facility used on the PC architecture which allows for a peripheral to read or write
from main memory without the help of the CPU . PCI peripherals use bus mastering and do not need
DMA .

DNS
Domain Name System. The distributed name/address mechanism used in the Internet. This mechanism
allows you to map a domain name to an IP address, which is what lets you look up a site by domain
name without knowing the IP address of the site. DNS also allows reverse lookup, that is you can get a
machine’s IP address from its name.

DPMS
Display Power Management System. Protocol used by all modern monitors in order to manage power sav-
ing features. Monitors supporting these features are commonly called “green monitors”.

ELF
Executable and Linking Format. This is the binary format used by most GNU/Linux distributions nowadays.

ext2
short for the “Extended 2 filesystem”. This is GNU/Linux ’ native filesystem and has all characteristics of
any Unix filesystem: support for special files (character devices, symbolic links...), file permissions and
ownership, and so on.

FAQ
Frequently Asked Questions. A document containing a series of questions/answers about a specific topic.
Historically, FAQ s appeared in newsgroups, but this sort of document now appears on various web sites,
and even commercial products have their FAQ . Generally, they are very good sources of information.

FAT
File Allocation Table. Filesystem used by DOS and Windows .

FDDI
Fiber Distributed Digital Interface. A high-speed network physical layer, which uses optical fiber for com-
munication. Only used on big networks, mainly because of its price.
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FHS
Filesystem Hierarchy Standard. A document containing guidelines for a coherent file tree organization on
Unix systems. Mandrake Linux complies with this standard in most aspects.

FIFO
First In, First Out. A data structure or hardware buffer from which items are taken out in the order they
were put in. Unix pipes are the most common examples of FIFO s.

FTP
File Transfer Protocol. This is the standard Internet protocol used to transfer files from one machine to
another.

GFDL
The GNU Free Documentation License. It is the license that applies to all Mandrake Linux documenta-
tion.

GIF
Graphics Interchange Format. An image file format, widely used on the web . GIF images may be com-
pressed or animated. Due to copyright problems it is a bad idea to use them, replace them as much as
possible by the far advanced PNG format instead.

GNU
GNU’s Not Unix. The GNU project has been initiated by Richard Stallman at the beginning of the 80s, and
aimed at developing a free operating system (“free” as in “free speech”). Currently, all tools are there,
except... the kernel. The GNU project kernel, Hurd , is not rock solid yet. Linux borrows,among others,
two things from GNU : its C compiler, gcc , and its license, the GPL .
See Also: GPL.

GPL
General Public License. The license of the GNU/Linux kernel, it goes the opposite way of all proprietary
licenses in that it gives no restriction as to copying, modifying and redistributing the software, as long as
the source code is made available. The only restriction, if one can call it that, is that the persons to which
you redistribute it must also benefit from the same rights.

GUI
Graphical User Interface. Interface to a computer consisting of windows with menus, buttons, icons and so
on. The vast majority prefer a GUI over a CLI (Command Line Interface) for ease of use, even though the
latter is more versatile.

HTML
HyperText Markup Language. The language used to create web documents.

HTTP
HyperText Transfer Protocol. The protocol used to connect to websites and retrieve HTML documents or
files.

IDE
Integrated Drive Electronics. The most widely used bus on today’s PC s for hard disks. An IDE bus can
contain up to two devices, and the speed of the bus is limited by the device on the bus which has the
slower command queue (and not the slower transfer rate!).
See Also: ATAPI.

IP masquerading
is when you use a firewall to hide your computer’s true IP address from the outside. Typically any outside
network connections you make beyond the firewall will inherit the firewall’s IP address. This is useful in
situations where you may have a fast Internet connection with only one IP address but wish to use more
than one computer that have internal network IP addresses assigned.

IRC
Internet Relay Chat. One of the few Internet standards for live speech. It allows for channel creation,
private talks, and also file exchange. It is also designed to be able to make servers connect to each other,
which is why several IRC networks exist today: Undernet, DALnet, EFnet to name a few.

IRC channels
are the “places” inside IRC servers where you can chat with other people. Channels are created in IRC
servers and users join those channels so they can communicate with each other. Messages written on an
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channel are only visible to those people connected to that channel. Two or more users can also create a
“private” channel so they don’t get disturbed by other users. Channel names begin with a #.

ISA
Industry Standard Architecture. The very first bus used on PC s, it is slowly being abandoned in favor of
the PCI bus. Some hardware manufacturers still use it, though. It is still very common that SCSI cards
supplied with scanners, CD writers, ... are ISA . Too bad.

ISDN
Integrated Services Digital Network. A set of communication standards for allowing a single wire or opti-
cal fiber to carry voice, digital network services and video. It has been designed in order to eventually
replace the current phone system, known as PSTN (Public Switched Telephone Network) or POTS (Plain Ole
Telephone Service). Technically ISDN is a circuit switched data network.

ISO
International Standards Organization. A group of companies, consultants, universities and other sources
which enumerates standards in various topics, including computing. The papers describing standards
are numbered. The standard number iso9660, for example, describes the filesystem used on CD-ROM s.

ISP
Internet Service Provider. A company which sells Internet access to its customers, whether the access is
over telephone lines or dedicated lines.

JPEG
Joint Photographic Experts Group. Another very common image file format. JPEG is mostly suited for com-
pressing real-world scenes, and does not work very well on non-realistic images.

LAN
Local Area Network. Generic name given to a network of machines connected to the same physical wire.

LDP
Linux Documentation Project. A nonprofit organization which maintains GNU/Linux documentation. Its
mostly known documents are HOWTOs , but it also maintains FAQ s, and even a few books.

MBR
Master Boot Record. Name given to the first sector of a bootable hard drive. The MBR contains the code
used to load the operating system into memory or a bootloader (such as LILO ), and the partition table
of that hard drive.

MIME
Multipurpose Internet Mail Extensions. A string of the form type/subtype describing the contents of a file
attached in an e-mail. This allows MIME -aware mail clients to define actions depending on the type of
the file.

MPEG
Moving Pictures Experts Group. An ISO committee which generates standards for video and audio com-
pression. MPEG is also the name of their algorithms. Unfortunately, the license for this format is very
restrictive, and as a consequence there are still no Open Source MPEG players...

NCP
NetWare Core Protocol. A protocol defined by Novell to access Novell NetWare file and print services.

NFS
Network FileSystem. A network filesystem created by Sun Microsystems in order to share files across a
network in a transparent way.

NIC
Network Interface Controller. An adapter installed in a computer which provides a physical connection to
a network, such as an Ethernet card.

NIS
Network Information System. NIS was also known as “Yellow Pages”, but British Telecom holds a copy-
right on this name. NIS is a protocol designed by Sun Microsystems in order to share common infor-
mation across a NIS domain, which can gather a whole LAN , part of this LAN or several LAN s. It can
export password databases, service databases, groups information and more.
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PAP
Password Authentication Protocol. A protocol used by many ISP s to authenticate their clients. In this s
cheme, the client (you) sends an identifier/password pair to the server, which is not encrypted.
See Also: CHAP.

PCI
Peripheral Components Interconnect. A bus created by Intel and which is today the standard bus for PC

architectures, but other architectures use it too. It is the successor of ISA , and it offers numerous services:
device identification, configuration information, IRQ sharing, bus mastering and more.

PCMCIA
Personal Computer Memory Card International Association. More and more commonly called “PC Card”
for simplicity reasons, this is the standard for external cards attached to a laptop: modems, hard disks,
memory cards, Ethernet cards, and more. The acronym is sometimes humorously expanded to People
Cannot Memorize Computer Industry Acronyms...

PNG
Portable Network Graphics. Image file format created mainly for web use, it has been designed as a patent-
free replacement for GIF and also has some additional features.

PnP
Plug’N’Play. First an add-on for ISA in order to add configuration information for devices, it has become
a more widespread term which groups all devices able to report their configuration parameters. As such,
all PCI devices are Plug’N’Play.

POP
Post Office Protocol. The common protocol used for retrieving mail from an ISP .

PPP
Point to Point Protocol. This is the protocol used to send data over serial lines. It is commonly used to send
IP packets to the Internet, but it can also be used with other protocols such as Novell’s IPX protocol.

RAID
Redundant Array of Independent Disks. A project initiated at the computing science department of Berkeley
University, in which the storage of data is spread along an array of disks using different schemes. At first,
this was implemented using floppy drives, which is why the acronym originally stood for Redundant
Array of Inexpensive Disks.

RAM
Random Access Memory. Term used to identify a computer’s main memory.The “Random” here means
that any part of the memory can be directly accessed...

RFC
Request For Comments. RFC s are the official Internet standard documents, published by the IETF (Internet
Engineering Task Force). They describe all protocols, their usage, their requirements and so on. When you
want to learn how a protocol works, pick up the corresponding RFC .

RPM
Redhat Package Manager. A packaging format developed by Red Hat in order to create software packages,
it is used in many GNU/Linux distributions, including Mandrake Linux .

SCSI
Small Computers System Interface. A bus with a high throughput designed to allow for several types of pe-
ripherals. Unlike IDE , a SCSI bus is not limited by the speed at which the peripherals accept commands.
Only high-end machines integrate a SCSI bus directly on the motherboard, PC s need add-on cards.

SMB
Server Message Block. Protocol used by Windows machines (9x or NT ) for file and printer sharing across a
network.
See Also: CIFS.

SMTP
Simple Mail Transfer Protocol. This is the common protocol for transferring email. Mail Transfer Agents
such as sendmail or postfix use SMTP . They are sometimes also called SMTP servers.
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SVGA
Super Video Graphics Array. The video display standard defined by VESA for the PC architecture. The
resolution is 800x 600 x 16 colors.

TCP
Transmission Control Protocol. This is the most common reliable protocol that uses IP to transfer network
packets. TCP adds the necessary checks on top of IP to make sure that packets are delivered. Unlike UDP
, TCP works in connected mode, which means that two machines must establish a connection before
exchanging data.

URL
Uniform Resource Locator. A string with a special format used to identify a resource on the Internet in a
unique way. The resource can be a file, a server or other item. The syntax for a URL is
protocol://server.name[:port]/path/to/resource.
When only a machine name is given and the protocol is http://, it defaults to retrieving the file index.
html on the server.

VESA
Video Electronics Standards Association. An industry standards association aimed at the PC architecture. It
is the author of the SVGA standard, for example.

WAN
Wide Area Network. This network, although similar to a LAN connects computers on a network that is not
physically connected to the same wires and are separated by a greater distance.

account
on a Unix system, the combination of a name, a personal directory, a password and a shell which allows
a person to connect to this system.

alias
mechanism used in a shell in order to make it substitute one string for another before executing the
command. You can see all aliases defined in the current session by typing alias at the prompt.

arp
Address Resolution Protocol. The Internet protocol used to dynamically map an Internet address to phys-
ical (hardware) addresses on local area networks. This is limited to networks that support hardware
broadcasting.

assembly language
is the programming language that is closest to the computer, which is why it’s called a “low level” pro-
gramming language. Assembly has the advantage of speed since assembly programs are written in terms
of processor instructions so little or no translation is needed when generating executables. Its main dis-
advantage is that it is processor (or architecture) dependent. Writing complex programs is very time-
consuming as well. So, assembly is the fastest programming language, but it isn’t portable between ar-
chitectures.

ATAPI
(“AT Attachment Packet Interface”) An extension to the ATA specification (“Advanced Technology At-
tachment”, more commonly known as IDE, Integrated Drive Electronics) which provides additional com-
mands to control CDROM drives and magnetic tape drives. IDE controllers equipped with this extension
are also referred to as EIDE (Enhanced IDE) controllers.

ATM
This is an acronym for Asynchronous Transfer Mode. An ATM network packages data into standard size
blocks (53 bytes: 48 for the data and 5 for the header) which it can convey efficiently from point to point.
ATM is a circuit switched packet network technology oriented towards high speed (multi-megabits)
optical networks.

atomic
a set of operations is said to be atomic when it executes all at once, and cannot be preempted.

background
in shell context, a process is running in the background if you can type commands while said process
is running.
See Also: job, foreground.
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backup
is a means of saving your important data to a safe medium and location. Backups should be done reg-
ularly, especially with more critical information and configuration files (the prime directories to backup
are /etc, /home and /usr/local). Traditionally, many people use tar with gzip or bzip2 to backup di-
rectories and files. You can use these tools or programs like dump and restore , along with many other
free or commercial backup solutions.

batch
is a processing mode where jobs are submitted to the processor, and then the processor executes them
one after the other till it executes the last one and it’s ready for another list of processes.

beep
is the little noise your computer’s speaker does to warn you of some ambiguous situation when you’re
using command completion and, for example, there’s more than one possible choice for completion.
There might be other programs that make beeps to let you know of some particular situation.

beta testing
is the name given to the process of testing the beta version of a program. Programs usually get released
in alpha and beta states for testing prior to final release.

bit
stands for BInary digiT. A single digit which can take the values 0 or 1, because calculation is done in base
two.

block mode files
files whose contents are buffered. All read/write operations for such files go through buffers, which
allows for asynchronous writes on the underlying hardware, and for reads, not to read again what is
already in a buffer.
See Also: buffer, buffer cache, character mode files.

boot
the procedure taking place when a computer is switched on, where peripherals are recognized one after
the other, and where the operating system is loaded into memory.

bootdisk
a bootable floppy disk containing the code necessary to load the operating system from the hard disk
(sometimes it is self-sufficient).

bootloader
is a program that starts the operating system. Many bootloaders give you the opportunity to load more
than one operating system by letting you choose between them at a boot menu. Bootloaders like grub

are popular because of this feature and are very useful in dual- or multi-boot systems.

buffer
a small portion of memory with a fixed size, which can be associated with a block mode file, a system
table, a process and so on. The coherency of all buffers is maintained by the buffer cache.
See Also: buffer cache.

buffer cache
a crucial part of an operating system kernel, it is in charge of keeping all buffers up-to-date, shrinking
the cache when needed, clearing unneeded buffers and more.
See Also: buffer.

bug
illogical or incoherent behavior of a program in a special case, or a behavior which does not follow the
documentation or accepted standards issued for the program. Often, new features introduce new bugs in
a program. Historically, this term comes from the old days of punch cards: a bug (the insect!) slipped into
a hole of a punch card and, as a consequence, the program misbehaved. Ada Lovelace, having discovered
this, declared “It’s a bug!”, and since then the term has remained.

byte
eight consecutive bits, interpreted in base two as a number between 0 and 255.
See Also: bit.
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case
when taken in the context of strings, the case is the difference between lowercase letters and uppercase
(or capital) letters.

character mode files
files whose content is not buffered. When associated to physical devices, all input/output on these de-
vices is performed immediately. Some special character devices are created by the operating system
(/dev/zero, /dev/null and others). They correspond to data flows.
See Also: block mode files.

client
program or computer that periodically connects to another program or computer to give it orders or ask
for information. In the case of peer to peer systems such as SLIP or PPP the client is taken to be the end
that initiates the connection and the remote end, being called, is taken to be the server. It is one of the
components of a client/server system.

client/server system
system or protocol consisting of a server and one or several clients.

command line
what is provided by a shell and allows the user to type commands directly. Also subject of an eternal
“flame war” between its supporters and its detractors :-)

command mode
under Vi or one of its clones, it is the state of the program in which pressing a key (this above all regards
letters) will not insert the character in the file being edited, but instead perform an action specific to the
said key (unless the clone has remappable commands and you have customized your configuration). You
may get out of it typing one of the “back to insertion mode” commands: i, I, a, A, s, S, o, O, c, C, ...

compilation
is the process of translating source code that is human readable (well, with some training) and that is
written in some programming language (C , for example) into a binary file that is machine readable.

completion
ability of a shell to automatically expand a substring to a filename, user name or other, as long as there
is a match.

compression
is a way to shrink files or decrease the number of characters sent over a communications connection.
Some file compression programs include compress , zip , gzip , and bzip2 .

console
is the name given to what used to be called terminals. They were the users machines (a screen plus a
keyboard) connected to one big central mainframe. On PC s, the physical terminal is the keyboard and
screen.
See Also: virtual console.

cookies
temporary files written on the local hard disk by a remote web server. It allows for the server to be aware
of a user’s preferences when this user connects again.

datagram
A datagram is a discrete package of data and headers which contain addresses, which is the basic unit of
transmission across an IP network. You might also hear this called a “packet”.

dependencies
are the stages of compilation that need to be satisfied before going on to other compilation stages in order
to successfully compile a program.

desktop
If you’re using the X Window System, the desktop is the place on the screen inside which you work and
upon which your windows and icons are displayed. It is also called the background, and is usually filled
with a simple color, a gradient color or even an image.
See Also: virtual desktops.
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directory
Part of the filesystem structure. Within a directory, files or other directories are stored. Sometimes there
are sub-directories (or branches) within a directory. This is often referred to as a directory tree. If you
want to see what’s inside another directory, you will either have to list it or change to it. Files inside a
directory are referred to as leaves while sub-directories are referred to as branches. Directories follow the
same restrictions as files although the permissions mean different things. The special directories . and
.. refer to the directory itself and to the parent directory respectively.

discrete values
are values that are non-continuous. That is, there’s some kind of “spacing” between two consecutive
values.

distribution
is a term used to distinguish one GNU/Linux manufacturers product from another. A distribution is made
up of the core Linux kernel and utilities, as well as installation programs, third-party programs, and
sometimes proprietary software.

DLCI
The DLCI is the Data Link Connection Identifier and is used to identify a unique virtual point to point
connection via a Frame Relay network. The DLCI’s are normally assigned by the Frame Relay network
provider.

echo
is when the characters you type in a username entry field, for example, are shown “as is”, instead of
showing “*” for each one you type.

editor
is a term typically used for programs that edit text files (aka text editor). The most well-known GNU/Linux

editors are the GNU Emacs (Emacs ) editor and the Unix editor Vi .

email
stands for Electronic Mail. This is a way to send messages electronically between people on the same
network. Similar to regular mail (aka snail mail), email needs a destination and sender address to be
sent properly. The sender must have an address like “sender@senders.domain” and the recipient must
have an address like “recipient@recipients.domain.” Email is a very fast method of communication and
typically only takes a few minutes to reach anyone, regardless of where in the world they are located.
In order to write email, you need an email client like pine or mutt which are text-mode clients, or GUI
clients like kmail .

environment
is the execution context of a process. It includes all the information that the operating system needs to
manage the process and what the processor needs to execute the process properly.
See Also: process.

environment variables
a part of a process’ environment. Environment variables are directly viewable from the shell .
See Also: process.

escape
in the shell context, is the action of surrounding some string between quotes to prevent the shell from
interpreting that string. For example, when you need to use spaces in some command line and pipe
the results to some other command you have to put the first command between quotes (“escape” the
command) otherwise the shell will interpret it wrong and won’t work as expected.

filesystem
scheme used to store files on a physical media (hard drive, floppy) in a consistent manner. Examples of
filesystems are FAT , GNU/Linux ’ ext2fs , iso9660 (used by CD-ROM s) and so on. An example of a virtual
filesystem is the /proc filesystem.

firewall
a machine or a dedicated piece of hardware which, in the topology of a local network, is the unique
connecting point to the outside network, and which filters, or controls the activity on some ports, or
makes sure only some specific interfaces may have access to them.
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flag
is an indicator (usually a bit) which is used to signal some condition to a program. For example, a filesys-
tem has, among others, a flag indicating if it has to be dumped in a backup, so when the flag is active the
filesystem gets backed up, and when it’s inactive it doesn’t.

focus
the state for a window to receive keyboard events (such as key-presses, key-releases and mouse clicks)
unless they are trapped by the window manager.

foreground
in shell context, the process in the foreground is the one which is currently running. You have to wait for
such a process to finish in order to be able to type commands again.
See Also: job, background.

Frame Relay
Frame Relay is a network technology ideally suited to carrying traffic that is of bursty or sporadic nature.
Network costs are reduced by having many Frame Relay customer sharing the same network capacity
and relying on them wanting to make use of the network at slightly different times.

framebuffer
projection of a video card’s RAM into the machine’s address space. This allows for applications to access
the video RAM without the chore of having to talk to the card. All high-end graphical workstations use
framebuffers, for example.

full-screen
This term is used to refer to applications that take up the whole visible area of your display.

gateway
link connecting two IP networks.

globbing
in the shell , the ability to group a certain set of filenames with a globbing pattern.
See Also: globbing pattern.

globbing pattern
a string made of normal characters and special characters. Special characters are interpreted and ex-
panded by the shell .

hardware address
This is a number that uniquely identifies a host in a physical network at the media access layer. Examples
of this are Ethernet Addresses and AX.25 Addresses.

hidden file
is a file which can’t be “seen” when doing a ls command with no options. Hidden files’ filenames begin
with a . and are used to store the user’s personal preferences and configurations for the different pro-
grams (s)he uses. For example, bash ’s command history is saved into .bash_history, which is a hidden
file.

home directory
often abbreviated by “home”, this is the name for the personal directory of a given user.
See Also: account.

host
refers to a computer and is commonly used when talking about computers that are connected on a net-
work.

icon
is a little drawing (normally sized 16x 16, 32x 32, 48x 48 and sometimes 64x 64 pixels) which represents,
under a graphical environment, a document, a file or a program.

inode
entry point leading to the contents of a file on a Unix -like filesystem. An inode is identified in a unique
way by a number, and contains meta-information about the file it refers to, such as its access times, its
type, its size, but not its name!
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insert mode
under Vi or one of its clones, it is the state of the program in which pressing a key will insert that
character in the file being edited (except pathological cases like the completion of an abbreviation, right
justify at the end of the line, ...). One gets out of it pressing the key Esc (or Ctrl-[).

Internet
is a huge network that connects computers around the world.

IP address
is a numeric address consisting of four parts which identifies your computer on the Internet. IP addresses
are structured in a hierarchical manner, with top level and national domains, domains, subdomains and
each machine’s personal address. An IP address would look something like 192.168.0.1. A machine’s
personal address can be one of two types: static or dynamic. Static IP addresses are addresses that never
change, but rather are permanent. Dynamic IP addresses mean your IP address will change with each
new connection to the network. Dial-up and cable modem users typically have dynamic IP addresses
while some DSL and other high-speed connections provide static IP addresses.

ISO 8859
The ISO 8859 standard includes several 8-bit extensions to the ASCII character set. Especially important
is ISO 8859-1, the “Latin Alphabet No. 1”, which has become widely implemented and may already be
seen as the de facto standard ASCII replacement.
ISO 8859-1 supports the following languages: Afrikaans, Basque, Catalan, Danish, Dutch, English,
Faroese, Finnish, French, Galician, German, Icelandic, Irish, Italian, Norwegian, Portuguese, Scottish,
Spanish, and Swedish.
Note that the ISO 8859-1 characters are also the first 256 characters of ISO 10646 (Unicode). However, it
lacks the EURO symbol and does not fully cover Finnish and French. ISO 8859-15 is a modification of
ISO 8859-1 that covers these needs.
See Also: ASCII.

job
in shell context, a job is a process running in the background. You can have several jobs in the same
shell and control these jobs.
See Also: foreground, background.

kernel
is the guts of the operating system. The kernel is responsible for allocating resources and separating
processes from each other. It handles all of the low-level operations that allow programs to talk directly
to the hardware on your computer, manages the buffer cache and so on.

kill ring
under Emacs , it is the set of text areas cut or copied since the beginning of the editor, which may be
recalled to be inserted again, and which is organized like a ring.

launch
is the action of invoking, or starting, a program.

library
is a collection of procedures and functions in binary form to be used by programmers in their programs
(as long as the library’s license allows them to do so). The program in charge of loading shared libraries
at run time is called the dynamic linker.

link
reference to an inode in a directory, therefore giving a (file) name to the inode. Examples of inodes which
don’t have a link (and hence have no name) are: anonymous pipes (as used by the shell), sockets (aka
network connections), network devices and so on.

linkage
last stage of the compile process, which consists in linking together all object files in order to produce an
executable file, and matches unresolved symbols with dynamic libraries (unless a static linkage has been
asked, in which case the code of these symbols will be included in the executable).

Linux
is a Unix -like operating system which runs on a variety of different computers, and is free for anyone to
use and modify. Linux (the kernel) was written by Linus Torvalds.
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login
connection name for a user on a Unix system, and the action to connect.

lookup table
is a table that puts in correspondance codes (or tags) and their meaning. It is often a data file used by a
program to get further information about a particular item.
For example, harddrake uses such a table to know what a manufacturer’s product code means. This is
one line from the table, giving information about item CTL0001

CTL0001 sound sb Creative Labs SB16 \

HAS_OPL3|HAS_MPU401|HAS_DMA16|HAS_JOYSTICK

loopback
virtual network interface of a machine to itself, allowing the running programs not to have to take into
account the special case where two network entities are in fact the same machine.

major
number specific to the device class.

manual page
a small document containing the definition of a command and its usage, to be consulted with the man
command. The first thing one should (learn how to) read when hearing of a command he doesn’t know
:-)

minor
number identifying the specific device we are talking about.

mount point
is the directory where a partition or another device is attached to the GNU/Linux filesystem. For example,
your CD-ROM is mounted in the /mnt/cdrom directory, from where you can explore the contents of any
mounted CD s.

mounted
A device is mounted when it is attached to the GNU/Linux filesystem. When you mount a device you can
browse its contents. This term is partly obsolete as with the “supermout” feature, users do not need any
more to manually mount removable medias.
See Also: mount point.

MSS
The Maximum Segment Size (MSS) is the largest quantity of data that can be transmitted at one time. If
you want to prevent local fragmentation MSS would equal MTU-IP header.

MTU
The Maximum Transmission Unit (MTU) is a parameter that determines the largest datagram than can
be transmitted by an IP interface without it needing to be broken down into smaller units. The MTU
should be larger than the largest datagram you wish to transmit unfragmented. Note, this only prevents
fragmentation locally, some other link in the path may have a smaller MTU and the datagram will be
fragmented there. Typical values are 1500 bytes for an ethernet interface, or 576 bytes for a SLIP interface.

multitasking
the ability for an operating system to share CPU time between several processes. At low level, this is also
known as multiprogramming. Switching from one process to another requires that all the current process
context be saved and restored when this process is elected again. This operation is called context switch,
and on Intel, is done 100 times per second; therefore it’s fast enough so that a user has the illusion that
the operating system runs several applications at the same time. There are two types of multitasking:
preemptive multitasking is where the operating system is responsible for taking away the CPU and pass
it to another process; cooperative multitasking is where the process itself gives back the CPU. The first
variant is, obviously, the better choice because no program can consume the entire CPU time and block
other processes. GNU/Linux does preemptive multitasking. The policy to select which process should be
run, depending on several parameters, is called scheduling.

multiuser
is used to describe an operating system which allows multiple users to log into and use the system at the
exact same time, each being able to do their own work independent of other users. A multitasking oper-
ating system is required to provide multiuser support. GNU/Linux is both a multitasking and multiuser
operating system, as any Unix system for that matter.
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named pipe
a Unix pipe which is linked, as opposed to pipes used in shells.
See Also: pipe, link.

naming
a word commonly used in computing for a method to identify objects. You will often hear of “naming
conventions” for files, functions in a program and so on.

newsgroups
discussion and news areas that can be accessed by a news or USENET client to read and write mes-
sages specific to the topic of the newsgroup. For example, the newsgroup alt.os.linux.mandrake is
an alternate newsgroup (alt) dealing with the Operating System (os) GNU/Linux , and specifically, Man-
drake Linux (mandrake). Newsgroups are broken down in this fashion to make it easier to search for a
particular topic.

null, character
the character or byte number 0, it is used to mark the end of a string.

object code
is the code generated by the compilation process to be linked with other object codes and libraries to
form an executable file. Object code is machine readable.
See Also: compilation, linkage.

on the fly
Something is said to be done “on the fly” when it’s done along with something else, without you noticing
it or explicitly asking for it.

open source
is the name given to free source code of a program that is made available to development community and
public at large. The theory behind this is that allowing source code to be used and modified by a broader
group of programmers will ultimately produce a more useful product for everyone. Some popular open
source programs include Apache , sendmail and GNU/Linux .

operating system
is the interface between the applications and the underlying hardware. The tasks for any operating sys-
tem are primarily to manage all of the machine specific resources. On a GNU/Linux system, this is done
by the kernel and loadable modules. Other well-known operating systems include AmigaOS , MacOS ,
FreeBSD , OS/2 , Unix , Windows NT , and Windows 9x .

owner
in the context of users and their files, the owner of a file is the user who created that file.

owner group
in the context of groups and their files, the owner group of a file is the group to which the user who
created that file belongs to.

pager
program displaying a text file one screenful at a time, and making it easy to move back and forth and
search for strings in this file. We advise you to use less .

password
is a secret word or combination of words or letters that is used to secure something. Passwords are
used in conjunction with user logins to multi-user operating systems, web sites, FTP sites, and so forth.
Passwords should be hard-to-guess phrases or alphanumeric combinations, and should never be based
on common dictionary words. Passwords ensure that other people cannot log into a computer or site
with your account.

patch, to patch
file holding a list of corrections to issue to a source code in order to add new features, to remove bugs,
or to modify it according to one’s wishes and needs. The action consisting of the application of these
corrections to the archive of source code (aka “patching”).

path
is an assignment for files and directories to the filesystem. The different layers of a path are separated by
the "slash" or ’/’ character. There are two types of paths on GNU/Linux systems. The relative path is the
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position of a file or directory in relation to the current directory. The absolute path is the position of a file
or directory in relation to the root directory.

pipe
a special Unix file type. One program writes data into the pipe, and another program reads the data at
the other end. Unix pipes are FIFO s, so the data is read at the other end in the order it was sent. Very
widely used with the shell. See also named pipe.

pixmap
is an acronym for “pixel map”. It’s another way of referring to bitmaped images.

plugin
add-on program used to display or play some multimedia content found on a web document. It can
usually be easily downloaded if your browser is not yet able to display or play that kind of information.

porting
a program is translating that program in such a way that it can be used in a system it was not originally
intended for, or it can be used in “similar” systems. For example, to be able to run a Windows -native
program under GNU/Linux (natively), it must first be ported to GNU/Linux .

precedence
dictates the order of evaluation of operands in an expression. For example: If you have 4 + 3 * 2 you
get 10 as the result, since the product has more precedence than the addition. If you want to evaluate the
addition first, then you have to add parenthesis like this (4 + 3) * 2, and you get 14 as the result since
the parenthesis have more precedence than the addition and the product, so the operations in parenthesis
get evaluated first.

preprocessors
are compilation directives that instruct the compiler to replace those directives for code in the program-
ming language used in the source file. Examples of C ’s preprocessors are #include, #define, etc.

process
in the operating system context, a process is an instance of a program being executed along with its
environment.

prompt
in a shell , this is the string before the cursor. When you see it, you can type your commands.

protocol
Protocols organize the communication between different machines across a network, either using hard-
ware or software. They define the format of transferred data, whether one machine controls another, etc.
Many well-known protocols include HTTP, FTP, TCP, and UDP.

proxy
a machine which sits between a network and the Internet , whose role is to speed up data transfers for
the most widely used protocols (HTTP and FTP , for example). It maintains a cache of previous demands,
which avoids the cost of asking for the file again if another machine asks for the same thing. Proxies are
very useful on low bandwidth networks (such as modem connections). Sometimes the proxy is the only
machine able to access outside the network.

pulldown menu
it is a menu that is “rolled” with a button in some of its corners. When you press that button, the menu “
unrolls” itself showing you the full menu.

quota
is a method for restricting disk usage and limits for users. Administrators can restrict the size of home
directories for a user by setting quota limits on specific filesystems.

read-only mode
for a file means that the file cannot be written to. You can read its contents but you can’t modify them.
See Also: read-write mode.

read-write mode
for a file, it means that the file can be written to. You can read its contents and modify them.
See Also: read-only mode.
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regular expression
a powerful theoretical tool which is used to search and match text strings. It lets one specify patterns
these strings must obey. Many Unix utilities use it: sed , awk , grep , perl among others.

root
is the superuser of any Unix system. Typically root (aka the system administrator) is the person responsi-
ble for maintaining and supervising the Unix system. This person also has complete access to everything
on the system.

root directory
This is the top level directory of a filesystem. This directory has no parent directory, thus ’..’ for root
points back to itself. The root directory is written as ’/’.

root filesystem
This is the top level filesystem. This is the filesystem where GNU/Linux mounts its root directory tree. It is
necessary for the root filesystem to reside in a partition of its own, as it is the basis for the whole system.
It holds the root directory.

route
Is the path that your datagrams take through the network to reach their destination. Is the path between
one machine and another in a network.

run level
is a configuration of the system software that only allows certain selected processes to exist. Allowed
processes are defined, for each runlevel, in the file /etc/inittab. There are eight defined runlevels: 0, 1,
2, 3, 4, 5, 6, S and switching among them can only be achieved by a privileged user by means of executing
the commands init and telinit.

script
shell scripts are sequences of commands to be executed as if they were entered in the console one after
the other. shell scripts are Unix ’s (somewhat) equivalent of DOS batch files.

security levels
Mandrake Linux ’s unique feature that allows you to set different levels of restrictions according to how
secure you want to make your system. There are 6 predefined levels ranging from 0 to 5, where 5 is the
tightest security. You can also define your own security level.

server
program or computer that provides a feature or service and awaits the connections from clients to execute
their orders or give them the information they ask. In the case of peer to peer systems such as slip or ppp
the server is taken to be the end of the link that is called and the end calling is taken to be the client. It is
one of the components of a client/ server system.

shadow passwords
a password management suite on Unix systems in which the file containing the encrypted passwords is
not world-readable, whereas it is when using the normal password system. It also offers other features
such as password aging.

shell
The shell is the basic interface to the operating system kernel and is what provides the command line
where users enter commands to run programs and system commands. All shells provide a scripting
language which can be used to automate tasks or simplify often-used complex tasks. These shell scripts
are similar to batch files from the DOS operating system, but are much more powerful. Some example
shells are bash , sh , and tcsh .

single user
is used to describe a state of an operating system, or even an operating system itself, that only allows a
single user to log into and use the system at any time.

site dependent
means that the information used by programs like imake and make to compile some source file depends
on the site, the computer architecture, the computer’s installed libraries, and so on.

socket
file type corresponding to any network connection.
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soft links
see “symbolic links”.

standard error
the file descriptor number 2, opened by every process, used by convention to print error messages to the
terminal screen by default.
See Also: standard input, standard output.

standard input
the file descriptor number 0, opened by every process, used by convention as the file descriptor from
which the process receives data.
See Also: standard error, standard output.

standard output
the file descriptor number 1, opened by every process, used by convention as the file descriptor in which
the process prints its output.
See Also: standard error, standard input.

streamer
is a device that takes “streams” (not interrupted or divided in shorter chunks) of characters as its input.
A typical streamer is a tape drive.

switch
Switches are used to change the behavior of programs, and are also called command-line options or
arguments. To determine if a program has optional switches that can be used, read the man pages or try
to pass the --help switch to the program (ie. program --help).

symbolic links
special files, containing nothing but a string that makes reference to another file. Any access to them is
the same as accessing the file whose name is the referenced string, which may or may not exist, and the
path to which can be given in a relative or an absolute way.

target
is the object of compilation, i.e. the binary file to be generated by the compiler.

telnet
creates a connection to a remote host and allows you to log into the machine, provided you have an
account. Telnet is the most widely-used method of remote logins, however there are better and more
secure alternatives, like ssh .

theme-able
a graphical application is theme-able if it is able to change its appearance in real time. Many window
managers are theme-able as well.

traverse
for a directory on a Unix system, this means that the user is allowed to go through this directory, and
possibly to directories under it. This requires that the user has the execute permission on this directory.

username
is a name (or more generally a word) that identifies a user in a system. Each username is attached to a
unique and single UID (user ID)
See Also: login.

variables
are strings that are used in Makefile files to be replaced by their value each time they appear. Usualy
they are set at the beginning of the Makefile. They are used to simplify Makefile and source files tree
management.
More generally, variables in programming, are words that refer to other entities (numbers, strings, tables,
etc.) that are likely to vary while the program is executing.

verbose
For commands, the verbose mode means that the command reports to standard (or possibly error) output
all the actions it performs and the results of those actions. Sometimes, commands have a way to define
the “verbosity level”, which means that the amount of information that the command will report can be
controlled.
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virtual console
is the name given to what used to be called terminals. On GNU/Linux systems, you have what are called
virtual consoles which enable you to use one screen or monitor for many independently running ses-
sions. By default, you have six virtual consoles which can be reached by pressing ALT-F1 through ALT-
F6. There is a seventh virtual console by default, ALT-F7, which will permit you to reach a running X
Window System. In X, you can reach the text console by pressing CTRL-ALT-F1 through CTRL-ALT-F6.
See Also: console.

virtual desktops
In the X Window System, the window manager may provide you several desktops. This handy feature
allows you to organize your windows, avoiding the problem of having dozens of them stacked on top of
each other. It works as if you had several screens. You can switch from one virtual desktop to another in
a manner that depends on the window manager you’re using.
See Also: window manager, desktop.

wildcard
The ’*’ and ’?’ characters are used as wildcard characters and can represent anything. The ’*’ represents
any number of characters, including no characters. The ’?’ represents exactly one character. Wildcards are
often used in regular expressions.

window
In networking, the window is the largest amount of data that the receiving end can accept at a given
point in time.

window manager
the program responsible for the “look and feel” of a graphical environment, dealing with window bars,
frames, buttons, root menus, and some keyboard shortcuts. Without it, it would be hard or impossible to
have virtual desktops, to resize windows on the fly, to move them around, ...
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deactivate, 170, 170, 171

APMd
deactivate, 170

APMd daemon
deactivate, 168, 169, 170

applets
GNOME, 73

Application
GnomeMeeting, 142

applications
Aumix, 137
Bastille, 165
DiskDrake, 190
draksec, 199
GNOME, 74
HardDrake, 178
InteractiveBastille, 166
KMail, 55
Konqueror, 55, 91
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KWrite, 55
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Aumix, 137
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manual, 176
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background, 45
KDE, 65

bar
icons, 46
menu, 45
status, 46
task, 47, 55
title, 45
tool, 55
tool, application, 46
tool, shrink button, 55

Bastille, 165

security levels, 165
Bastille-Chooser, 165
BIOS, 3
boot

device, 26
boot up

configuration, 174
boot disk, 3, 27

creating, 174
creating for semi and automated installation, 175

boot images, 3
booting

dual, ??
bootloader, 27

configuration, 175
GRUB, 26
LILO, ??
uninstall, 31

bugfixes
MandrakeUpdate, 221

CDROM
icon, 55

cdrom.img, 3
clipboard, 96

button, 55
clock

GNOME, 70
KDE, 55

command
BastilleChooser, 165
rawwrite, 4
telnet, deactivate, 168

commands
DrakConf, 173
InteractiveBastille, ??
Kppp, 5
mcc, 173
mem=xxxM, 12
minicom, 5
modprobe, 182

configuration
GNOME, 73
server, 169
workstation, 167

console
access, 209

contributors page, ii
Control Center

GNOME, 70
Control Center

KDE, 64
conventions

typing, iii
CPU

load average, 71
cron, 169
date

adjust, 208
defrag, 1
Denial of Service

blocking, 167, 168, 169
dependencies
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desktop, 45

GNOME, 67
KDE, 55
virtual, 46

desktop guide
GNOME, 70

desktop, show
icon, 55

DHCP server
deactivate, 170

DHCP server, 198
deactivate, 170

DHCP server daemon
deactivate, 167, 168, 169

DiskDrake, 17
hda, 191
NFS, 196
removable devices, 193
Samba, 194

disks, 7
DNS server

deactivate, 167, 168, 169
Docbook, iii
documentation, ii

GNOME, 73
donation, ii
DOSEMU, 167, 168, 169
drag’n’drop, 96
DrakConf, 173
draksec, 199
DrakX, 11
etherdrake, 182
file

hidden, 100
file manager

icon, 55
file managers

Konqueror, 91
Nautilus, 101

file system
Devfs (Device File System), 10

firewalling
moderate, server, 170
moderate, workstation, 168
no, workstation, 170
no, workstation, 167
tight, workstation, 169

floppy
auto-install, 30
icon, 55

fonts
management, 204

Free Software Foundation, i
ftp

deactivate, 168, 168, 169, 170, 171
deactivate anonymous mode capability, 168, 169, 170,
171
deactivate user mode capability, 169, 170
disable user mode, 170, 171

games
GNOME, 73

gateway
configuring, 198

GFDL, 223
GNOME
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configuration, 73
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desktop, 44, 67
desktop guide, 70
documentation, 73
file manager, 74
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hardware, 73
lock screen, 69
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main menu, 69, 72
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Nautilus, 74
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office, 74
packaging, 73
pager, 70
panel, 68
printing, 73
tasklist, 70
terminal, 69
terminals, 74
web sites, 73

GNU Free Documentation License, i
GPM

disable, 168, 169, 170, 171
graphical

environment, 40
GRUB, 3, 26
hard disk

detection, 15
HardDrake, 178

ftp archive, 183
home page, 183
other devices, 180
selected device, 180
Sound Wizard, 182
Wizard, 182

hardware
configuration, 178
GNOME, 73
troubleshooting, 183

hardware, supported, 5
hd.img, 3
help

balloon, 45
KDE, 55

home
partition, 8

I/O address, 6
icon, 44
icons

choosing, 63
creating, 61
deleting, 63
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IDE

detection, 14
devices, 9

info pages, 59
installation

automated, 30
replay, 30
save package selection, 30

installation class, 13
expert, 14, 14
recommended, 14, 14

installation options
expert, 12
kernel options, 12
linux, 12
text, 12
vgalo, 12

InteractiveBastille, 166
End screen, 167
entries, 167
wizards, 167

internationalization, ii
Internet

configuration wizard, 211
connect button, 211
connection, 211
disconnect button, 211
expert configuration mode, 211
introduction, 147
profiles, 211

Internet connection
ADSL connection, 23
cable modem, 23
ISDN modem, 23
LAN, 23
traditional modem, 23

IO
settings, 182

IRQ, 6
settings, 182

ISA card, 182
IsaPnPTools

home page, 183
ISDN card

configuration, 24
K menu, 55
KDE

background, 65
clock, 55
Control Center, 64
desktop, 44, 55
documentation, 55
help, 55
wallpapers, 66

keyboard, 16, 24
changing layout, 190
configuration, 24
GKB, 71

KMail, 55
Konqueror, 55, 91

detailed tree view, 98

directory, creating, 94
display, 97
display types, 98
drag’n’drop, 96
file, linking, 95
file, deleting, 96
file, finding, 97
file, renaming, 95
file, copying, 95
file, moving, 95
hidden files, 100
icon view, 98
index.html, 99
linking windows, 101
multicolumn view, 98
shred, 97
sort, 99
text view, 99
tool bar, 92
tree view, 98
window splitting, 100

konsole, 55
KWrite, 55
languages, 12
LDAP, 22
legal disclaimer, 5
license, 13
LILO, 3, 26
lock screen

button, 55
GNOME, 69

log files
searching through, 208

login, 39
action, 39
graphical, ??

login mode
autologin, 175
graphical interface, 175

login mode
configuring, 175

logout, 39, 41
GNOME, ??
KDE, 41

logout button
GNOME, 69

lpd, 189
man pages, 59
Mandrake

Control Center, 173
Expert, 55
Mailing Lists, i
News, 55
Online, 55
Store, 55
Update, 221

Mandrake First Time, 40
Mandrake Forum, i
Mandrake Secure, i
MandrakeCampus, i
MandrakeExpert, i
MandrakeSoft, i
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MandrakeSoft S.A., i
MandrakeStore, ii
MBR, 27
mcc, 173
menu

pull-down, 45
menu, main

GNOME, 69
menudrake, 200

add entry, 201
advanced features, 202

modems
linmodems, 5
winmodem, 5

mount points, 17
mouse, 15, 23

changing, 183
configuration, 23

MP3, 131
MSEC, 199
multimedia

center, 131
GNOME, 74

named, dns
deactivate, 170, 170, 171

Nautilus, 69, 74, 101
appearance, 104
desktops, 106
history, 102
icon captions, 106
icon view, 106
list view, 106
navigation, 106
news, 102, 106
notes, 102
preferences, 104
search, 106
sidebar, 102
sidebar defining, 106
smooth font, 105
speed tradeoffs, 106
standard tree structure, 102
theme, 105
windows, 106

netiquette, 52
network.img, 3
networking

GNOME, 73
news server

deactivate, 170
news server

deactivate, 170
NFS

deactivate, 170, 170
disable, 168, 169
file sharing, 196

NIS, 22
deactivate, 170, 170

normal updates
MandrakeUpdate, 221

office
GNOME, 74

other.img, 3
package

installable, 217
installed, 217
installing, 217
uninstalled only, 217
uninstalling, ??
updates only, 217

packages
description, 216
development, 19
graphical environment, 19
individual selection, 19
installing, ??
management, 215
selected, 216
server, 19
updating, 220
workstation, 19

packaging, ii
GNOME, 73

pager
GNOME, 70

panel, 45
GNOME, 68
retractable, 45

partition, 7
extended, 9
formatting, 193
logical, 9
primary, 9

partition table, 190
expert mode, 193

partitioning, 17
partitions

bad blocks, 18
formatting, 18
manual formatting, 18
pre-existing, 18

password, 39
root, 21

PCI SCSI, 14
pcmcia

deactivate, 170, 170
disable at startup, 169

pcmcia.img, 3
Peter Pingus, v
Plug’N’Play

ISA, 5
OS, 3

PnP OS, 3
ports, 165
printer

add, 184
configuration, 183
connection type, 189
default, 187
Expert Mode, 184
local, 189
multi function, 185
network, 189
options, 186
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remote servers, 184
remote printers, 189
remote lpd, 189
SMB, 189
testing, 187
URI, 189

printing
configuration, 24
disable, 171
GNOME, 73

programming, ii
programs

accessing, 48
run, 72

protocol
LDAP, 22
NIS, 22

Queen Pingusa, v
quit

button, 55
RAM memory, 7
resolution

changing display, 176
testing new video mode, 177

rhost-based authentication
disable, 170

rlogin access
disable, 168, 169

root
partition, 8
password, 21
window, 45

routing daemons
deactivate, 170

routing daemons
deactivate, 170

RpmDrake , 215
deep list, 216
file list, 216
find list, 216
flat list, 216
MandrakeUpdate, 221
reset, 217
RpmInst, 217
search, 216
update mirror list, 220
urpmi, 218
urpmq, 218

RpmInst, 217
rsh access
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